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1. INTRODUCTION

Welcome to Dataton WATCHOUT, the leading multi-display production and presentation system. Use
it o create stunning collages combining images, video, lighting, 3D and interactivity. Present your
shows using projectors for large, seamless images. Hook up WATCHOUT to monitors, LED walls or
other creative screen arrangements. Or project onto complex three-dimensional objects using the 3D
video mapping capabilities.

ABOUT THIS MANUAL
This manual is divided into the following parts:

* An introduction to give you the big picture. Start here if you're a new user or just having your first
look at WATCHOUT. You'll also find basic instructions on how to install the program and configure
your computers.

* A reference section, describing all windows, menus, commands and other details. Refer to this
section to learn more about specific functions.

* A number of appendices with additional information related to particular areas of the product, such
as live video inputs and external control protocols.

WATCHOUT VERSION 6
This manual refers to WATCHOUT version 6. The latest version of the software and its documentation
can always be obtained from:

http://www.dataton.com/downloads
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SYSTEM OVERVIEW
This section provides an introduction to the various components in a basic WATCHOUT system, and

how they fit together. Note that each computer in a system running WATCHOUT must have a
WATCHOUT license key connected. Dataton WATCHPAX and WATCHMAX have built-in license keys.
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A typical, small system for projection on a flat or curved screen.

In the illustration above, a laptop running WATCHOUT is used as the production computer. This con-
nects to a network switch, which is then connected to a Dataton WATCHMAX media server. The
WATCHMAX unit could also be a self-build display computer running WATCHOUT software or a one
of Dataton’s WATCHPAX media server range. Both the production and display computers need to be
equipped with a WATCHOUT license key.

HINT: When connecting a single display computer to the production computer, a network switch may
not be required.

Depending on the graphics card, a self-build display computer can drive up to six displays. Dataton
WATCHMAX media servers offer four to twelve channel outputs as does the compact WATCHPAX 60
series; WATCHPAX 4 offers four outputs and WATCHPAX 20 two outputs. The display devices connect
using appropriate cables, such as DisplayPort, DVI, SDI or HDMI. Which cables to use depends on
the display devices as well as the outputs from the display computer

The next example shows four, vertically rotated screens controlled by two Dataton WATCHPAX 20
media servers.

The system is programmed using WATCHOUT production software running on the laptop. Alterna-
tively, you can use Dataton WATCHNET to schedule presentations or for interactive control.
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Production
computer

Display computer
(media server)

Network switch

In WATCHOUT, you can arrange the displays in the Stage window as they are placed on the wall -
including the gaps between display surfaces. WATCHOUT takes care of distributing the content
across any number of display computers.

The last example shows how you can project onto a physical object using a 3D Mapping Projector.
The hardware hookup is very similar to the first example. The production and staging workflow is
quite different, however, involving various 3D techniques such as modelling, UV-mapping and textur-
ing, as well as precise calibration of the projectors’ positions (see “Calibrate”).

Projectors

Display computer

(media server) I

P dataton

Production
computer

Network switch

Projecting onto a physical object using 3D mapping projectors.

PRODUCTION COMPUTER

This is the focal point for your WATCHOUT production work. It is where you collect all the source
material, or media, to create your presentation. Using the WATCHOUT production software (see
“Software Overview”), you simply drag media into your presentation, positioning it in the Stage win-
dow and along the Timeline.
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The production computer talks to the display computers through the network, transferring media files
for you as required, as well as controlling the playback of the show. It can also be used for audio
playback while running the show.

DISPLAY COMPUTERS/MEDIA SERVERS
Display computers connect to the display devices and handle all the hard work associated with ren-
dering images and video. They also apply edge blends, geometry correction and can play audio.

The fact that the system can use multiple display computers means it is scalable to virtually any size: as
more displays are added, you can also add more computing power to drive these displays. A display
computer may drive up to six displays, depending on hardware and performance requirements.
Dataton media servers (WATCHPAX and WATCHMAX range) offer up to 12 outputs, depending on

model.

Use Dataton WATCHPAX or WATCHMAX media servers if you prefer something that's ready to use
out-of-the-box. Alternatively, configure your own Windows-based PC computer (see the chapter on
Installation as well as the recent tweak list).

NETWORK

The network ties the parts together, allowing the production computer to manage all display comput-
ers. It is created by connecting the computers to a network switch.

As you add new media to your presentation, or revise existing media, these changes are automati-

cally propagated, via the network, to the appropriate display computers. The network also transfers
your display configurations, timeline programming and other aspects of your presentation. With all
this material residing on the display computers, very little information needs to be sent over the net-

work during playback, avoiding network congestion.

DISPLAY DEVICES

WATCHOUT can be used with virtually any display device that can be connected to a computer, such
as projectors, LCD panels and LED walls.

MINIMAL SYSTEM CONFIGURATION

Although you can use the WATCHOUT production software on its own
for practice, you won't be able to appreciate the full power of
WATCHOUT until you start connecting display computers. The illustration
shows a minimal system, consisting of the following components:

* Laptop computer running WATCHOUT production software, equipped
with a WATCHOUT license key.

* Network, connecting the two computers together via a hub or switch.

e Computer running WATCHOUT display software and equipped with a WATCHOUT license key
(Dataton WATCHMAX media server in this case).

e Display device, for example, a monitor or a projector.

Don't forget that each computer in a system running WATCHOUT must have a WATCHOUT license
key connected (see “License Keys”).

NOTE: The production software can be used on its own without a license key. License keys are
required for using the display software.
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ALTERNATIVE DISPLAY LAYOUTS

WATCHOUT is very flexible in terms of how you arrange the displays. The illustrations below show
some more unusual display arrangements. In addition, WATCHOUT also supports projection on
curved surfaces and onto physical objects (3D mapping).

IMAGES, SOUND AND VIDEO
A WATCHOUT presentation uses multiple media, such as still images, video clips, sound files, efc.
WATCHOUT accepts a wide variety of still image and video file formats. Transparency (alpha chan-

nel) is supported in both still images and video files. For more details on the various kinds of media
supported by WATCHOUT, see the Media chapter.

LIVE FEEDS
In addition to pre-produced content, WATCHOUT can also incorporate live feeds of various kinds:

* Video cameraq, e.g., for integrating a live image of a speaker into the presentation.
e Other external feeds, such as a DVD player or a satellite link.
e Computer graphics, e.g., a PowerPoint presentation.

® RSS feeds or other external data sources managed through the WATCHOUT Dynamic Image Server
(see “Dynamic Images”).

Some live feeds require additional hardware, such as capture cards, in order to bring the signal into
WATCHOUT . In other cases, the external feed can be brought into the system through the network,
(see “NDI video”).

EXTERNAL CONTROL

Use Dataton WATCHNET to configure a touch panel as an interactive front-end that can be used from
iPhone, iPad, or similar device, controlling any number of WATCHOUT clusters, as well as to schedule
presentations and manage the system.

WATCHOUT can also be used together with other control systems and technologies to build powerful
presentation environments. Connect other devices and systems to WATCHOUT using a computer
network, serial port, MIDI, DMX-512, RTTrPM protocol or a timecode feed (see separate sections and
appendices for details on external control options).

INTRODUCTION 8


http://www.dataton.com/watchnet

SOFTWARE OVERVIEW
This section provides a brief introduction to the WATCHOUT production software.

@& WATCHOUT + Show - O p

File Edit 5Stage Preview Media Timeline Tween Window Help

OFF LINE Media

Name Thumbnail Type Information
ooy > o N s

> car Folder 8 items
DLogo.png "D dataton Image 1844 x 447
Flower 02.png 1% Image 250 x 250
Human.Jds I@I 3D Model 410 x1000

Hydraulics.wav Ei] ) Sound 2 channels

Main Timeline
0:36.8282

% LAYER 10

Messages
* Input 3 |:| g Flower 02.png

Mame| Descripti| Value

® cnh nmx1  0SES | > LAYERS WATanllT
0 Task : -

Name Status igge ot

Timeline 2 > > Position

vV Scale

Q<40

STAGE WINDOW

The Stage window allows you to organize displays and projectors to reflect their expected position. It
also provides a preview of the end result, and allows you to manipulate the position and movement of
images.

TIMELINE

Media files are dragged from your hard disk into a timeline window, where they appear as horizontal
boxes called cues. Each cue features a thumbnail icon of the media. You determine timing and dura-
tion by adjusting the position and length of these cues. The horizontal layers in the timeline window
represent the back-to-front stacking order of overlapping images.

In addition to the Main Timeline, shown above, you can add any number of Auxiliary Timelines
through the Task window. Those timelines can be started and run independently of the main timeline.

MEDIA

As media is added, thumbnails representing the media files also appear in the Media window. This
acts as a central repository for all media used in your presentation. It provides information about each
media file, and allows the file to be easily accessed for editing or other purposes.

CUES AND TWEEN TRACKS

The cues in the timeline window can be enhanced by applying tween tracks. Tween tracks control the
dynamic behavior of media on stage, such as position, scale or transparency. WATCHOUT sports a
variety of tween track types, all providing real-time effects that can be programmed or even controlled
live using external inputs (see “Cues”).
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SYSTEM MANAGEMENT

Changes to the presentation are transferred to the display computers as you make them. This includes
any media you have added, or modified. As the media files and cues are cached locally on each
display computer, the show is ready to run at any time by simply pressing the spacebar.

WATCHOUT TRAINING VIDEOS
To learn more about WATCHOUT, check out the training videos available here:

https://www.dataton.com/training-support/academy/academy-training-videos

DATATON ACADEMY
Dataton offers industry-certified training worldwide. For a list of training sessions and information on
course content, please visit the Dataton website:

https://www.dataton.com/training-support/academy

WHERE TO GO FROM HERE

To use WATCHOUT for running actual, full-scale presentations, you need to hook up media servers
and projectors (or other display devices) as shown in the illustration under System Overview. You also
need to acquire WATCHOUT License Keys. The Installation chapter provides details on setting up and
configuring a complete system.
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2. INSTALLATION

This chapter tells you how to install the required software components and connect the hardware.

SOFTWARE
WATCHOUT is Microsoft Windows-based software. Obtain the “WATCHOUT Installer” by

downloading it from

WATCHOUT_
Installer_6.2.2

https://www.dataton.com/downloads/watchout

Run the installer and follow the on-screen instructions. This installs both the production and
display software components, adding them to your Start menu.

INSTALLING QUICKTIME
In addition to WATCHOUT, you may also want to install Apple QuickTime, available from: s

https://support.apple.com/kb/DL837

Quickkirne
Inskaller

NOTE: QuickTime is not required by WATCHOUT. Install it only if you need to play video
content encoded using legacy video codecs, or if you want to use the Audio or Video Export functions
in the WATCHOUT INSTALLER production software.

NETWORK

The production computer and all display computers must be connected using an Ethernet network,
which comes standard on most computers. Wireless networks are generally not recommended.

STAND-ALONE SYSTEM
For a minimal system configuration, connect all computers to a network switch.

Network switch

Production
computer

WATCHMAX

"D dataton Display computer

(media server)

Projectors

For stand-alone operation of a WATCHOUT system, this is usually all you need to do in terms of hard-
ware connection.
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NOTE: If you're using just one display computer (possibly driving multiple displays), you can simplify
the system even further by removing the switch and connecting the production computer directly to the
display computer.

COMPUTER ADDRESSING

All WATCHOUT computers on the network must have a unique address. Addresses may be assigned
automatically or manually. In most cases, automatic addressing is preferred, since it makes system
setup and configuration easier, and avoids configuration errors such as assigning the same address to
more than one computer. When using automatic addressing, use the Network Window in
WATCHOUT to assign computer names.

Many networks support dynamically assigned addresses based on the DHCP standard, which is a
form of automatic addressing. If that applies to your network, you're good to go. If your network
doesn’t support dynamic addressing, your computer will generally fall back on self-assigned address-
ing (also known as “Link-Local”), where each computer grabs an address for itself after first making
sure that it isn’t already in use.

NOTE: If using self-assigned addresses, ensure all computers on the network employ this method, or
they will not be able to communicate with each other.

If you choose to use manual addressing, you must assign a fixed IP address to each computer (see
“Manual Addressing”).

LICENSE KEYS

Each computer in the system requires a WATCHOUT license key, including the production .
computer. Plug the key into any free USB (Universal Serial Bus) port on the computer. L )

~ dataton

NOTE: Dataton WATCHPAX and WATCHMAX have internal licenses, and don't require WO

any external license keys. b 024

HINT: You can run the production software off-line without a license key connected. A key is needed
when you go on-line to communicate with the display computers.

DISPLAY DEVICES

WATCHOUT can be used with any display technologies, such as projectors, LCD screens and LED
wall processors. Generally speaking, you can use any display device that's compatible with the dis-
play card in the display computer (media server).

You can connect up to six display devices per display computer, depending on your computer’s graph-
ics configuration and other hardware capabilities. All displays must be connected to the same graph-
ics card.

In addition, some of Dataton’s own media servers have an additional eight outputs through SDI.

To configure the graphics card settings of Dataton media servers (WATCHPAX and WATCHMAX units)
press Ctrl-W and select “GPU Settings” from the File menu. For non-Dataton display computers, please
see “Display Properties” later in this chapter.

It is also possible to open the configuration panel for the capture card(s) installed in certain Dataton
media servers. To do so, press Cirl-W and select “Capture Settings” from the File menu.

Command-line options of newer generation of Dataton media servers, for example WATCHPAX 60,
may be set through the “Edit Command Line Options” entry under the File menu.
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Dataton WATCHPOINT

File Videoln AudioOut MIDIIn Timecode 5Dl Help
Full Screen Ctrl+W

Edit Startup Script
GPU Settings
Capture Settings
Re-launch

Edit Command Line Options

Shut Down
Exart Chrl+X

SOUND

Sound can be provided through any of the display computers, or through the produc-

tion computer. Simply connect the sound output from the computer (usually a 3.5 mm o @%—'
mini-jack) to the amplifier or powered speakers. For more details, see “Sound Set- Sound output
tings” later in this chapter. jack symbols.

If you need to run the computer’s line-level audio signal a long distance, you should

use an audio line level transformer. This converts the unbalanced signal coming from the computer to
a balanced signal, thereby reducing the risk of hum and noise when connected to a professional
audio amplifier.

USING MULTIPLE SOUND CHANNELS

You can have multiple display computers playing at the same time, which gives you multiple audio
channels. The synchronization between computers is generally good enough for multi-language sup-
port or special effects sound tracks, but not for true, phase-accurate, multi-channel sound
reproduction.

Another option is to connect a multi-channel sound interface to your production or display computer.
This kind of professional interface can handle multiple phase-accurate sound channels. Furthermore,
many desktop-style computers support multi-channel playback using several 3.5 mm output jacks.

Audio Device Setting

Audio device settings include audio device selection, sample rate and WASAPI shared/exclusive
mode. In the production software, this is done in the “Audio Out” tab of the Preferences dialog box. In
the display software, press Cirl-W to reveal the menu bar, then choose the desired device, sample rate
efc.
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WATCHOUT supports WASAPI and ASIO drivers. Identify the type of driver by looking at the suffix of
the device name, [WASAPI] or [ASIO].

Preferences X

General EdgeBlend Control Conditions Video In  Audio Out  3p Cue Colors

Audio Device: AR T Configure...
WASAPI Mode: (@ Shared () Exdusive
Sample Rate: Auto w

Qutput Channel Limit: |g

2 Channel Detected

OK Cancel

Audio device settings

f= Dataton WATCHPOINT

File  ic

Line Qut 1)2 (2- AudioBox 1518YSL) [WASAPT]

Line ©ut 516 (2- AudioBox 1518¥SL) [WASAPI]

SPDIF Out (2- AudicBox 1518YSL) [WASAPT]

Line Qut 748 (2- AudioBox 1518¥SL) [WASAPI]

1J280590-4 (MYIDIA High Definition Audio) [WaSAPT]

Line ©ut 34 (2- AudioBox 1518YSL) [WASAPI]

Realtek Digital Output (Realtek High Definition Audio) [WASAPT]
Speakers (Fealtek High Definition Audio) [WASAPT]

ASIO4ALL w2 [ASI0]

AudioBox ASIO Driver [ASIO]

WASAPT Share Made  »

fo Dataton WATCHPOINT Rz Dataton WATCHPOINT

File fudio Dut  Help File Audio Out  Help

Audio Device Budio Device
Audio Sample Rate 3 Auto Audio Sample Rate

WaSAPT Share Mode  # &PI Share Mode Shared
Exclusive

LIVE VIDEO INPUT

WATCHOUT can integrate live video feeds using video input devices, such as capture cards or
IP-based streaming. This may be a camera feed, a satellite link, or the image displayed by another
computer (e.g., a Microsoft PowerPoint® presentation). For examples on some suitable video input
solutions, see “Live Video Input”.
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FEEDING MULTIPLE DISPLAY COMPUTERS

The video signal must be fed to each computer on which it will appear. For instance, if your system
uses five display computers, and you want to show a live video image straddling two of those five
display areas, both those display computers must be fitted with an appropriate input device to capture
the signal.

If you are feeding multiple display computers with an identical signal, a video distribution amplifier,
matrix, splitter or switch may be required. Suitable devices are available from a wide range of
manufacturers.

SOFTWARE DRIVER INSTALLATION

Most capture cards require specialized software drivers. Although the driver is sometimes delivered
on a DVD with the card, it's often a good idea to check the manufacturer’s web site for the latest driver
version.

WATCHOUT CONFIGURATION

Configure each WATCHOUT display computer that is due to show live video as described under Add
Live Video. Optionally, you can also choose to show live video in the Stage window of the production
computer (see “Video In” under Preferences).

MIDI AND DMX-512

WATCHOUT can communicate with other devices using the MIDI and DMX-512 industry standard
protocols, as well as devices connected through a serial or network data link. MIDI communication
requires a Windows compatible MIDI interface, which is often connected through a USB port. Follow
the instructions included with your MIDI interface to install any required software or drivers.

See the chapter on Inputs and Outputs, as well as MIDI Show Control for more details.
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VNC SERVER SOFTWARE

If you want to use the Computer Screen media item in WATCHOUT to integrate a live computer dis-
play into your presentation over the network, for example, to display Excel or Powerpoint as part of a
speaker-support presentation, you must install VNC server software on the remote computer. This must
be a separate computer — it can not be one of the computers running WATCHOUT software.

NOTE: This software is not required for basic WATCHOUT functions. You only need to install this
software if you want o use the “Computer Screen” feature (see “Add Computer Screen”).

VNC (Virtual Network Computing) server software is available for a wide variety of operating sys-
tems. The instructions below describe its installation under Windows. VNC is free software, available
in several forms:

http://www.realvnc.com/
http://www.uvnc.com/

Download the VNC server software from one of the above locations, and follow the installation
instructions. You're advised to start the VNC server software as a user mode application.

For best performance, use a reasonably fast computer to run the VNC server software and the appli-
cation you wish to incorporate into your presentation (for example, Powerpoint).

Make sure that the VNC server computer is connected to the WATCHOUT network, and has a fixed,
known IP number in its TCP/IP settings. This IP number and other TCP/IP parameters must match the
network to which it is connected. Also verify that its firewall is disabled, or that the VNC port 5900 is
open in the firewall (see Firewall Settings).

The first time you run the VNC server software, you will be prompted to enter a password. The VNC
server software then appears as an icon in the lower right corner of the screen while running. Pointing
at this icon displays the IP number of the VNC server. Double-lick the icon to change the settings.

E VMC Server Properties (User-Mode) Iﬁ
| Sharing I Deskdop | Capture Method | Legacy
Authentication | Connections | Inputs

71 Mo Authentication

@ YMC Password Authentication

MT Logon Authentication Configure

Encryption: (AT Generate Keps

[] Prompt local uzer to accept connections

Only prompt when there iz a uzer logged on

QK ] I Cancel Apply
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MANUAL ADDRESSING

Some, or all, computers in your system may need to have a network address assigned manually. This
is particularly important for computers that need to be accessed by their network address (IP number)

from other computers, such as when controlling WATCHOUT from a separate control system. To

assign addresses manually, follow the instructions below.

Right-click (Windows 10) or click (Windows 7) the Start button and choose Control Panel. Select
“Small Icons” under “View by”. Open the “Network and Sharing Center”. Click “Change adapter
settings”, then right-click your “Ethernet” or “Local Area Connection” or and choose “Properties”.

=HREN X

-
& _ Mot connected

L" Wirelesz Metwork Connection
e
3@ d’-‘m] Atheros ARS2E85 Wireless Metwork...

LJ\J Lt < All Control.. » Metwork and Sharing Center - | +4 | | Search Con...
|@| A|
Control Panel Home - — = 53
Manage wireless networks @Uv| B/ « Networka.. » Network Connections » - ‘¢f| | Search Net.. 0 |
Change adapter settings
Change advanced sharing Organize ~ = - i '@'
settings
- Bluetooth Network Connection ~ Local Area Connection

R L-.\g"‘.\ Mot connected L---.LE Metwork

L 4 9 Bluetooth Device (Personal Area ... @ Realtek PCle GBE Family Controller

Ensure that “Internet Protocol Version 4 (TCP/IPv4)” is available and selected.

" 3
4 Local Area Connection Properties ﬁ

™

Metworking

Connect using:

L¥ Broadcom MetXtreme Gigabit Ethemet

This connection uses the following items:

% Cliert for Microsoft Networks

SQDS Packet Scheduler

O BF“E and Printer Sharing for Microsoft Networks

[ - Intemet Protocol Version & (TCP/IPvE)

S Iiemet Protocol Version 4 (TCP/IPv4) |

i Link-Layer Topology Discovery Mapper /0 Driver
& Link-Layer Topology Discovery Responder

Description

Transmission Control Protocol/Intemet Protocol. The default
wide area network protocol that provides communication
across diverse interconnected networlks.

0K || Cancel
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Choose “Internet Protocol Version 4 (TCP/IPv4)”, click “Properties...” and enter the desired IP address
and other settings as desired.

i :
Internet Protocol Version 4 (TCP/IPv4) Properties @ﬁ

General

‘You can get IP settings assigned automatically if your network supports
this capability, Otherwise, you need to ask your network administrator
for the appropriate IP settings.

() Obtain an IP address automatically
(@) Use the following IP address:

IF address: /w2 .1568. 0 . 1
Subnet mask: 255,255 .255. 0
Default gateway:

Obtain DMNS server address automatically
(@) Use the following DS server addresses:

Preferred DMS server:

Alternate DNS server:

[ OK ][ Cancel ]

IMPORTANT: This example is applicable if you're building a stand-alone system. If your WATCHOUT
subnet is connected to a larger network, you should consult your network administrator.
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FIREWALL SETTINGS

The Windows firewall may interfere with normal operation of WATCHOUT. You can avoid this either
by disabling the firewall, or by configuring the firewall to allow WATCHOUT to function. To disable
the firewall, open the “Windows Firewall” control panel, as shown below.

NOTE: Instead of disabling the firewall fully, you may configure it to allow WATCHOUT and related
functions to pass. Consult your computer’s documentation on how to configure the Windows firewall.

-

[ SREEN
IL:‘._.JI\.._.J'I |ﬂ' ¥ Control Panel » All Control Panel ltems » Windows Firewall - | +3 | | Search Con... 2 |
I@I -
Control Panel Home . . . [
Help protect your computer with Windows Firewall
Allow a program or feature Windows Firewall can help prevent hackers or malicious software from gaining access .
through Windows Firewall to your computer through the Internet or a network, 7
® Change notification settings How does a firewall help protect my computer?
B Turn Windows Firewall on or What are network locations? -
off
&u Restore defaults Update your Firewall settings
# Advanced settings Windows Firewall is not using the [ '@Use recommended settings
recommended settings to protect
Troubleshoot my network your computer.
See also What are the recommended settings?

If the firewall is on, click “Turn Windows Firewall on or off.” This opens the “Windows Firewall Set-
tings” window, allowing you to turn off the firewall.

IMPORTANT: A WATCHOUT system should not be accessible from the Internet, or other external net-
work. If you need to access the Internet from your system, use a separate firewall device to protect
your complete system from security attacks.

=,

i = | B |

@Q'|ﬁ <« Windows Fir... » Customize Settings i | 1 | | S i |

o

Customize settings for each type of network
You can modify the firewall settings for each type of network location that you use,

m

What are network locations?
Horme or work (private) network location settings
@ (71 Turn en Windows Firewall

Block all incoming connections, including those in the list of allowed
programs

Motify me when Windows Firewall blocks a new program

-

I@ @ Turn off Windows Firewall (not recormmended)

[ 0K ][ Cancel ]

The firewall feature should be turned off. Otherwise it may interfere with the ability to
connect to and download media files to the display computers.
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DISPLAY COMPUTER SETTINGS

To achieve best performance and reliability in your WATCHOUT system, you need to adjust several
settings on all your display computers. Most of the settings below are found by clicking (Windows 7)
or rightclicking (Windows 10) the Start button and choosing Control Panel.

NETWORK

If you choose to use manual addressing for all your computers, follow the instructions given above
under “Manual Addressing” to assign those addresses. Specify a unique IP number for each display
computer by changing the last group of IP address digits.

NOTE: It is not usually necessary to assign addresses manually. When using automatic addressing,
make sure you access display computers by name and not by address, in case automatically assigned
addresses change (see “Computer”).

As an example: in a system consisting of one production computer and three display computers (in
this case Dataton WATCHMAX servers), you would end up with IP addresses assigned like this:

WATCHMAX WATCHMAX WATCHMAX
~p dataton ~D Jdataton ) dataton

192.168.0.1 192.168.0.10 192.168.0.11 192.168.0.12

If your WATCHOUT subnet is not stand-alone but connected to a larger network, you should consult
your network administrator for the correct IP number, subnet mask, and other parameters.

DISPLAY PROPERTIES
® |n your computer’s Control Panel, choose “Display” then “Adjust Resolution.”
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* Set “Resolution” to match the desired resolution for the display. If you have multiple displays con-
nected, select each display and set its resolution and other parameters.

F ||:| IEI EE N

QD _;|'__._; < Displ.. » Screen .. - | +y | | Search

-

Change the appearance of your display

Detect

m

Display: |1. LP1S6WH2-TLBA |
Besolution: ’1366 = 768 (recommended) vl
Orientation: ’ Landscape hd ]

Advanced settings =

e Click “Advanced settings.”

e Click the Monitor tab and set “Screen refresh rate” as set in your WATCHOUT presentation (see
"Display Framerate”), and click OK.

-
Generic PnP Maonitor and Intel(R) HD Graphics Properties M
Intel(R) Graphics and Media Contral Panel |
Adapter Manitar | Troubleshoot Color Management |
Maonitor Type

k'; Generc PnP Maonitor

L '?E_Eﬂmperties J

Maonitor Settings

Screen refresh rate:
60 Hertz -

Hide modes that this monitor cannot display

Clearing thiz check bowx allows you to zelect dizplay modes that thiz
monitar cannot dizplay corectl. This may lead to an unuzable dizplay
anddor damaged hardware.

Colors:
| True Color (32bit) v |

[ ok ][ Cancel || Aooly

In most cases you should choose “60 fps” in the WATCHOUT Preferences dialog box, and set the
display’s refresh frequency to 60 Hz.
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Some system configurations don't allow you to change the refresh rate. In this case, the Refresh rate
option will not be shown under the Adapter tab. This may vary depending on the display card, dis-

play card drivers and the display connected to the system.

IMPORTANT: While WATCHOUT will attempt to set the display resolution automatically, setting the
resolution manually is usually preferable. The reason is that some display adapters don't allow

WATCHOUT to set the most optimal display refresh frequency. By setting the display resolution and
refresh frequency manually before starting WATCHOUT, you avoid the risk of getting a non-optimal

display frequency.

SOUND SETTINGS

When using a display computer for sound playback, you must enable the correct sound output and

turn up its volume. Open the Sound control panel and make sure the correct output is activated. If not,
select the desired playback device and click “Set Default”.

% Sound

[E5C)

Playback |Recording | Sounds

Select a playback device below to modify its settings:

Waorking

Speakers

Realtek High Definition Audio
@. Working
i~

Realtek Digital Output
w Realtek High Definition Audio

Set Default

[

Ok

J l Cancel

l

Apply

=

The look of these windows may vary depending on the features of your audio interface.

Once you have selected the desired output in the list shown on the previous page, click Properties and

turn up the volume under the Levels tab.
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[} Speakers Properties Iﬁw

General | Levels |Enhanr_ements | Aduanced|
Realtek HD Audio cutput
0w
Aux -
0 1
CD Audio
0 m
Line In
0 o @)
Front Fink In
0 a
K ] [ Cancel Apply

NOTE: In some cases, such as when dealing with multi-channel sound systems, you may also need to
configure the sound outputs in WATCHOUT (see “Audio Device Setting”).

AUTO-STARTING WATCHOUT
If you want WATCHOUT display software to start automatically when you turn on your computer,
install a shortcut to the display software in the Startup folder like this:

e Under Windows 10: open the Startup ltems folder by pressing Windows-R to open the Run dialog
box and entering “shell:startup” (without the quotes).

e Under Windows 7: click the Start button and choose “All Programs”. Right-click on “Startup” and
choose Open.

® Open your WATCHOUT installation folder and locate the program named WATCHPOINT, which is
the WATCHOUT display software application.

 Using the right mouse button, drag WATCHPOINT from the WATCHOUT installation folder into the
Startup folder, then choose “Create Shortcut here”.

® Restart your computer to verify that the display software starts as desired.

IMPORTANT: Make sure you drag using the right mouse button to create a shortcut in the Startup
folder. Do not move the WATCHPOINT program into this folder.

In addition to launching WATCHOUT, this shortcut can also pass on various optional parameters.
These parameters can further control how WATCHOUT is started, as well as initiate various automatic
actions. See the appendix on Command Line Options for full details.

NOTE: In some cases, other programs that also start automatically may load after WATCHOUT and
interfere with WATCHOUT, for example causing it to not start in full screen mode. If so, use the
“Delay” command line option to delay the start of WATCHOUT as needed.
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DISPLAY COMPUTER OPTIMIZATIONS

While the basic configuration of the display computer outlined above is sufficient in many cases, some
computers require additional work to achieve best possible performance. This section provides some
general hints and pointers on how to proceed.

NOTE: The information below does not apply to Dataton WATCHPAX and WATCHMAX units which
are supplied ready tuned for WATCHOUT.

FORMATTING THE DISK AND INSTALLING WINDOWS

If you intend to use a computer primarily as a WATCHOUT display computer, it makes sense to
re-format the hard disk and then install only Windows, required device drivers and WATCHOUT. This
avoids many problems caused by various pieces of software that are often pre-installed on computers,
or that may have accumulated over time.

NOTE: You don’t have to reformat your hard disk in order to use WATCHOUT. This is an advanced
procedure that helps in obtaining the best possible performance. You can apply all other adjustments
described in this appendix even if you choose not to dedicate the computer to WATCHOUT.

To prepare your computer in this way, first make sure that the hard disk doesn’t contain any important
information. You should perform a backup if you're unsure about the content of the hard disk. Then
start the computer from the Windows installation disk, and follow the on-screen instructions. Early on
in the installation procedure, you will be asked where to install Windows. As part of this, you will get
the opportunity to remove the existing partitions and create new ones, which you should do.

For best performance, create a smaller (50-100 GB or so) partition for Windows and any other appli-
cations you may want to install. This partition will become the C: drive. Leave the remainder of the
disk unformatted for now.

Proceed with installing Windows on the newly created, small partition. Once that's done, install
required device drivers (graphics or sound card drivers, etc), and perform any additional adjustments
mentioned in this appendix.

INSTALLING WATCHOUT
Before installing WATCHOUT, you need to format the remaining space of the hard disk:

® Right-click Start and choose Control Panel > Administrative Tools.

® Double-click Computer Management.

e Click Disk Management in the list. Right-click on the Unallocated space.
® Choose “New Partition”.

Proceed with creating a primary partition of the maximum size.
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If installing on a rotating-platter disk, choose the NTFS file system with an “Allocation Unit Size” of
32K on the last page of the “New Partition Wizard”. Generally, it is OK to also select “Perform a
Quick Format”. Specifying a larger allocation size greatly reduces the tendency of disk fragmenta-
tion, at the cost of a small amount of wasted disk space. Given the fact that most WATCHOUT media
files tend to be rather large, this should not have any practical disadvantages. This is not needed if
you're using a Solid State Disk drive.

Once the formatting is complete, the new partition will appear as the D: disk drive. Create a

WATCHOUT folder on this disk, and install WATCHOUT here. When the WATCHOUT installer asks
where to install WATCHOUT, choose the newly created WATCHOUT folder on the D: drive.

NOTE: Under Windows 7, the “Administrative Tools” option is hidden by default. To show it on the
Start menu, right-click the task bar and choose Properties to display the “Taskbar and Start Menu

Properties”. Click the “Start Menu” tab. Click the “Customize” button. In the list, make sure that “Dis-
play Administrative Tools” is enabled.

WINDOWS MEDIA CENTER
Under Windows 7, make sure you disable Windows Media Center: If not, this feature in Windows

may interfere with some functions in WATCHOUT.

e Rightclick (Windows 10) or click (Windows 7) the Start button and choose Control Panel.
® Select “View by: Small Icons” then choose Programs and Features.

® On the left-hand panel click on “Turn Windows Features on or off”.

e Scroll down to “Media Features” and expand it.

¢ Uncheck Windows Media Center.
NOTE: Windows Media Center is not available under Windows 10.

USER ACCESS CONTROL SETTINGS

The User Access Control (UAC) feature of Windows may interfere with certain functions in
WATCHOUT, particularly when running on unattended display computers. UAC, per definition,
assumes that there is a user. WATCHOUT display software is often run in an unattended way, with no
user standing by to click buttons or type passwords. Furthermore, you generally shouldn’t run
WATCHOUT on networks that have direct Internet access, or any other kind of unrelated (and possibly
harmful) traffic. Under those specific circumstances, you're better off without UAC, since it tends to
cause more problems than it solves.
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To turn off the UAC:

¢ |nside the Control Panel window, click User Accounts.
® Click Change User Account Control Settings.

* Drag the slider to Never Notify.

e Click OK.

HARDWARE SYNCHRONIZATION

While WATCHOUT's software-based synchronization across multiple display computers is generally
sufficient, there are some cases where absolute, frame-accurate synchronization is required. An exam-
ple is when using multiple display outputs or computers to drive a single LED wall. Since there are no
edge-blend areas or display edges to cover up any minor discrepancies in this case, even minute
differences in synchronization are readily apparent.

To eliminate tearing between the outputs of multiple display servers, all outputs must be locked to a
common synchronization source. This can be accomplished by using workstation graphics cards in
conjunction with synchronization cards. SDI outputs can be locked to external synchronization sources
using the functionality of SDl-enabled Dataton media servers, together with the appropriate setting in

WATCHOUT.
Examples of hardware-assisted synchronization solutions include:
* NVIDIA Quadro G-Sync I, when used in conjunction with select NVIDIA Quadro graphics cards.

* ATl FirePro S400 Synchronization Module, when used in conjunction with select AMD FirePro
graphics cards.

o WATCHPAX 60 (model C) with synchronized SDI outputs.

NOTE: When using AMD graphics, you need the synchronization module to accomplish frame accu-

rate synchronization even within a single graphics card. This is generally not the case when used with
NVIDIA graphics.

For more details on hardware synchronization, see “Use as Synchronization Chain Master”.

GENERAL PERFORMANCE

The performance of a PC is often degraded by numerous small programs and services running in the
background. Such programs consume considerable system resources, and may serve no purpose on
a WATCHOUT display computer. You can enhance performance by identifying and removing, or
disabling, such programs.

IDENTIFYING BACKGROUND PROGRAMS
To identify any unwanted background applications or services:

® Close all open windows.

e Under Windows 10; open the Control Panel and click “Administrative Tools” then double-click
“System Information.”

e Under Windows 7; click Start, type “System Information” and press Enter.

e Select “Software Environment, Running Tasks” in the list to the left (see illustration below).
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The list to the right displays all currently running programs. Look specifically for tasks whose path is
anything but “c:\windows\system...”. To see which programs are started automatically, choose “Soft-
ware Environment, Startup Programs” in the list to the left.

B Systern Information [=|[E ][]
File Edit View Help
System Summary * || Mame Path &
ot Hardware Resources atiZevioc.exe Mot Available |
il Campnnents. ati2ewvsorexe Not Available 1
WSt En1.f|.r0nment audiodg.exe Mot Available
S]I,fﬁterg Dr.lvers =||| ccc.exe chprogram files\ati technologi..
----S|gr.1& TNEL . C5rss.exe Mot Available
- Environment Yariables :
Brint Job C5rS5.8Xe Mot Available
- Print Jobs
W ey cwm.exe chwindows\system324dwm.exe
M cunning Tasks explorer.exe chwindows\explorer.exe
T T lsass.exe Mot Available
. lsm.exe Mot Available
- Program Groups - || ma_cmidi_inst.exe Mot Available e
PR T 3 ¥ m b

HINT: The names listed in the Running Tasks and Startup Programs lists are often cryptic, and may be
hard to associate with a particular program. In this case, looking at the path leading to the program’s
file can provide a valuable hint. In particular, if the program is installed under “c:\Program Files\...”,
you should be able to learn more by looking inside its installation folder.

REMOVING BACKGROUND PROGRAMS
Once you have identified any undesired background programs, you should either remove or disable
them. If you know you won't need a background program, remove it from the computer.

To remove a program, open the “Programs and Features” control panel, choose the program, and
click “Uninstall”. Follow the subsequent instructions on how to remove or uninstall the program.

If you're uncertain about removing the program, or if the program doesn’t appear in the “Programs
and Features” control panel, you may choose to disable it instead. This can sometimes be done with
configuration options in the program itself. Other programs don’t offer this capability, forcing you to
either uninstall the program or disable it using other means.

Background programs often identify themselves by an icon on the taskbar, in the lower right corner of
the screen. Right-click such an icon to open its menu. Sometimes the menu includes a “Disable”,
“Close” or “Do Not Load” item. It may include “Open”, “Configure” or “Properties” items that allow
you to set various options, including the automatic loading of the program at start-up. After disabling
a program in this way, restart the computer to verify that the program is no longer active. Some pro-
grams only allow you to disable them temporarily, and will then load again the next time you start the
computer.

Another way to locate and disable startup programs is by using the Windows Task Manager (Win-
dows 10):

e Press Ctrl-Alt-Delete.
e Select “Task Manager”.

e Click the “Startup” tab.
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* Locate undesired startup items and disable those by right-clicking and choosing “Disable”.

NOTE: Under Windows 7, the “msconfig” utility can perform similar functions.

SYSTEM SERVICES

Most background activities are not run as regular programs, but as System Services. To view system
services:

* Right-click Start and click Control Panel > Administrative Tools.
® Double<lick Services.

* Sort by “Status” to see all Running services together.

4 Services El@

File Action View Help

" Services (Local]

-~

Application Layer Gateway Service | Name Description Status Startup Type =

w Application Experi... Processes a.. Manual

Ll ee 2 Facilitates t...  Started

w Application Infor... Manual

Description: o Ati External Event ... Started Automatic
Pr':"'”'jET 5|i|pp|:.|rtff|:|r3ird party " Background Intelli... Transfers fil... Manual
P s o e ~: Base Filtering Engi... The Base Fil... Started Automatic -
Connection Sharing

L il 3

\ Extended /{Standard f

This list provides detailed information on each service. Select a service in the list for a description.
There are numerous services, many of which are not needed on a computer dedicated to running
WATCHOUT display software. Not all services are running — only those listed as “Started”. To disable
a service, double<click it and set its “Startup Type” to Disabled.

For more information on what the various services do, and which ones you may disable (or set to
“Manual”), visit one of the many web sites dedicated to tweaking Windows for better performance.

DISABLING AUTOMATIC UPDATES

While keeping your computer up-to-date with the latest system software version is generally a good
idea, it may not apply to your display computers. Windows 10 will automatically download and
install new system software in the background (assuming it has Internet access), which may interfere
with show playback, display on-screen prompts, or similar. In many versions of Windows 10, this
feature can not be easily disabled.

One way to avoid automatic updates is to make sure your WATCHOUT system doesn’t have Internet
access. That's often a good idea anyway to make sure nothing from outside interferes with your pre-
sentation. When that's not possible, you can prevent automatic updates by disabling the Windows
System Service responsible for this functionality:

® Proceed as described above under “System Services”.
® Locate the service named “Windows Update”.
e Right-click the service and chose Properties.

e Set “Startup Type” to Disabled.
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Keep in mind that once disabled, your computer will no longer receive any updates. You may want to
occasionally reset this setting to its default value and re-start your computer with Internet access to
allow it to update if you're concerned with keeping the operating system up-to-date.

See here for more details on this topic:

http://www.thewindowsclub.com /turn-off-windows-update-in-windows-10

USING A SOLID STATE DRIVE

Whenever possible, choose an SSD, or other high-performance solid-state storage solution, for storing
your WATCHOUT show data on each display computer. This avoids the problem of disk fragmenta-
tion, and provides much faster access to the media files. This is particularly important when driving
multiple displays, or when playing image sequences or other lossless video formats.

OTHER ISSUES

This section lists some other issues known to cause problems from time to time. The WATCHOUT forum
also contains some details on configuring WATCHOUT as well as general troubleshooting:

http://forum.dataton.com/forum/2-watchoutforum/

VIDEO PLAYBACK

Some DVD player programs — often included with graphics cards or DVD drives — may interfere with
the ability of WATCHOUT to play back video content (including some related audio formats). To solve
this problem, uninstall the DVD player application and all its components.

SOUND PLAYBACK

You need to install the proper software driver for your sound interface. The driver received with your
computer, operating system or sound card is usually sufficient, but you should check the sound card
manufacturer’s web site to make sure you have the latest driver version installed — particularly if you're
experiencing problems relating to sound playback.

When installing or updating sound card driver software, avoid installing other associated software.
Additional software is often provided that will run as background applications. You may have to
check for and remove such software after installing/upgrading sound card drivers

DEFECT DRIVERS

Performance and reliability problems may be caused by defect software drivers. Such problems can
be hard to diagnose. More often than not, it's easier to start from scratch by re-formatting the hard
disk and re-installing Windows and required device drivers only.

CLONING A COMPUTER

A WATCHOUT system typically uses multiple, identical playback computers. Performing the above
trouble-shooting and tuning operations on multiple computers is tedious. An alternative is to get one
display computer working properly, and then clone its hard disk to the others. This, of course, assumes
that they all have the same hardware configuration.

A fast and convenient method for cloning the hard disk is to use True Image, from Acronis:
http://www.acronis.com/

Using this program, you can clone a hard disk to another computer either across a network or using a
CD-ROM.
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IMPORTANT: While the cloning procedure copies everything on the hard drive, it does not automati-
cally perform any firmware (BIOS) or similar upgrade. You may need to perform any motherboard
upgrades manually after cloning the disk.
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3. WINDOWS

All WATCHOUT windows reside inside a desktop window, with a menu bar running along its top. You
can resize the desktop window by dragging any of its outer borders or corners. Minimize or maxi-
mize it using the buttons in the upper right corner. Clicking the close box is equivalent to choosing
Quit on the File menu.

Move a WATCHOUT window by dragging its title bar. Resize a window by dragging any of its cor-
ners or outer borders.

@ WATCHOUT + Show o = X
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Clockwise from top left. The Stage window shows the display areas and a preview of the presentation.
The Media window lists all media used in your presentation. The Main Timeline window shows the
layers, cues and tween tracks. Other windows are described later in this chapter.

Opening Windows
Many windows are opened through the Window menu. Hence, if you accidentally close a window,
look here to re-open it. To open an Auxiliary Timeline window, double-click its task in the Task window.

Window Layouts

Window layouts can be saved and loaded in the Layout submenu of the Window menu. To save a
layout, just select a preset under the “Save Preset” submenu, or use the keyboard shortcut
Ctrl+Alt+<n>, where <n> is the number of the preset.

To load a layout, select the corresponding preset under the “Load Preset” submenu, or hit Alt+<n>.
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The layout can also be reset to the default layout (as seen when creating a new show), by selecting
“Reset” in the Layout menu.

Window Help
Layout * Load Preset * Preset 1 Alt-1
iere Save Preset L‘x’ » Preset 2 Alt-2
Media Reset Preset 3 Alt-3
»  Main Timeline =i i
Preset 5 Alt-5
Input Preset6  Alt-6
Output Preset7 A7
Task Preset 8 Alt-8
Status Presetd A9
Message Preset 10 Alt-0
Metwork
License Manager

Loading a preset window layout:

Popup Menu

A rightclick contextual popup menu has been added to most of the windows in WATCHOUT. In gen-
eral, the contents of the popup menu reflect the Edit menu. The contents of the menu may change
dynamically, however, depending on where you click, and what is currently selected.

More information on what commands can be found in which context, see the sections about each
window.

STAGE WINDOW

The Stage window is used to add and arrange the display areas used in the presentation. It also pro-
vides a preview of your presentation as you move along the timeline, and lets you position media on
stage. The title bar shows the ON/OFF LINE status. While on line, the production software controls
the display computers. The following gestures can be used in the Stage window:

* Control<lick to zoom in (changing the preview scale).
e Control-drag to zoom in to the specified area.
e Control-Shift-click to zoom out.

e Control-Alt-drag to pan the window (scrolling its content).

HINT: The commands on the Stage and Preview menus govern the behavior of the Stage window and
its preview functionality.

ADDING DISPLAYS AND PROJECTORS
To add a display device to the Stage window, choose one of the Add... commands on the Stage
menu. See “Add 2D Display/Projector” and following sections in the Commands chapter for details.

You can also add a display device using the right-click popup-menu. To do so, make sure the Stage
window is selected, then right-click anywhere in the Stage (not on a display). The popup-menu gives
you the same options as the Stage menu. The display device is then created at the position you
right-clicked.
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SETTING THE STAGE SCALE

Set the viewing scale for displays and images using the “Scale” command on the Stage menu. Alter-
natively, you can interactively set the scale by clicking in the Stage window while holding down the
Control key. This displays a magnifying glass that allows you to zoom in at the clicked location. Drag
with the magnifying glass to zoom to a specific area. Control-Shift-Click to zoom out.

ADDING MEDIA

Add media to your presentation by dragging it to the desired location in the Stage window. A corre-
sponding cue will be added to the timeline window at the currently selected layer and time position.
Alternatively, drag the media to a timeline. To remove the media from the Stage window, remove the
corresponding cue from the timeline.

POSITIONING MEDIA ON STAGE

You can position media on stage by dragging its preview in the Stage window. To do so, first select
the timeline window, then drag the image in the Stage window. Press the Shift key to constrain the
move. Double-click a Cue or an individual Position tween point to edit the position numerically (see
“Initial Stage Position”and “Position”).

IMPORTANT: To change a position tween point, first click the tween point to go to its exact time posi-
tion, then move the image. If you don’t go to the tween point first, a new tween point may be added
instead.

USING STAGE TIERS FOR COMPLEX DISPLAY ARRANGEMENTS
The straightforward method of adding displays to the stage, as described on the previous page,
works fine in most cases. However, more complex display arrangements call for a different approach.

Assume, for example, that you want to make a display layout consisting of a main area with three
overlapping (edge blended) projectors, plus one detached projector on either side, and finally a
high-resolution plasma display showing the center part of the screen. This plasma display could be
placed outside the theater, as a preview display. The detached projection screens on either side of the
center area will generally be used as part of the main show, but will occasionally show different
images to augment the center screen.

Desired display layout: Side displays (orange], main center area (red, green, blue), a
larger, separate display (purple).

Merely adding all six displays to the stage will not work as desired for the following reasons:

* The large, separate display overlapping the three projectors in the center will cause WATCHOUT to
attempt to edge blend all these four displays (overlapping displays automatically get an edge-blend
gradient).
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* Panning large images sideways on the main center area, or on the side screens, will make those
images intrude on the adjacent display areas. That's fine while using all five projectors as a single,
large canvas, but not when using the side displays independently.

You can overcome these problems by placing each set of displays on their own stage tier. Stage tiers
act as independent, named levels on the stage. Edge blending occurs only among displays on the
same tier. Furthermore, timeline layers can be associated with specific tiers only, preventing their
images from spilling onto displays on other tiers.

Top: The tier named “Separate”, with its single high-resolution display. Middle: The tier
“Sides”. Bottom: The tier “Main” with the three overlapped projectors.

To create additional tiers, choose “Tier: Add” on the Stage menu. To add displays to a specific tier,
first select that tier on the Tier sub-menu of the Stage menu. To associate a timeline or a layer with @
stage tier, see “Stage Tiers".

ROTATING THE VIEW OF THE STAGE WINDOW

When working with 3D content, images positioned in 3D space, or rotated around their X or Y axes, it
is sometimes hard to see where things are if you only view them from the front. For instance, if you
want to make one image orbit another image along a horizontal plane, the motion path will look like
a straight line when viewed from the front. Choose “Top” under “View” on the Stage menu to view the
stage from the top.

Likewise, for vertical motion, the stage can be viewed from the left. By alternating between these three
views, you can create elaborate three-dimensional motion paths.

HINT: To view stage content from an arbitrary angle, add a “3D Mapping Projector” and select its
View tab. Position the projector as desired in the Stage window, and use it as a camera to visualize
any part of the stage.

PREVIEWING WITHOUT PERSPECTIVE

The Stage window generally shows images in 3D space using the perspective set in Preferences.
Deselect “Perspective” on the Preview menu to view and edit images using an ortographic (non-per-
spective) view.

POPUP MENU
The contents of the right-click menu in the Stage window depend on where you click in the stage areq,
and whether the Stage window is selected or not.

If the Stage window is selected you can right-click on display devices and modify them that way. For
example, you can move them to a different Stage Tier. If you rightclick where there is no display
device, you essentially get the same command options as the Stage menu. If the Stage window is not
selected, menu options are the same as right-clicking in the Timeline window.
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STAGE LIST

The right-most part of the Stage window can be used to show a hierarchical list view, called stage list,
showing all the display devices and which stage tier they are on. This list can be activated from the
Stage menu, or from the right-click menu in the Stage window. The list view can be used, for example,
to drag display devices between different stage tiers. You can also center the stage view on a specific
display device by right-clicking on it and select “Go To".

MAIN TIMELINE WINDOW

The timeline window holds the cues that make up your presentation. Cues are arranged along layers,
representing the back-to-front stacking order of images on stage. Increasing layer numbers move the
image closer to the front.

Main Timeline b 4
Current time position. 0:35.840 [0:320 3 : : ; Jump button.
1 I
Currently selected layer. 7 LAYER 10 Time ruler.

Layer attributes. o O

L .
Collapsed layer. > LAYER 9 ayer.

> LAYER 8

> Position , Tween pane.

Play button. Time scale button.

TIME POSITION INDICATOR

The current time position is indicated by a vertical line through the Timeline window. lts color indicates
the “Click Jumps to Time” mode.

SETTING THE CURRENT TIME POSITION

Click the time ruler to jump to a time position. To set the time numerically, choose “Timeline Settings”
on the Timeline menu. To go to the beginning of a cue, or to a tween point, click it with “Click Jumps to
Time” selected on the Timeline menu.

ADJUSTING THE TIME SCALE

Click the magnifying glass areas of the time scale button to zoom in and out by a fixed amount. Press-
ing the ‘+" and '~ keys on the numeric keypad has the same effect. Drag the center of the button to
change the scale gradually.

THE JUMP BUTTON

Click the jump button, located to the right of the time ruler, to jump to the current time position if
scrolled out of view, or to jump back to the previous start time. Pressing the asterisk key on the numeric
keypad has the same effect.
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STARTING AND STOPPING

Click the play button to start and stop playback. If the stage is online, this also controls playback on
screen. Pressing the spacebar is equivalent to clicking the play button. Pressing O on the numeric key-
pad starts playback, Esc stops playback.

USING THE SCROLL WHEEL

By default, the scroll wheel on the mouse scrolls windows vertically. The scroll wheel can be combined
with the following modifier keys in the timeline window:

e Shift: Scrolls the timeline horizontally.
e Control: Moves the current time position in 0.1 second increments.

e Control+Shift: Moves the current time position in 1 second increments.

ADDING CUES

To add a cue, drag media from your hard disk or the Media window to a timeline or the Stage win-
dow (see “Cues”).

SELECTING THE CURRENT LAYER

Click the name of a layer to make it the currently selected layer. When pasting an individual cue, it
will be pasted at the current time and layer. Likewise, when adding media by dragging into the Stage
window, a new cue will appear at the currently selected time and layer.

CHANGING LAYER HEIGHT
Click the collapse triangle to minimize and restore the layer height. Shift-click to collapse/expand all
layers. An expanded layer shows details about its attributes, as well as tween point indicators along
the bottom of cues on that layer.

ADDING AND REMOVING LAYERS
Layers can be added, removed and renamed using the corresponding commands on the Timeline
menu (see “Adding and Removing Layers”).

DISABLING LAYER PREVIEW

To disable the layer preview in the Stage window, click the eye symbol to turn it off. Shift-click to dis-
able/enable all layers. Disabling a layer allows you to manipulate images in the Stage window that
otherwise would have been covered by other images. Disabling a layer’s preview has no effect on its
playback on screen.

LOCKING A LAYER

To lock a layer, click the padlock symbol. Cues on locked layers can’t be selected or changedm nor
can you add new cues to a locked layer.

LAYER NAME AND ATTRIBUTES
Other layer attributes may also be indicated in the layer header area:

S: the layer applies only in Standby mode.
T: the layer is restricted to certain tiers only.

C: followed by a number: the layer is conditional, with the specified condition (see “Condition”
below).
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HINT: The layer name is shown in italics in the header area when any non-default attribute is applied.
Expand the layer or open its “Layer Settings” to see what's different.

To change the name or other attributes of a layer, first select the layer then choose “Layer Settings” on
the Timeline menu, or simply double<lick the layer name.

.......................

Mame:
Locked: [_]Lock all Cues on this Layer
Preview: [_| Hide Layer in Stage Window
Perform: (@ Normal () In Standby () Both

Condition: | 0 (0 for none)

QK Cancel

Lock all Cues on this Layer
This checkbox is equivalent to the padlock symbol in the layer’s header pane. Selecting it prevents
cues on this layer from being changed or deleted.

Hide Layer in Stage Window

This checkbox is equivalent to the eye symbol in the layer’s header pane (see “Disabling Layer
Preview”).

Perform Normal/In Standby/Both

By selecting “In Standby”, images and other media on this layer will perform only when in “Standby”
mode. This allows you to keep, for example, a background image ready to be displayed at any time,
thereby avoiding going to a black screen when activating the standby mode.

By selecting “Both”, cues on this layer will perform regardless of any Standby mode.

Normally, the Stage window doesn’t preview media controlled from such standby layers. You can
override this using the “Preview Standby Layers” command on the Preview menu.

IMPORTANT: In order to be available to the Standby command at any time, media on standby layers
consume processor and memory resources even while notin standby. Avoid using multiple standby
layers at the same time or playing video or other heavy-duty content on standby layers. Generally, use
only a single, large background image at a time.

Condition

Media associated with cues on a conditional layer will perform only when that condition is enabled in
the Preferences dialog box (see “Enable Layer Conditions”). This can be used, for example, to keep
multiple language versions of a show in the same file, allowing the correct language version to be
activated by enabling its associated condition.

Normally, the Stage window previews media on enabled conditional layers only. You can override
this using commands on the Preview menu.

NOTE: The name of a conditional or standby layer is shown in italics in the Timeline window.
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Stage Tiers

Normally, cues appear on displays on all stage tiers. Select “Restrict Rendering” to restrict images
presented by cues on this layer to a specific stage tier or set of tiers. Select the desired set of tiers in the
list. See”Using Stage Tiers for Complex Display Arrangements” for more details.

NOTE: You must add tiers to the Stage window before you can assign layers to specific tiers (see
“Tier").

Layer >

General Stage Tiers
Restrict Rendering to Stage Tiers

Main

QK Cancel

IMPORTANT: Restrictions applied here are in addition to any restrictions applied to the enclosing
compositions and timeline. A Layer can only apply further restrictions. It can not remove any restric-
tions applied by enclosing compositions/timeline.

POPUP MENU

The right-click popup menu of the timeline window basically contains the same commands as the
Timeline menu. However, if you right-click on a media cue you will also be able access the commands
of the tween menu.

AUXILIARY TIMELINE WINDOW

The window associated with an auxiliary timeline is very similar to the Main Timeline window. To
create an auxiliary timeline, choose “Add Auxiliary Timeline” from the window menu of the Task win-
dow (see “Task Window”). Open its window by double-clicking its name in the Task window.

Timeline 2 e

0:00.000 |

[> LAYER 2

W LAYER1

=l Q
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Name the auxiliary timeline by choosing “Timeline Settings” on the Timeline menu while the auxiliary
timeline’s window is active.

An auxiliary timeline can be stopped - indicated by a red Stop button in its lower left corner as well as
in the Task window. When stopped, it doesn’t contribute to the stage. For more details, see “Auxiliary
Timeline”.

COMPOSITION WINDOW

The window associated with a composition resembles the
.o . ] . o Comp ot

Main Timeline window in the way it is operated. However,

its purpose is quite different. Unlike the main timeline and 0:00.000 |

auxiliary timelines, its output doesn’t appear directly on > LAYER 3

stage. Instead, you use the composition from another time-

line similar to playing a video clip. See Compositions for WV LAYER 2

details.

Create a composition by choosing “Add Composition” on
the Media menu. A new composition item appears in the
Media window. To open the timeline window of a composi-
tion, double-click its name in the Media window. Use the
“Timeline Settings” command on the Timeline menu to
change the name or other properties of a composition (such as its reference frame).

NOTE: When opening a composition, its preview will temporarily replace the normal content of the
Stage window. This doesn’t affect the image shown by any display computers. Close the composition
to restore the Stage window.

MEDIA WINDOW

The Media window lists all media items that have been added to the presentation. It provides a thumb-
nail preview of each item, along with a description of its name, type, location, size and other informo-
tion, as appropriate.

Media e
Mame Thumbnail Type Information Duratio
ArmCycle_ HAP _A.mov e Video 512 x 384

E:at" i T

Ball.png Q Image J00 x 300

> Car Folder 3 items

Background3.jpg : Image 3552 x 1080

DLogo.png "‘D datatOﬂ Image 1844 x 447

EngineComp Compositior 1024 x768  10.0
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® Double-click Name to edit the media specification.
* Double-click a Composition’s name to open its timeline.
 Doublelick a thumbnail to open media file in its associated application.

e Click the triangle next to a folder’s name to reveal its content.

ADDING MEDIA

Add new media by dragging files from your hard disk into the Media window, or by choosing “Add
Media File...” on the Media menu. Files dragged directly into the Timeline or Stage windows are
automatically added to the Media window as well. Each media file used in your presentation will only
appear once in the Media window, regardless of how many times it is used.

REMOVING MEDIA

Remove individual media items by selecting them and choosing “Clear” on the Edit menu. Remove all
unused media items from the Media window by first choosing “Select Unused” on the Media menu. It
is not possible to remove media that's currently in use in the presentation. Removing media list items in
this way does not affect the files stored on your computer.

HINT: Use the Find command in the Timeline window to track down media references by the name of
the media item or any other part of its file path.

LOCATION

Indicates the location of a media file. If the file is located in or under the folder in which the presenta-
tion itself is saved, the path to the file will be relative to this folder. Otherwise, it will be an absolute
path, beginning with a ’/’-character.

IMPORTANT: If possible, store media files in a sub-folder of the folder containing the presentation file,
since this allows the use of relative path names. Doing so allows you to move the entire presentation to
another folder, disk or computer intact. Using absolute path names may cause problems if the speci-
fied location is not available after moving the presentation.

HINT: If you change your mind concerning file locations, you may move the files to a more appropri-
ate location (for example, to a subfolder of the folder containing the show file), and then use the Find/
Replace command to update the locations in the Media window accordingly.

CHANGING THE FILE ASSOCIATION

You can change the file associated with a particular media list item by double-clicking its name and
choosing another file. This will affect all cues associated with this media list item. You can only replace
a media file with another of the same type.

EDITING THE MEDIA FILE
To open a media file in its associated application, double-click its thumbnail. This provides convenient
access to a media file in order to view or edit it.

NOTE: Your computer must have been set up properly in order to associate each file type with the
appropriate application.

HINT: You can open the media file associated with a cue by Alt-double-clicking the cue on its timeline.

WINDOWS 40



REFRESHING MEDIA INFORMATION
After editing media files, update the Media list in WATCHOUT by choosing Refresh on the Media

menu.

GROUPING MEDIA ITEMS INTO FOLDERS

Media items can be arranged into groups. Chose “New Folder” on the Media menu to create a folder
then drag the desired media items onto the folder. Double-click the folder’s name to change it. Click
the triangle to show or hide the content of the folder.

NOTE: Folders in the Media window have no relation to folders on your computer’s hard disk. They
are merely a way to organize items in the Media window. Creating or removing folders from the
Media window will not create or remove any folders on your hard disk.

ADDING A MEDIA PROXY

In some cases, media files can not simply be dragged into the Media list. Instead, you can add a
proxy item to the Media window using the “Add Proxy” command on the Media menu. Examples
where this is the case include:

* Avery large video that has been pre-split into multiple files (see “Pre-splitting a Large Video”).

* You want to incorporate stereoscopic video into your presentation, using separate left-eye/right-eye
video files.

® The media may not yet be available, or may for other reasons need to be provided or replaced
manually on the display computer at a later time.

POPUP MENU

The contents of the right-click menu in the Media window are basically the same as the Media menu.
However, when you right-click on a composition you can also edit the properties of the composition,
by selecting “Composition Settings...”, and duplicate it by selecting “Duplicate Composition”.

INPUT WINDOW

The Input Window lists external inputs available for use in expressions. Expressions are used to con-
trol tween track parameters and to trigger tasks.

Input 4

Name Description Value

C-key MIDI1 Note 65 1.000
Ch1 DMX 1 0.000
ExtCtrl Generic 4.653
MC3 MIDI1 Cont 3 [OL894

® Click the plus-button in the top right corner to add more inputs.
* Drag horizontally in the Value field to simulate a change in value.

For details on the various kinds of inputs see “Inputs”. For more about expressions, see “Expression”.
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OUTPUT WINDOW
The Output Window lists outputs allowing you to control external devices using cues.

Output bt

Name Description

#® Houselights DMX 62
® spot DMX 1 0.690
[l| switch UDP192.168.0.64 On

e Click the plus-button in the top right corner to add more outputs.
* Drag horizontally in the Value field a change the value manually.

To create a cue for an output, drag the output onto a timeline. See “Outputs” for more details.

TASK WINDOW
The Task window lists all the auxiliary timelines of your presentation, along with their status and trig-

gering expression. Tasks (auxiliary timelines) may be organized in task folders.

Task 4

Name Status Trigger

Marguee [> 0:03 CKey

B Andrews P> 0:06
%/ The Joneses
A Jones
Z Jones

P Crenshaw

* Tasks and task folders are added using the menu icon in the top right corner, or by using the right
click menu.

* Double<lick a task’s name to open its timeline.

® Double-<lick a task folder to change its name

* Drag tasks vertically in the list to re-arrange their frontto-back ordering on stage. Tasks may also be
dragged in and out of task folders and re-arranged within the folders. Additionally, you can create

nested folders by placing folders within folders.

e Click the menu icon, or right-click within the Task window, and select “Lock Task List” to lock the task
list. This prevents tasks being re-arranged, deleted or added.
NOTE: Task folders have to be collapsed before further tasks, or folders, can be placed below them.

The status of each task is shown in the Status column. An auxiliary timeline can be in either of three
states, as indicated by the two buttons.

The Status column indicates a timeline’s current run mode, letting you start or stop timelines manually.
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o B A paused timeline.
o B3 A playing timeline.
o BB A stopped timeline. While stopped, its cues have no effect on the stage.

The Expression column shows any expression that can be used to trigger a task. An auxiliary timeline
can be started by either of the following events:

* Manually, for instance by clicking the Play symbol in the Task list.
* By external inputs, using its triggering expression (see “Expression”).

® By another timeline, using a Control cue set to target the auxiliary timeline (see “Control Cue”).

Changing the Stacking Order

An auxiliary timeline always performs in front of the main timeline on stage. When multiple auxiliary
timelines are active at the same time, their frontto-back stacking order is typically controlled by their

order in the Task window. To move an auxiliary timeline closer to the front, drag it towards the top of
the Task window.

NOTE: This behavior can be overridden in the Timeline Settings dialog box of an auxiliary timeline.
Here you can choose that it always starts out as frontmost, regardless of its position in the Task win-
dow (see “Auxiliary Timeline Settings”).

STATUS WINDOW
The status window provides a user-configurable set of status items that can be sized as desired.

Status 4

Main Timeline Position

0 g 0 8 g 5 Timecode Format: | SMPTE drop-frame A

P : Mormal
Playing Color: |Film (24 fps)

OFF LINE ) 2o )
Paused Color: |SMPTE non-dron
Standby Background Color: [gMpTE BRW (30 fps)

(84 Cancel

Timeline Positicn X

Status window, and the settings associated with the Main Timeline Position status item.

* To add more status items, click the plus-button in the top right corner.

* To configure a status item, double-click it in the Status window then change its settings (such as color
and other properties).

* To remove a status item, select it with the mouse then choose “Clear” on the Edit menu.
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HINT: The Main Timeline Position status item allows you to set the format in which the time position is
displayed, including various EBU or SMPTE timecode formats, as shown above.

MESSAGE WINDOW

The Message window lists the messages sent to you by WATCHOUT. Such messages may originate
from the production software or from the display computers. Some messages are merely informative
while others indicate errors requiring your attention.

Messages e

201508-2110:14:15
Error: Unable to open MIDI port

NOTE: The Message window appears automatically when a message is posted. To avoid this, move
the window to the side instead of closing it.

Removing Messages

To remove messages, select them (either by Shift-clicking or by choosing “Select Al
then choose “Clear” on the Edit menu.

|II

on the Edit menu)

NETWORK WINDOW
This window lists all WATCHOUT display computers found on the local network. It's a good place to
start if you're having trouble connecting to display computers. It shows the IP number as well as any

name of each display computer. If you're using Dataton media servers such as WATCHMAX or
WATCHPAYX, its serial number will be shown here too.

Display Computers Found on Local Network b

IP Number Serial Number Computer Name Cluster Name

192.168.10.253 3363-103M1 wP1 WOLab
192.168.10.200 3362-10780 Wwp2 WOLab
192.168.10.238 WOLab

ADDRESSING BY IP NUMBER OR BY NAME

Display computers may be addressed either by name or by IP number (see “Computer”). In most
cases, addressing by name is preferable, since it allows IP numbers to be dynamically assigned,
thereby reducing the need for manual configuration.

NOTE: Normally you should always use name addressing for any Dataton media servers in your
system. It is possible, using a script command, to assign a fixed IP address to Dataton servers, but in
most cases this is not needed.
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To change the name of a display computer, double<lick it in the list and enter the desired name. This
name is stored in the display computer, and can subsequently be used when referring to that
computer.

Display Computer .t

IP Mumber: 192.168.0.217

Computer Mame: [WP1

Cluster Name: M

WATCHPAX Mumber: 3352-11506

(04 Cancel

Assigning computer and cluster names.

If you have multiple display clusters on the same network, you may also want to assign cluster names.
By using cluster names, you may reuse computer names within each cluster. This is advantageous
when managing a network with several identical clusters. A show can then be transferred to each
cluster merely by changing the cluster name in the Preferences dialog box, rather than changing the IP
address in each display used in the show.

Display Computers Found on Local Network X

IP Numbei Serial Number
192.168.10.253 3363-10301
192.168.10.200 3362-10780

192.168.10.238

Computer and cluster name assigned to Dataton media server with serial number

3363-10301.

LICENSE MANAGER WINDOW
This window lists the WATCHOUT software licenses found on your system, indicating the individual
license number and the WATCHOUT versions for which it is valid.
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License Manager 4

License Version Pending Location

2-2T763280 5,6

2-3037275 5,6 192.168.0.43
1-1815447 5,6 192.168.0.42
2-27T18176 5,6 192.168.0.217

Scan License Keys | ¥ Scan Remote Displays Too Copy All as Text |

Four WATCHOUT licenses, all valid for versions 5 and 6. The first one was connected
locally, while the other ones were connected to display computers with IP addresses as
indicated.

By default, only license keys connected to the production computer are shown. To add licenses to this
list, connect them to the production computer, then click “Scan License Keys”. Licenses connected to
any remote display computers, that have one or more displays in the Stage window assigned to them,
may also be included by selecting “Scan Remote Displays Too” before clicking “Scan License Keys”.
This is particularly useful if you're using Dataton media servers (where the license key can not be
removed) or in a fixed installation scenario where computers may be hard to access.

The remote display computers don't have to be online for this to work. They just need to be connected
to the network and have the display software running on them. Licenses seen on your system will
remain in this list until explicitly removed. To remove licenses, select them in the list and choose
“Clear” on the Edit menu, or on the right-click popup menu.

UPGRADING LICENSES
When a new, major version of WATCHOUT is released, licenses must be upgraded in order to be
eligible for use with that version. Upgrading your licenses is a multi-step procedure:

* Make sure all relevant licenses are shown in the License Manager window. If you're unsure, first
select all licenses and remove them by choosing “Clear” on the Edit menu, then re-scan the avail-
able licenses.

e Click “Copy All as Text” to obtain information about all the licenses.
e Send that information in an email, along with your order for the upgrade.

® Once your order has been processed, copy all text in the email containing the upgrade, then paste
it into the License Manager window. New licenses appear in the “Pending” column.

e Click “Scan License Keys” to transfer the pending updates to all matching license keys or Dataton
media servers seen on your system.

e Version 5 to 6 upgrade: https://www.dataton.com/watchout-version-5-to-6-upgrade

Please contact your Dataton reseller for more details on how to upgrade your system.
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4. COMMANDS

This chapter describes the production software menus and their commands, as well as the dialog
boxes that appear as the result of some commands

FILE MENU

The File menu provides commands related to the entire presentation, such as opening old presenta-
tions or creating new ones.

NEW

Creates a new presentation, specifying the name and location of the WATCHOUT show. It is generally
a good idea to create a new folder for each new show. Store all media related to that show in subfold-
ers of this folder. By keeping the show file and any folders containing its media together like this,
WATCHOUT will use relative paths to all media files, making it easier to move the show to another
disk, backing it up, etc.

HINT: To re-use objects such as display or projector arrangements, tasks and cues, simply copy them
from the old presentation then paste them in the new one.

OPEN

Opens an existing WATCHOUT presentation. This command also verifies that all media files required
by the show are still available. Messages appear in the Message window if anything is amiss.

OPEN RECENT

Provides a list of recently opened presentations. Choosing an item from the sub-menu opens the
selected presentation.

SAVE
Saves the presentation that is currently open.

SAVE A COPY AS
Saves a copy of the presentation that is currently open. This is useful for saving backup copies without
changing the name of the current presentation.

NOTE: Opening and using such a copy without changing it back to its original name will cause a new
set of media to be downloaded to all display computers under the new show name.

CONSOLIDATE TO

Moves or copies the entire presentation, including its media files, to a folder. You can use this com-
mand to consolidate all the relevant files into a folder on a removable drive, regardless of where those
files are stored.

is command is also usetul it you've been using media files stored on numerous servers or disks, or i
Th disal ful if you've b g media files stored disk f
you want to weed out unused media files intermixed with files actually used in the presentation.

In addition to collecting your media files, this command updates the access paths accordingly in the
Media window, and stores this updated copy of the presentation file in the consolidated folder. When
using Copy, the old presentation and its media files are not affected.
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When you give this command, first choose an empty folder for your consolidated presentation. You
are then presented with the dialog box shown below and can choose whether to copy or move the
media files.

Consclidate Media Files x

Indude: (®Media Currently Used: () All Media Items

Copy media files. Uses more disk space, but leaves

Copy the original presentation intact.

Move Move media files if possible (if not, copy instead),
The consolidated presentation will then be opened.

Cancel

Include. Choose “Media Currently Used” to weed out unused items from the Media window, exclud-
ing those from the consolidation (the files will stay where they are). Choose “All Media ltems” to
include all media items and files listed in the Media window, regardless of whether they are actively
used or not.

NOTE: Merely using a media item in a Composition does not count as being actively used, unless
said composition is then also used from a timeline. Whenever in doubt, always choose “All Media
ltems” when consolidating a show.

Copy. Creates a new copy of your presentation, leaving the current media files and the presentation
file as they are. This is the safest option, but may require more time and disk space, since it entails
making new copies of the media files.

IMPORTANT: When choosing “Media Currently Used”, any unused media items (including composi-
tions) are removed from the Media window in the consolidated version of the show. Unused media
files are left in their old locations, and are not copied or moved.

Move. Instead of copying them, this moves all actively used media files residing on the same volume
as the target folder. This is much faster and requires no additional disk space for files already located
on the target volume. Media files residing on other disks, partitions or servers will be copied, how-
ever. The consolidated presentation is then opened automatically.

IMPORTANT: Since the Move option moves media files away from the locations specified in the origi-
nal presentation, you will no longer be able to use the old presentation file. A new copy of the presen-
tation file is created in the consolidated folder with the updated media file references.

AUTO SAVE

Activates/deactivates the auto save function. This can also be done in the Preferences dialog.

With this functionality activated, your show is saved automatically with a predetermined time interval.
The interval may also be set in the Preferences dialog. Auto-saved files are stored in a special folder,
with the same name as your show file followed by a “_autosave” suffix.

If you accidently quit WATCHOUT without saving or there is a system failure, there may be a newer
version of the show file stored in the auto save folder. If that is the case, the next time you open that
show file you will be prompted to choose whether you want to load the newer auto-saved file instead.
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EXPORT BUNDLE FOR WATCHNET

Saves the entire show, including all its media and other details, to a “WATCHOUT Bundle” file (with
file extension WOB). This file can subsequently be imported into WATCHNET for deployment onto
clusters managed by a WATCHNET server.

NOTE: A WOB file can not be read back into WATCHOUT. lt's intended for use with WATCHNET

only. If you want to archive a show, use the “Consolidate To” command instead.

EXPORT BUNDLE UPDATE

Creates a bundle update file, containing only the changes made to a show since a specific
“WATCHOUT Bundle” file was exported — referred to as the base bundle for the update. The new
bundle update file, with file extension WOBU, can then be imported to a WATCHNET server that
already has the base-bundle file.

Since the bundle update file contains only the changes relative to its base bundle, it is generally much
smaller, making it faster and easier to deploy to a WATCHNET server. When exporting a bundle
update, you must select an existing WOB file containing an earlier version of the show you're export-
ing. The new bundle update file has the same initial name as the WOB file upon which it is based,
plus a time stamp acting as its version number.

IMPORTANT: A bundle update file can only be used by a WATCHNET server that already has the
bundle file on which it is based. The update file only contains the differences between the old and new
show versions and can not be used on its own.

EXPORT MOVIE
Exports the main timeline of your show as a QuickTime movie. The movie file can then be sent off for
client approval, posted to a web site, or similar.

NOTE: Before choosing this command, set up the Stage window to define the scale and area to be
exported. Only the displays currently visible in the Stage window will be exported. This can be used
to export a smaller portion of a very large stage. Areas outside the displays that are currently visible in
the Stage window will be cropped or blanked out in the resulting file. Also, if your show uses condi-
tional layers, set the desired set of layer conditions in the Preferences box before exporting.

When you choose the “Export Movie” command, a Save dialog will be shown, allowing you to name
the resulting movie file. This dialog box also allows you to limit which part of the timeline to export,
and to control the compression being used. The formats available may vary depending on the version
of Quicktime you have installed.

Navigate to the desired

My

- 1) 3
folder. e
. File name: -
Name of the new movie. S—
Save as type: Ich;k-hrne Movie (*.mov) '] [ Cancel ]
Portion of timeline to save. I
i Start Time: 0.0 End Time: 3:l23.518 Cpmpression Settings...
How to compress the movie.

NOTE: This command requires QuickTime installed on your production computer.

Exporting an Auxiliary timeline
To export an auxiliary timeline, first open and select its window, then choose “Export Movie” on the
File menu.
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EXPORT AUDIO

Exports a stereo mix-down of the audio from the main timeline of your show, as a WAVEHil.

QUIT

Quits WATCHOUT after optionally saving any changes.

PREFERENCES

Allows you to specify miscellaneous settings of the presentation.

Preferences

Display Cluster Name:
Display IP Mumber Prefix:

Display Framerate:

Stand-By Enter Rate:

Stand-By Exit Rate:

Default Image Duration:

Default Audio Volume:

Edge Blend Contraol

Conditions Video In  Audio Qut 3D

60Hz

o

[ ]Custom Framerate: &0

1.0 seconds
1.0 seconds
10.0 seconds
50 Sk

When Adding New Cues: [+] Center Anchor Position

Enable Auto Save: Every | 5 minutes

Media File Refresh: () Automatic (@) Manual

Ok

X

Cue Caolors

Cancel

NOTE: These settings are stored with the presentation, and do not apply to other shows made on the

same production computer.

Display Cluster Name

Specifies the name of the display cluster. This is useful when you have multiple clusters on the same

network, especially when several clusters have the same configuration of displays, and you're using

computer names, rather than IP addresses, to specify display computers.
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NOTE: A “display cluster” refers to a set of displays that work together to present a single show.
Often, you have only a single cluster on your local network, in which case naming is not necessary.
However, in some cases — particularly in fixed installations — you may have several independent dis-

play clusters on the same network, all updated from a single production computer, or using Dataton
WATCHNET.

Display IP Number Prefix

When using fixed IP addresses for display computers, the IP addresses usually only differ in the last
few digits (see illustration under “Network”). By entering the common initial part in this field, you then
only have to enter the last few digits into the specifications dialog box of each individual display.

IMPORTANT: You must enter the period that separates the last two groups of digits here. The complete
IP address is made by simply concatenating the contents of the “Display Address Prefix” field with the
contents of the display’s Computer field.

Display Framerate

Specifies the frame-rate used by the display computers. This setting lets WATCHOUT optimize its
behavior to match the frame-rate of any video being used in the presentation, as well as the display
devices. Your display computers should use a matching refresh rate (see “Display Properties”).

Standby Rates
Specifies the fade out and fade in rates for the standby command (see “Standby”).

Default Image Duration

Display duration used for new image cues added to timelines. You change the duration of cues by
dragging either end of the cue.

Default Audio Volume

Volume level used to play audio not governed by a Volume tween track. Set this to a value below
100% to provide for some additional headroom when controlling the playback volume.

Center Anchor Position

When checked, the anchor point will be aligned with the center of the image as you drag an image to
a timeline or the Stage window (see “Anchor Position”).

Edge Blend

Drag the round dot to adjust the edge blend curve. It is possible to add more points to the curve, but
this is generally not required. The same curve is applied to all edges. The left of the curve corresponds
to the outer (dark) edge of the gradient. Your display computers must be online for you to see the effect
of the edge blend curve while changing it.
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Preferences X

Control Conditions Video In  Audio Qut 3D Cue Colors

General iEdae b

Soft Edge Blend Curve

Mote: Left side of curve is outer part of edge blend

a4 Canicel

IMPORTANT: Before attempting to adjust the edge blend curve, make sure your projectors are set up
properly. If not, it may be impossible to get a proper edge blend.

Double-lick a point to view and edit its value numerically, or to change its type. This also allows you
to copy the edge blend curve from one presentation to another.

HINT: Enlarge the window for better precision in adjusting the curve.

Overriding the Global Edge Blend

As an advanced alternative, you can disable the default edge blending on a per-display basis. This is
done in the Advanced tab of the Display Settings dialog box. You can add individual edge masks
using the Mask tab of the Display Settings dialog box, allowing you to control all aspects individually.
However, in the vast majority of cases this is not required when using reasonably matched and cali-
brated projectors.

Control
This tab provides various options for external control of the WATCHOUT production software.
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Preferences X

Conditions  Video In  Audio Out 3D Cue Colors

General Edge Blend

Metwork
[ 5o Online Automatically After Opening Show
Production Computer Contral: [_|TCP/IP [ JUDP

Timecode
[] control of Main Timeline {LTC EBU/SMFTE)

Input device: |Mone
Format: [Auto Detect
Time Offset: 0.0 +or -
Status: Mo timecode device,
MIDI
Input Device: Mone ~
[ IMIDI Show Control, Device ID: | 0
MSC Cue Lists: | Ianore Command {do nothing)

DM 512 {Art-Net)

Default Universe, In: EI Out:

Dynamic Image Server

Default Address: | |

Realtime Tracking
Multicast Address: [238.210.10.1 | Port: | 24002 |

System Scale {1m in pixels) | 1000

0K Cancel

Control tab.

NOTE: For more control options, see “Inputs”.

Go Online Automatically. When selected, WATCHOUT will automatically attempt to connect to
the display computers when opening this show.

Production Computer Control (TCP and UDP). Activates external control of the WATCHOUT
production software. This allows you to control your WATCHOUT presentation from a touch panel or
other computers and control systems. The control protocol has provisions for positioning, starting and
stopping the presentation, as well as other miscellaneous functions. See Controlling the Production
Software.

NOTE: This control feature is not to be confused with the display cluster control capability, described
under Control Protocol. While they both perform similar functions, one controls the production com-

puter and the other controls the display computers directly, without the need for any production com-
puter being present during playback.

Timecode Control of Main Timeline. Enables synchronization of the main timeline of the produc-
tion software by an external timecode signal. When selected, specify which audio device will be used
for timecode, the format of the expected timecode as well as any offset to be added to the external
timecode to make it match up with the timeline. Use a negative offset if the external timecode specifies
a later time position.

MIDI Show Control. Enables control of WATCHOUT using the MIDI Show Control protocol, avail-
able in many lighting consoles. See the appendix titled MIDI Show Control for details on the various
options.
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DMX-512 Universe. Specifies the Artnet protocol “universe” number to be used to receive and
transmit DMX-512 data. This relates to the DMX-512 Input and Output respectively. See DMX-512
Input for more details on how to use DMX-512.

Default Dynamic Image Server Address. The default server address used by Dynamic Image
media items, if not specified explicitly (see “Add Dynamic Image”).

Realtime Tracking. Specifies settings for a realtime tracking system to be used in conjunction with
WATCHOUT. The tracking system sends it data on a multicast network address that may be specified
together with its corresponding network port. It is also possible to set system-wide scaling for the data
received from the tracking system. Please see the appendix titled “E. TRACKING INPUT” for details on
how to incorporate realtime tracking into your show.

Enabled Layer Conditions. Specifies which layer conditions will be enabled. Each layer in the
Timeline window can be associated with a condition, in which case media on that layer will only
appear when the corresponding condition is enabled (see “Condition”). You can specify any combi-
nation of conditions.

Layer conditions are particularly useful together with external control of display clusters, (see “Control
Protocol”).

NOTE: The Stage window normally previews media from enabled layers only. This behavior is gov-
erned by options on the “Preview” menu.

Video In

Associates video input cards in the production computer with video input device numbers, subse-
quently used in “Live Video” media. This allows you to view live video in the production computer, if
desired. It serves the same purpose in the production computer as the “Video In” menu does in the
display software (see illustration under “Add Live Video”).

NOTE: The “Video In” settings in the Preferences dialog box apply only to the production computer.
Each display computer has its own, independent assignment of video input devices. This allows you to
have different configurations of capture cards in the various computers.

If you don't want to preview live video in the production computer’s Stage window, choose the
“Thumbnail” stage preview mode in the “Live Video” media item. Doing so still allows you to assign
video input device numbers for use in the display computers, while disregarding any setting for the
corresponding video input device number in the production software. In this case, you can ignore the
settings in the “Video In" section of the Preferences dialog box.

Audio Out

Associates audio output channel pairs in the production computer with audio output channel numbers,
subsequently used in the “Output Channel Assignment” tab of a Sound cue (see “Sound Cue Specifi-
cations”). This allows you to play multi-channel audio through the production computer, if desired.

NOTE: The “Audio Out” settings in the Preferences dialog box apply only to the production computer.
Each display computer has its own, independent assignment of audio output channel. This is accessed
through the “Audio Out” menu shown by pressing Cirl-W on a display computer (see “Sound”).

3D Perspective and Stereoscopy
These settings control the perspective of images and 3D objects rotated or moved in 3D space.
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| 3D

30 Perspective
Vanishing Point, X: 1944 ¥: 1389 px. | Center |
Perspective: |_J a0 mm eq.
wide tele
Stereoscopy
Eve Distance: |_J 150 pixels

Vanishing Point. As images move away from the viewer along the Z axis, they Ve

move towards the vanishing point. In general, you want this point to be at the center A

of the stage, which can be accomplished by clicking the Center button. You can also  vanishing point
enter the coordinate of the vanishing point manually. The position of the vanishing symbol.
point is indicated by a symbol in the Stage window, displayed only while editing the

settings in the Preferences dialog box.

Perspective. Images rotated around the X or Y axes appear distorted according to the perspective.
A smaller value results in a more exaggerated perspective. You may think of this value as controlling
the focal length of a lens used to view the images, where a wide angle lens (smaller value) results in a
more pronounced perspective. This value also controls the degree to which images moved along the Z
axis (towards or away from the viewer) change their apparent size.

HINT: Sometimes, the perspective effect can make it harder to edit the position and orientation of
images in the Stage window. If so, turn off the perspective using the Perspective command. That com-
mand affects the preview only — not images displayed on screen.

Eye Distance. When displaying images using stereoscopic projection, this setting controls the
amount of left/right image separation that's applied as a function of the distance from the zero paral-
lax plane (i.e., the screen). Depending on the physical size of the screen used to view the presenta-
tion, you may need to adjust this value. For comfortable viewing, the left/right separation should not
exceed 60 mm on screen (approximately 2.4 inches).

IMPORTANT: This setting has no effect on stereoscopic video being used in your presentation, as the
eye separation has already been baked into the video itself. Attempt to keep the amount of physical
eye separation of stereoscopic video within the same limits as other stereoscopic images, as
mentioned above.

Cue Colors

This tab enables you to select default cue colors for the various types of media cues available in
WATCHOUT. Hover the mouse over one of the labels to display a small informational text about which
cue types are affected by that default cue color.

Click a color indicator next to a label to bring up a color selection dialog in which a new default color
may be selected.
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Preferences X

General Edge Blend Control Conditions Video In - Audio Qut 3D

Default Cue Colors

videos: [ captures: ||}

Image and Still: . Metwork Streams: .
Audio: . Compositions: .

omx: | 3D Models: [

QK Cancel

Cue colors tab

EDIT MENU

The Edit menu contains commands applying to the current window or currently selected objects (for
example, displays, cues or tween points).

UNDO/REDO
Reverts recent changes you've made to the presentation.

CuUT

Transfers selected objects to the clipboard, allowing them to be pasted in elsewhere. Use this, for
example, to move cues to another position along the timeline, or to other presentations.

COPY

Copies selected objects to the clipboard, allowing the copies to be pasted in elsewhere. Use this, for
example, to transfer display configurations or cues between presentations.

NOTE: When transferring cues between presentations in this way, any media associated with these
cues will transfer along with the cues, and will be automatically added to the Media window in the
target presentation.

PASTE
Pastes the most recently cut or copied objects into the current window.
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CLEAR

Removes selected objects without altering the contents of the clipboard.

SELECT ALL
Selects all objects in the current window.

SELECT TO END
Applies to timeline windows. Selects all cues from the current time position and forward.

SPECIFICATIONS

Opens the Specifications dialog box for the selected object. This is equivalent to pressing the Enter key
or double-clicking the object.

Image >
Image File: | Photos/Background3.jpg Browse...
Transparency: | ato Detect o

Optimize For: @ Better Performance
() More Effects and Capabilities

Anples to imsgess up
FOpaeEs Th JES Up

to BH by BK poesls.

(84 Cancel

Example specifications dialog box for a still image.

See “2D Display/Projector”and “Cue Specifications” for more details. For media proxy items, see
“Add Proxy”.

MOVE
Moves the selected objects by a specified number of pixels. Applies to cues and displays. When
applied to cues, it moves the stage positions of media displayed by the cues.

Maove >
¥ Distance: | 1] pixels
¥ Distance: | 0 pixels
7 Distance: | 0 pixels

)4 Cancel

FIND/REPLACE

Finds and optionally replaces specified text. When applied to the Media window, this allows you to
locate media items by specifying the name of the media file, or any part of its path name. The com-
mand operates on the information shown in the “File Location” column of the Media window, indicat-
ing the relative or absolute path to the media file.
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Find/Replace X

Find:

[ |Replace with:

(® One ataTime () All at Once
|:| Case Sensitive

[ ]Find in Current Selection Only

Find Cancel

You can use the Replace function to update the path to media files after they have been moved to
another disk or folder. For instance, if you start out with your media files on a shared server during the
early stage of production, you may later want to move all media files into a sub-folder of the folder
containing the presentation file. After transferring the files, use the Find/Replace command to change
the absolute part of the path name (beginning with a */’ character) to a relative (that is, beginning
with the name of a folder located in the same folder as your presentation).

As an example, assume that the media files were stored in a folder named “WATCHOUT/Produc-
tion1/Media” on a network volume named “E:” during production. You have now copied these files
into a folder named “Media” located in the same folder as the WATCHOUT presentation file. You
would then enter the following values into the Find/Replace dialog box to update all relevant media
paths accordingly.

Find/Replace X
A leading '/’ character indi- Fird:E: /Shows Production/Media
cates an absolute path. : NOTE: N? legding Y/
Check o replace. k| Replace with: | Media character lqdlcates a
| ) [ 0ne ataTme @ Allat Once | folder relative to the folder
Choose “All at Once” to - containing the presenta-
change all matching items, or [[] Case Sensitive tion file.
“One at a Time” to review [ ]Find in Current Selection Only
each change before
proceeding. Find Cancel
FINDING CUES

The Find command can also be used in timeline windows. In this case, it allows you to search for
Control cues by name or media cues by the name of their associated media. The latter is useful in
finding cues using a particular media item. The timeline is first searched in the forward direction from
the current time position. If not found, it is searched backwards.

COMMANDS 58



Find Cues X

Find: | ==

Search: () Control Cues (@) Media Cues
(® One ata Time () All at Once

|:| Case Sensitive

[ ]Find in Current Selection Only

Find Canicel

USING QUICKFIND
The QuickFind feature allows you to jump straight to a Control cue by pressing a single function key

on the keyboard. Simply name the cues F1, F2, F3, etc, and then press the corresponding function
key. (see “Using Find and QuickFind”)

FIND/REPLACE AGAIN
Repeats the most recent Find/Replace command.

SNAP
When this is enabled, objects exert gravity on each other as they are dragged with the mouse, mak-
ing them snap together. This makes it easier to align images, cues and tween points.

* When dragged in the Stage window, images will snap to the edge, center or corner of displays and
other images.

e Cues will snap to adjacent cues when dragged in a timeline window.

e Tween points snap to other tween points within the same cue, as well as to the beginning and end of
the cue.

* Cues and tween points snap to the current time position. For this to work, first turn off “Click Jumps
to Time"” on the Timeline menu.

HINT: When working in a crowded stage window, it may be hard to see what's snapping to what. If
so, zoom in on the area of interest (see “Setting the Stage Scale”) and disable the preview of layers
that get in the way (see “Disabling Layer Preview”).

STAGE MENU
The Stage menu applies specifically to the contents of the Stage window.

ADD 2D DISPLAY/PROJECTOR
Adds a new display of the specified size to the Stage window. After adding a display, open its dialog
box to enter its specifications (see “2D Display/Projector”).

Use this command to add flat panel displays (LCD, LED, etc) as well as projectors for flat surfaces. Also

use it for projection on curved surfaces that can be managed using the geometry correction capabili-
ties of WATCHOUT (see “PREVIEW QUALITY”). For projection mapping or projection onto 3D geome-
try, use “Add 3D Mapping Projector” instead (see below).

IMPORTANT: Displays and projectors can not be added while Online is selected on the Stage menu.

COMMANDS 59



The secondary menu provides some common display sizes as shortcuts. You can, however, enter any
size in the display’s dialog box as long as it is supported by the physical display and the interface
card in the display computer.

NOTE: Displays and projectors are added to the current stage tier (see “Using Stage Tiers for Com-
plex Display Arrangements”). Move between tiers using the Cut and Paste commands.

ADD 3D MAPPING PROJECTOR

Adds a projector that can be freely positioned and rotated in the Stage window. While a 2D Display/
Projector can be positioned and rotated on the X/Y plane, a 3D Projector can be positioned any-
where in 3D space, and can be pointed in any direction. Use this type of display device when project-
ing onto 3D geometry, such as a car or a piece of furniture, represented by a 3D model (see “3D

Models”).

For more details on how to use 3D Projectors, see “3D Mapping Projector”.

ADD VIRTUAL DISPLAY

A virtual display is conceptually similar to regular 2D displays, with one important distinction. Rather
than outputting its pixels to a physical display or projector through a graphics card, those pixels are
made available for use within WATCHOUT itself.

When you add a virtual display, not only do you get a display rectangle in the Stage window, but you
also get a new media item added to the Media window, with the same name as the virtual display.
Use this media item as any other image media source in WATCHOUT. Anything that hits the virtual
display on Stage will appear on this image.

One advantage of virtual displays is that they are not constrained to the dimensions supported by
common displays and graphics cards, allowing you to use any reasonable width or height. This
makes them useful for modeling LED walls, which often use modules of odd pixel dimensions. This
video provides an introduction:

http://www.dataton.com/producing-for-led-walls

Another use for virtual displays is to generate dynamic textures for 3D models. While you can drop a
simple image or video directly onto a 3D object as a texture, this doesn’t give you much control over
that image. If you instead use a Virtual Display to texture the 3D model, you have all the layering,
compositing, tweening and realtime rendering capabilities of WATCHOUT at your disposal. This
video provides an introduction:

http://www.dataton.com/3d-texturing-using-virtual-displays

For more details, see “Virtual Display”.

SCALE
Sets the viewing scale of the Stage window. A larger preview gives you greater precision in position-
ing displays and images using the mouse.

HINT: In addition to these fixed scale factors, you can zoom to any area of interest using the mouse
while holding down the Control key, or choose “Frame Displays” to scale the Stage window to
enclose all displays (see next).

FRAME DISPLAYS

Scales and scrolls the Stage window to enclose all displays and projectors. This command is useful if
you want to get an overview of your entire set of displays/projectors, or if you accidentally scrolled
your displays out of view and can’t seem to find them.
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SCROLL TO ORIGO

Resets the scrolling of the Stage window so that its X/Y zero position is at the top/left of the window. |
may occasionally be useful to place 3D projectors or content at negative stage coordinates. To do so,
you need to scroll the stage window above or to the left of the zero point (origo). You can then use the
“Scroll to Origo” command to reset the stage window's scroll position.

NOTE: The zero point is indicated by gray lines in the Stage window.

VIEW

Rotates the Stage window preview so that you can view 3D models, motion paths and other elements
from the left or top instead of the front. This is useful when positioning content in 3D space, or editing
complex motion paths (see “Rotating the View of the Stage Window”).

TIER
Manages stage tiers, which are useful for building elaborate display arrangements (see “Using Stage
Tiers for Complex Display Arrangements”).

Main
Selects the main stage tier. There’s always at least one stage tier. Any additional stage tiers will be
listed below “Main” on this sub-menu.

NOTE: In order to add or manipulate displays, you must first select their stage tier using this menu.
Inaccessible displays are shown with a dotted outline in the Stage window, and a small text will
appear when you point at such a display, telling you which tier it resides on.

Add

Adds another tier to the stage, and selects it as the current tier. Any displays you add or paste will now
go onto this tier.

Rename
Allows you to change the name of the currently selected stage tier.

ONLINE
Connects the production computer to the display computers. Once connected, the display computers
will follow as you jump around on the timeline and start/stop the presentation.

NOTE: Choosing “Online” also locks all displays in the Stage window. You must deselect “Online” in
order to make any changes in the Stage window.

A stop sign inside a display in the Stage window indicates failed connection to that display computer.
Other errors are reported in the Message window.

During the connection procedure, the production computer will verify that all display computers are
using the same version as the production computer and have the same components installed. If any
display computer is running a WATCHOUT version that differs from that of the production computer
you will be asked whether or not you want to update it.
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Different Watchout versions detected

version installed.

o One or more display computers have another software
Do you want to update them?

NOTE: Installing a different WATCHOUT version on the display computers using the production inter-
face will also install any components that are present on the production machine.

If all display computers and the production computer are running the same version of WATCHOUT but
there are components, e.g. NewTek NDI® HX, that are installed on the production machine and not on
the display computers, then you will be asked if you want to update those as well.

Component update recommended

One or more display computers have outdated components
installed.
Do you want to update them?

IMPORTANT: The recommendation is to always run the same version of WATCHOUT, with the same
installed components, on all display computers as well as on the production computer.

LIVE UPDATE

While selected, display computers are continuously updated with any changes made to the show. This
greatly streamlines the production workflow as positioning of images and other precise adjustments
become fully interactive, giving instant feedback on displays or projection surfaces.

IMPORTANT: In order to allow content to be freely positioned anywhere on stage, all content will be
loaded onto all display computers when Live Update is selected. While this doesn't affect playback
performance, it requires more time fo initially transfer all media assets and will also consume more
space on the display computers.

UPDATE

Updates all connected display computers with any changes you’ve made to the presentation, includ-
ing transferring new or modified media files to the display computers. This command is not needed
while in “Live Update” mode (see above).

STANDBY

Causes all display computers to fade to black, or to the image of any standby layer (see “Perform
Normal/In Standby/Both”) and also fades the audio. This is useful if you want to pause the show in a
smooth way — possibly to jump to another position along the timeline. Give the command again to
restore normal image display. While online in standby mode, an indicator is shown at the top of the
Stage window.

HINT: A standby indicator can also be added to the Status window (see “Status Window”).

The fade-out and fade-in times for the Standby command are set in the Preferences dialog box.
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MANAGE DISPLAY COMPUTER
The commands on this sub-menu allow you to operate the display computers from the production
computer. This is particularly useful if the display computers have no mouse or keyboard connected.

Remote Access

Opens a remote access window onto the desktop of displays selected in the Stage window. For this to
work, WATCHOUT display software has to be running on the display computer. The WATCHOUT
display software will be reduced to its window mode, allowing you to see the desktop of the display
computer. While in this mode, you can interact directly with the display computer, for instance to
delete files or similar housekeeping chores.

NOTE: Take care not to do anything that causes the display software to close, as doing so also termi-
nates the remote access session.

End the remote access session by closing the desktop window of the display computer. WATCHOUT
display software will be restored to its full screen mode by the Online command.

Power Down

Turns off the power of selected or all display computers. This quits WATCHOUT display software,
terminates Windows and turns off the computer. As part of this procedure, the WATCHOUT produc-
tion software also learns the hardware address of the display computers, which can then be used by
the Power Up command.

Power Up

Sends a “Wake on LAN” command via the network to selected or all display computers. If properly
configured, this will power up the computer(s) as if their power switch had just been pressed. Put a
shortcut to the WATCHOUT display software into the Startup folder of the display computer to make it
launch WATCHOUT automatically.

IMPORTANT: There are two prerequisites for this command to work:

® The computer must be configured to “Wake on LAN” (sometimes referred to as “Magic Packet”).
This setting may be found under the “Power Management” tab of the Local Area Network Connec-
tion’s Properties dialog box, or in the computer’s BIOS settings.

® The production computer must at some point have given the Power Down command to that display
computer, thus learning the hardware address of the computer’s network card.

Rebuild Show Cache

Forces the selected display computer(s) to re-build the show cache for the show that is currently active.

Delete Other Shows
Deletes all shows on the selected display computer(s) except for the currently active show.

Download Log Files

Downloads all Log Files from the selected display computer(s). Once selected, you will be prompted
for a destination folder. In the selected destination folder, a directory structure will be created that
contains the downloaded log files for all selected display computer(s). If the display computer(s) in
your show are addressed by IP-address, the subfolders in the directory structure will be named using
IP-addresses, otherwise computer- and cluster names are used.
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Download Dump Files

Downloads all Dump Files from the selected display computer(s). Once selected, you will be prompted
for a destination folder. In the selected destination folder, a directory structure will be created that
contains the downloaded dump files for all selected display computer(s). If the display computer(s) in
your show are addressed by IP-address, the subfolders in the directory structure will be named using
IP-addresses, otherwise computer- and cluster names are used.

PREVIEW MENU

The items on this menu control the preview of cues shown in the Stage window. These commands do
not affect the display computers or what appears on their outputs.

CLICK SELECTS FRONTMOST IMAGE

When this option is selected, clicking an image preview in the Stage window always selects the corre-
sponding cue in the Timeline window. While this is the most natural behavior in many cases, it may
get in your way if you want to move an image that appears partially obscured behind another image.
In this case, uncheck this menu option, select the cue corresponding to the image to be moved, then
drag the image in the Stage window.

PREVIEW QUALITY
Control the overall preview quality of images in the Stage window using the following four
commands.

Best Quality. Renders high quality preview of all cues except those explicitly set to “Preview:
Reduced” (see “Preview”).

Video as Thumbnails. Uses low resolution thumbnails as video preview. This speeds up editing of
presentations that have many large video clips playing at the same time.

Thumbnails. Uses low resolution thumbnails of images and video for the Stage window preview.
While the image quality in this mode is very low, its performance is high — particularly when dealing
with numerous, very large images.

Wireframe. Displays all images as boxes with the name of the media item, rather than showing the
image. This is sometimes useful when trying to position images, or to track down images obscured by
other images.

HINT: As an alternative to selecting global thumbnail preview for images or video, you can set individ-
ual cues to preview as thumbnails by selecting “Reduced” on the “Preview” pop-up menu in each cue.

PERSPECTIVE

In general, you want the Stage preview to match what you see on screen in terms of media placement
and perspective. However, the perspective view can make some editing operations harder. If so, you
can turn off the perspective preview using this command, causing the Stage window preview to
appear in an ortographic mode.

NOTE: The amount of perspective applied to images rotated or positioned in 3D space is controlled
by the Perspective slider in the Preferences dialog box.

PROJECTOR BEAMS
Normally, the beam of a 3D Mapping Projector is shown only when the projector is selected in the
Stage window. Use this command to always display projection beams.
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OFF LINE - Tier Mapping

Projector beams shown in Stage window.

HINT: The color of the beam is set in the projector’s dialog box. When using multiple projectors, set
them to different colors to tell them apart.

MASKED BY DISPLAYS

Masks images to the areas inside the displays. This provides a more accurate representation of what
is actually shown by the display computers. However, it also makes it harder to edit the presentation,
since images positioned outside the displays disappear.

OUTLINE DIMMED IMAGES

When an image is dimmed using an opacity tween track, it may become hard to see and manipulate
in the Stage window. Selecting this option causes a thin frame to be displayed around such images,
making them easier fo see.

PREVIEW STANDBY LAYERS

When activated, the Stage window will show the same images as the display computers while in
standby mode (that is, any images from standby layers — see “Perform Normal/In Standby/Both”).
This allows you to edit such images through the Stage window.

However, in most cases, you probably prefer to see the normal images in the Stage window even
while in standby mode, in order to preview and possibly edit those while the display computers show
the standby images. This can be accomplished by un-checking the “Preview Standby Layers” menu
item.

PLAY AUDIO MEDIA
By default, the production computer plays all audio cues. You can turn off this behavior using this
menu option, thereby reducing the processing overhead associated with audio playback.

NO / ALL / ENABLED CONDITIONAL LAYERS

These three menu items control the extent to which images originating from conditional layers appear
in the Stage window. (See “Condition”and “Enabled Layer Conditions” for more on conditional
layers).

ENABLE LAYER CONDITIONS

Specifices which layer conditions will be enabled. Each layer in the Timeline window can be associ-
ated with a condition, in which case media on that layer will only appear when the corresponding
condition is enabled. You can specify any combination of conditions.
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Generally, you want images originating from enabled layers only to appear in the Stage window,
which is accomplished by choosing “Enabled Conditional Layers”. To preview images from all condi-
tional layers, regardless of whether or not they are enabled in the Preferences dialog box, select “All
Conditional Layers”.

ALL / ACTIVE / SPECIFIC STAGE TIERS

Just as timeline layers can use conditions to enable/disable their cues (as described in the previous
paragraph), timelines and their layers can also be associated with stage tiers. Cues on such timelines
or layers will only appear on displays on those specific tiers. The commands in this group of the Pre-
view menu control what's shown in the Stage window in this case. By selecting “All Stage Tiers”, the
Stage window will preview cues regardless of their stage tier association. Select “Active Stage Tier” to
preview cues on layers associated with the tier specified on the Stage Tier sub-menu. Selecting “Spe-
cific Tiers” brings up a dialog box where you choose any combination of stage tiers to preview.

NOTE: Cues on timelines and layers not restricted to specific tiers will always be included in the pre-
view, regardless of the preview mode chosen using these menu options.

BACKGROUND COLOR

Sets the background color of the Stage window. If your source material is hard to see on the default
(black) background, then change to another color.

MEDIA MENU
The Media menu applies specifically to the contents of the Media window.

ADD MEDIA FILE
Opens a dialog box where you can choose files to be added to the Media window. Alternatively,
simply drag the file into the Media, Stage or Timeline window.

ADD SOLID
Creates a solid, white rectangle of specified size (see “Solid”).

HINT: While the basic color of a Solid is always white, you can use a Color tween track to colorize it
(see “Color”).

ADD TEXT

Adds a generated image for displaying text. Use this as an alternative to creating text using Photo-
shop or other applications. Text images created using this method can be edited directly inside
WATCHOUT, thereby speeding up the production workflow. See “Text” for more details.

ADD PROXY
Adds a proxy media item of the kind specified. Use a proxy to handle media that can not be added
simply by dragging into the Media window, as in the following cases:

* The media file isn't recognized by the production computer in the manner you want, for instance, a
sequence of still images that you would like to treat as if it were a video file.

* The media file is a large movie or still image that has been pre-split into multiple files (see “Pre-split-
ting a Large Video”).

* You want to incorporate stereoscopic video into your presentation, using separate left-eye/right-eye
video files.
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® The media may not yet be available, or may - for other reasons — need to be provided or replaced
manually on the display computer at a later time.

Use a media proxy to accommodate any of these cases. Once a media proxy has been added to the

media list, it can be used on the timeline just like other media items.

Video Proxy et
Image Sequence: [ | Play from a Sequence of Still Image Files
Pre-split: [_] Pre-split Files for Multiple Displays
Stereoscopic: [ | Use Separate "Left™ and "Right” Files
File/Falder: Browse...
File Transfer: () Manual (® Automatic [ ] Auto-Refresh on Update
Duration: Frame Rate: frames/sec,
|:| Preview: Choose...
Thumbnail; Choose...
Dimensions; Width: | 00 Height: | 600
Transparency: Auto Detect ~
Enable WATCHPAY Hardware Acceleration
Apply Frame Elending
oK Cancel

Available options vary based on the kind of proxy added.
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Image Sequence
This option applies to video proxy only. Select this option to treat a folder of numbered still images as
a video.

IMPORTANT: In order to play image sequences, a very fast, solid state (e.g. SSD), storage subsystem
is required.

After selecting this option, click the Browse button and choose the folder containing the image
sequence. The names of the files inside the folder have the following restrictions.

e The files must be of type TIFF, PNG, JPEG, TGA or DDS, with uncompressed TGA being the recom-
mended format for best performance. For DDS images, the only texture format supported are DXT1,
DXT5 and RGBA.

e All files must have the same extension.

e Files must be numbered consecutively.

® The number of digits in the name must be the same for all files.

* The sequence can start at any number, but would typically start at 1.

® The files names must all begin with the same initial string of characters.

* The sequence number must come immediately before the period, followed by the file extension.
Here are some valid examples:

* Img0001 tiff, Ing0002.tiff, IngO003.tiff

e Spring2015_00001..tif, Spring2015_00002.tif, Spring2015_00003.tif

You can also use image sequences for stereoscopic video and video pre-split for designated displays.
In those cases, there are strict naming requirements. For stereoscopic image sequences, create a

folder with the desired media name (“The Finals” in the example below). Inside this folder, create two
subfolders named Left and Right. Those subfolders must contain the image sequence files for the corre-

sponding eye.
‘ The Finals

.
scecee ececececccccocccococococoe
. .

‘ Left ‘ Right

Img0001..tif ImgO001..tif
Img0002.tif Img0002.tif
Img0003.tif Img0003.tif

For stereoscopic image sequences, use the same naming convention for all files in both
the Left and Right folders.
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NOTE: The identical file-naming convention outlined above applies to all files in both folders. Thus, if
the files in the “Left” folder are named Left000 1 1iff, Left0002 tiff and the files in the right folder are
named RightO001 tiff, Right0002.iff, the image sequence will not play since the initial string of char-
acters are different.

For image sequences that are pre-split for designated displays, create a folder with the desired media
name (“The Finals” in the example below). Inside this folder, create a folder for each display on which
the video will appear, using the display’s name as the folder name. As with stereoscopic image
sequences, all files in all folders must use the same naming convention.

The Finals

Display 1 Display 2

Img000 1 .tif

Img000 1.tif

Img0002.tif Img0002.tif
Img0003.tif Img0003.tif

Image sequences pre-split for multiple displays.

If you want to combine both stereoscopic and pre-split image sequences, create a folder with the
desired media name. Inside this folder create two folders for each display, named Display 1-Left and
Display 1-Right (replacing “Display1” with the actual name of your displays). All files in all folders

must use the same naming convention.
‘ The Finals
Display 1- Display 2-
Right Left

Img0001..tif Img0001..tif
Img0002.tif Img0002.tif Img0002.tif Img0002.tif
Img0003.tif Img0003.tif Img0003.tif Img0003.tif

Display 2-
Right

Img0001..tif

Display 1-
Left

Img0001..tif

Image sequences pre-split for multiple displays.
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Pre-split

This option applies to video and image proxies. Check this if you have pre-split a still image or large
movie (see “Pre-splitting a Large Video”). In this case, the resulting files must be placed in a folder
specified in the File/Folder field. This folder must contain one file per display intersecting the movie,
each file named after its target display.

For example, assume you have a large video called “LargeMovie.mpg” that intersects two displays
named “Display 1” and “Display 2”. You would then pre-split the video into two files. Name those files
“Display 1.mpg” and “Display 2.mpg” and put them in a folder named “LargeMovie”. Finally, specify
that folder in the File/Folder field of the video proxy. The same process would apply if you had a large
image.

IMPORTANT: Always append the proper file extension to the name of either the video files or the
folder containing the pre-split files. This ensures that the correct video playback mechanism is used. By
default, Windows may not display filename extensions. To show file extensions, choose “Folder
Options” on the Tools menu in Windows Explorer, click the View tab, and uncheck “Hide extensions
for known file types”.

Stereoscopic

Select this option to play stereoscopic video. In this case, you must supply separate files correspond-
ing fo the left and right eye’s viewpoint. Those files must be placed in a folder selected using the
Browse button. Name the files Left and Right respectively, appending the proper file type extension.

NOTE: WATCHOUT does not support active stereo (frame-sequential) but only left and right stereo-
scopic video.

You can combine Pre-split and Stereoscopic videos by naming each video according to the display as
well as its eye affinity, separated by a dash. For instance, to present a stereoscopic pre-split across
two edge-blended projection screen areas, name the files as follows:

Display 1-Left.mpg Display 2-Left.mpg
Display 1-Right.mpg  Display 2-Right.mpg

File/Folder

The title of this field reads “Folder” if “Image Sequence”, “Pre-split” or “Stereoscopic” is selected,
otherwise it reads “File”. In this field you specify the file or folder associated with the media item. Use
the “Choose” button next to the field to choose an existing file/folder. If you set “File Transfer” to
“Manual”, you should type the fictive, relative path to a file that may not exist on the production com-
puter, but will be provided manually to the display computer.

File Transfer

Specifies whether the file will be transferred manually or automatically from the production computer
to the display computers. Normally, you would choose “Automatic”. You may choose “Manual” if the
file is to be provided later, directly to the display computer, or if the file is not yet available.

NOTE: If you choose “Automatic”, WATCHOUT will make sure that the file/folder you specified actu-
ally exists prior to closing the dialog box. If you choose “Manual”, it becomes your responsibility to

provide the file, and WATCHOUT will not verify its existence.

Auto-Refresh on Update

If selected, an updated media file associated with this proxy will be transferred to the display comput-
ers whenever you use the Stage Update command, without first having to use the Media Refresh
command.
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IMPORTANT: When using this feature, media files must maintain their original size. If required, you
can plan ahead by making the original larger than necessary to accommodate future changes.

Duration

Enter the duration of the media here. Applies to moving images (video, image sequences) and sound
only.

Frame Rate

Enter the desired playback rate here. Applies only when “Image Sequence” is selected. Otherwise the
frame-rate is specified by the video file itself.

HINT: You can modify the default playback rate of video in the cue playing the video (see “Playback
Speed”).

Preview

Allows you to choose a scaled down version of a video for preview purposes. This is useful in cases
where the full video is too heavy to play in the production computer. This may be due to the production
computer being less powerful than the display computers, or when playing multiple video files simulta-
neously across many display computers.

Thumbnail

Allows you to choose a thumbnail image to represent the proxy in the Media window, inside cues and
in the Stage window preview. If not specified, a default icon will be displayed.

Dimension
Specifies the size of the image. Applies to still and moving images.

Transparency

Allows you to specify whether the image contains transparent areas, as well as the form of transpar-
ency used. Normally, WATCHOUT determines this from the information in the media file, but when
using a proxy, you must specify this manually. Setting this incorrectly may cause the image to display
without transparency or not at all. Applies to still and moving images.

The types of transparency supported by WATCHOUT include:
* None. The image or video has no alpha channel.
e Straight Alpha. The transparency information affects the alpha channel of the image only.

e Pre-multiplied with White. The transparency affects both the alpha channel and the pixels in
the image so that the pixels in fully transparent areas are white. This is often used in material pro-
duced for printing purposes.

e Pre-multiplied with Black. The transparency affects both the alpha channel and the pixels in
the image so that the pixels in fully transparent areas are black. This is often used in material pro-
duced for video compositing purposes.

Enable WATCHPAX Hardware Acceleration

Applies only when playing certain video formats, such as H.264, on WATCHPAX. May improve video
playback performance when playing high resolution video. This checkbox has no effect when using
other display computers.
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Apply Frame Blending

This setting often results in smoother video playback, at the possible expense of some loss in image
sharpness. This is especially true when the frame-rate of the video is not an even multiple of the display
computer’s frame-rate (for instance, when playing 25 fps video on a display computer set to 60 fps).
This is accomplished by blending adjacent frames together, weighted by their temporal position in the
sequence.

ADD COMPOSITION

Add a Composition to the Media window. A composition allows you to group images together
(including their tween tracks) in a way that can subsequently be used as a media item on other time-
lines. Here are a few videos that show how to use compositions:

Compositions: https://vimeo.com/134594131

Composition example: https://vimeo.com/ 134594382

Scale, move and rotate compositions: https://vimeo.com/134594385
Nesting compositions: https://vimeo.com/134594388

See “Restrict Rendering to Stage Tiers” for a description of the fields in the dialog box shown by this
command.

ADD COMPUTER SCREEN

This feature allows you to incorporate a live image of a computer screen into WATCHOUT. This can
be used to show Excel graphics, Powerpoint slides, a web browser, or similar software applications,
as part of your presentation.

Computer Screen >
Mame: |
Address;
Screen: | 0 (0 is default)
Password:

Stage Preview: () Live (@) Thumbnail
Dimensions
Width: | 1024 Height: | 760

(8] 4 Cancel

The image displayed on the screen of the source computer is sent continuously via the network to the
WATCHOUT display computers, where WATCHOUT composites it with other media. For example,
you can put a plain Powerpoint presentation on top of a large, high-resolution background, thereby
enhancing it with all the high-quality presentation capabilities of WATCHOUT.

To incorporate a computer screen into your presentation, follow these steps:

e |nstall, activate and configure VNC server software on the remote computer (see “VNC Server
Software”).

* Add a Computer Screen media item to the Media list using this command on the Media menu.
Configure it as described below.
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 Drag the computer screen object from the Media list onto the Stage, and program it using cues as
any other image element.

The same capabilities apply to computer screen images as any other images. For instance, you can
program its position, scale and opacity. Since the images are sent across the network to all display
computers, you can show the computer display across multiple display computers.

Computer Screen Settings

In the Computer Screen dialog box, type the IP number of the remote computer into the Address field,
and the VNC password into the Password field. Set Dimensions to the size of the display of the VNC
server (reducing the resolution may improve performance).

The Screen field is rarely used, and should generally be set to zero. It may be used with some imple-
mentations of VNC server software which support multiple screens or work-spaces.

Set “Stage Preview” to “Live” if you want to preview the Computer Screen in the Stage window of the
production software. Otherwise, set this to “Thumbnail”. This setting affects the Stage window pre-
view only — not what's shown by the display computers.

NOTE: The computer that's being viewed does not require a WATCHOUT license key.
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ADD LIVE VIDEO

This feature allows you to display live video, such as a camera feed, as part of your WATCHOUT
presentation. The live video feed must be connected to each display computer that is expected to
show it. For instance, if you want to show live video across two displays, the video signal must be fed
to both display computers (typically using a video distribution amplifier). See “Live Video Input” for
more details.

To activate the Live Video feature, follow these steps:
e Start WATCHOUT display software on the display computer.
® Press Cirl-W to switch to window mode.

® On the “Video In” menu, make sure that your video input device is associated with the relevant
device number.

e Connect a video source to the video input.

Dataton WATCHPOINT

File | Video In | Audio Qut MIDI In  Timecode 501 Help
Device 1 Mone

Lol SDI 1 (12G)

SDI 2 (3G)
SDI 3 (3G)
SDI 4 (3G)
SDI 5 (12G)
SDI 6 (3G)
SDI 7 (3G)
SDI 8 (3G)
HDMI

Device 3
Device 4
Device 5
Device &
Device 7
Device 8
Device @
Device 10
Device 11
Device 12
Device 13
Device 14
Device 15
Device 16
Device 17

Device 18

~D dataton

WATCHOUT

The “Video In” menu shown by pressing Ctrl-W on a display computer.

Device 19

Device 20

L L . L . . A . L

To use Live Video in your presentation, do as follows:

e Add a Live Video media item to the Media list using the command on the Media menu, configuring
it as described below.

* Drag the Live Video object from the Media list onto the Stage or a timeline, just like any other media
object.
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Live Video supports the same capabilities as video played from disk, allowing you to program its
position, scale, rotation and opacity.

To show live video across multiple displays, you must connect the video signal to each of those display
computers. Furthermore, this video signal must be associated with the same input number on each
display computer that is to display it.

Live Video Settings
In the Basic settings tab of the Live Video dialog box, set “Input Device” to the device number selected
on the “Video In” menu and select a video standard appropriate for your video signal.

Basic  Advanced
Name:
Input Device: .1
Deinterlacing: | None W
Stage Preview: ) Live Video  (® Thumbna
[] Apply Frame Blending
[[] Compatibiity Mode
Digital Video Standard v

Video Timing: | 480i v | @ 25Hz W’

Deinterlacing. Video originating from some video cameras uses an interlaced signal, just like a PAL
or NTSC TV set. Presenting such a video signal on a non-interlaced display device, such as a video
projector or other display device designed to be used with computers, results in visual artifacts often
referred to as “combing” around the edges of moving objects. Use the Deinterlacing pop-up menu, set
to “Good Quality” or “Best Quality” to rectify this problem when required.

IMPORTANT: Do not use this feature unless necessary. Some video material and some cameras that
can be set to a “progressive scan” mode do not need deinterlacing, and using it may reduce the
image quality.

Stage Preview. Set to “Live” if you want to preview the Live Video in the Stage window of the pro-
duction computer. Otherwise, set this to “Thumbnail”. This setting affects the Stage window preview
only — not what's shown by the display computers.

NOTE: In order to preview Live Video in the Stage window of the production computer, this computer
must have the appropriate video capture capabilities, and the video signal to preview. Set the input
associations for the production computer in Preferences (see “Video In”).

Apply Frame Blending. This setting may result in smoother video playback, at the possible
expense of some loss in image sharpness. This is especially true when the frame-rate of the captured
video is not an even multiple of the display computer’s frame-rate (for instance, when capturing 25 fps
video on a display computer set to 60 fps). This is accomplished by blending adjacent frames
together, weighted by their temporal position in the sequence.
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NOTE: Frame blending, when applied to live video capture, increases the latency of the displayed
video by about half a frame.

Compatibility Mode. Some video input interfaces have had problems with dropped frames.
Selecting the compatibility mode may improve the performance on these input interfaces.

In the Advanced tab, select a “Signal Input” that is appropriate for your input signal source. If your
input interface has multiple inputs for the same kind of signal, enter the desired input number in the
field to the right of the “Signal Input” pop-up menu under the Advanced settings tab.

Live Video X
Basc [Advancad
Signal Input: | Default v 1|1

Trim Edges (pixels):
0

0 - - 0
0

Dimensions (after trimming):
Width: 720 Height: 480

=

Trim Edges. The fringes of a video signal sometimes contain noise. These four fields allow you to
selectively trim each of the edges of the video image to remove such noise.

Dimensions. With most video standards, the dimensions are fixed. However, when selecting
“Other” on the “Video Standard” pop-up menu, you can manually enter the desired dimensions. Use
this, for example, to enter the size of a computer signal brought infto WATCHOUT using a DVI or Dis-
playPort capture card.

NOTE: The dimensions shown are after any edge trimming. For example, if the original image is 640
by 480 and you trim 10 pixels at each edge, the resulting dimensions become 620 by 460.

Using Multiple Video Inputs

WATCHOUT supports up to twenty video input devices. The number of video inputs that can be dis-
played simultaneously depends on your computer hardware, type of video input device, efc.

Most video input devices have multiple connectors — sometimes for different kinds of video signals (for
example, DVI and SDI). You specify which one to use in the Live Video media dialog box. Add more
Live Video media objects to access different inputs on the same device.

NOTE: With some capture solutions, you can only display one input at a time. In this case, it's gener-
ally not possible to make a clean switch back-to-back from one input to another on the same input
device. You need to leave a couple of seconds between the end of the cue displaying one input and
the beginning of the cue displaying the other.
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ADD DYNAMIC IMAGE
Adds a media item for viewing images originating from a “WATCHOUT Dynamic Image Server” (see
“Dynamic Images”).

Dynamic Image 4

Mame: |

Server Address:

Leave Server Address empty to uss
default address from Preferences

Type: |Image e
Stage Preview: (@ Live () Thumbnail
Dimensions
Width: | 640 Height: | 480

Path:

Parameters:

(04 Cancel

Name. The name used to refer to the media item.

Server Address. The IP number of the computer running the dynamic image server application. If
left blank, WATCHOUT will use the address specified in the Preferences dialog box.

Type. Specify whether the source is a still image, a Flash animation or an HTML web page.

Stage Preview. Controls whether the production software’s Stage window will display the live
dynamic image or a static place-holder.

Width/Height. The dimensions of the dynamic image. Generally, this should match the actual
source image file. When rendering HTML, specify the size to be rendered beginning from the top of
the web page.

Path. The path to the content to be rendered. This can take either of two forms:

A local path on the dynamic image server itself, as a relative path (that is, one that doesn’t begin with
a protocol specifier or a slash).

A fully qualified URL for an external web resource, accessible to the dynamic image server.

For example, if a file named “CNN_News.swf” is in a folder named DynImg, located in the
WATCHOUT installation folder, set the path to:

DynImg/CNN News.swf

HINT: Use the -f command line parameter of the dynamic image server to specify an alternate location
of any locally served content (see “Alternate File Location”).

To access a web page over the Internet, set the path like this:

http://www.bbc.com/weather/3448439
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HINT: To display only a portion of a web page, such as a weather map on a weather site, use a Crop
tween track to crop out the relevant part of the image.

Parameters. Additional parameters passed to the dynamic image being served (see “Dynamic
Image Parameters”).

NEW FOLDER

Adds a new folder to the Media window, allowing you to group related media items. Such a group of
media in the Media window is independent of the folders on your hard disk, and serves merely as a
means fo organize items in the Media window.

LARGE THUMBNAILS
Displays larger thumbnail images in the Media window. This gives a better preview of each image,
but reduces the number of items visible in the list.

NOTE: The size of wide thumbnails in the Media window is also affected by the width of the Thumb-
nail column. Make this column wider to see wide thumbnails.

REFRESH

Refreshes items in the Media list by reloading their information from the associated media files. A
dialog is displayed allowing you to refresh media that has been changed, or all media, regardless of
the file's last modified time-stamp.

REFRESH AUTOMATICALLY

Activates a mechanism that recognizes when media files have been changed and automatically
refreshes them. Example: You added an image file to your WATCHOUT show, but subsequently edited
it in image editing software. When the image file is saved to disk, WATCHOUT detects that it has
been changed/saved and will immediately add the updated image into your show.

This works well with simple media files such as images and 3D models. However, it does not work
with streaming media such as video and audio.

SELECT UNUSED
Selects all unused items in the Media window. After reviewing the selection, you can choose Clear on
the Edit menu to remove the unused media items.

IMPORTANT: Only media items directly or indirectly associated with cues on the Main Timeline, or
any auxiliary timeline, are considered as being used. Specifically, media items used in compositions
are only considered used when the composition itself is being used. Hence, you can prevent a compo-
sition and its media from being considered unused by adding it to an auxiliary timeline.

TIMELINE MENU

The Timeline menu applies specifically to the contents of timeline windows. It is only available when a
timeline window is selected.

CLICK JUMPS TO TIME
Deselect this option to keep the time position stationary while manipulating cues and tween points.
The state of this mode is reflected by the color of the current time indicator.

HINT: Turn off this option to use the current time indicator as a ruler for aligning cues and tween
points. See “Snap” for more details.
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ADD PLAY / PAUSE CONTROL CUE
Adds a Control cue at the current time and selected layer. When reached during playback, the cue
will perform its programmed action (see “Control Cue”).

HINT: When using Control cues, dedicate a layer rather than mixing them with other cues. This makes
them easier to find and prevents them from getting obscured by other cues.

ADDING AND REMOVING LAYERS

Choose “Append Layer” to append a layer to the timeline, or choose “Insert Layer” to insert a layer in
front of the current layer. Choose “Delete Layer” to delete the current layer. A layer containing cues
can not be deleted.

LAYER SETTINGS

Opens a dialog box that allows you to rename the layer as well as set various layer attributes (see
“Layer Name and Atiributes”).

INSERT/DELETE TIME

Open up a gap in time along a timeline, or to remove unwanted time, as specified by the “Insert/
Delete” option.

Insert/Delete Time X

Perform: (@) Insertion () Deletion
Time:

Active Cues: Adjust Duration
Tween Points: Adjust Positions

(04 Cancel

Time
The amount of time to insert or delete. When deleting, the specified amount will be deleted starting
from the current timeline position and forward.

CAUTION: When deleting time, any cues or tween points falling within the deleted time range will be
shortened or deleted.

Active Cues

If “Adjust Durations” is selected, the duration of cues within the range of insertion or deletion will be
adjusted accordingly. Deselect to only move the starting point of cues starting later along the timeline.

Tween Points

If “Adjust Positions” is selected, then also move or delete tween points ahead in time within active
cues. Deselect to leave tween points where they are.

TIMELINE SETTINGS

Choosing this command while the Main Timeline Window is active will display the settings associated
with the main timeline.
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Time Pasition: :E

Duration: [10:00.0

(04 Cancel

Duration. Determines the length of the timeline, and must always encompass all cues on the timeline.
It is extended automatically as more cues are appended.

HINT: Typing a value into the “Time Position” field jumps to that time. This is often more accurate than
trying to click a specific time in the time ruler.

AUXILIARY TIMELINE SETTINGS
Choose the “Timeline Settings” command to displays the settings for an active auxiliary timeline
window.

Auxiliary Timeline -

General Stage Tiers
Name: |IE00]

Time Pasition: |0.0

Duration: (10:00.0

Stacking Order: | Task List Order L

a4 Cancel

Name. The name of the auxiliary timeline (shown in the Task window).
Time Position. Enter a new value here to jump to specified time position.

Duration. Determines the length of the timeline, and must always encompass all cues on the timeline.
It is extended automatically as more cues are appended.

Stacking Order; Task List Order

This is the default stacking order. In this mode, multiple active auxiliary timelines render their images
in the order in which they are listed in the Task window. You can change this order by dragging tasks
up or down in the Task window, thereby affecting how multiple, active and overlapping auxiliary
timelines interact on screen.

Stacking Order; Always on Top

In this mode, the auxiliary timeline will render its images on top of all other auxiliary timelines set to
“Task List Order” or “Always on Top” when activated. This is useful, for example, when you have a
group of mutually exclusive timelines, where each new timeline started should supersede the previous
one.

HINT: You can then use a Control cue to stop the previous auxiliary timeline in the group (see “Control

Cue”).
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Stacking Order; Above Edge Blend

In this mode, the auxiliary timeline will render its images on top of all other timelines when activated.
Furthermore, no edge blend will be applied to its images. This is useful in two specific cases:

* When displaying line-up images. During line-up you want to see the full image all the way out to the
edge to make sure that the image fits precisely onto the display chip in the projector.

* When showing a live video image on a display partially intersecting other displays that are lacking
capture cards for this live video input. Putting this live video image on an auxiliary timeline set to
render above the edge blend avoids the feathered edge that would otherwise be applied to the
infersecting areas.

RESTRICT RENDERING TO STAGE TIERS

If selected, the timeline will be restricted to rendering onto selected stage tiers (see “Using Stage Tiers
for Complex Display Arrangements”). This is similar to the corresponding setting for a timeline layer
(see “Stage Tiers"), but affects the entire timeline.

IMPORTANT: Tier restrictions are cumulative in that a composition or timeline layer can only restrict
rendering further. It can not remove any restrictions applied at a higher level.

COMPOSITION SETTINGS

To displays its settings, choose “Timeline Settings” while a composition’s timeline window is active.

Composition 4

General  Stage Tiers

Mame: |

Time Position; |0.0

Duration: (10,0

[ ]Lodk Duration
Reference Frame:
Left: | 128 Top: | 70
Width: | 5403 Height: | 1084
(04 Cancel

Name. The name of the composition (shown in the Media window).
Time Position. Enter a new value here to jump to specified time position.

Duration. Determines the length of the composition timeline. Set this to exactly match the active part
of the timeline if you want to loop the composition, since the end of the composition determines the
looping point (see “Looping”).

Lock Duration

When selected, the composition’s duration will not be automatically extended. This option is useful for
compositions designed to be looped. Often such a loop is designed with a particular cycle time in
mind, set as the duration of the composition. In this case, check this option to avoid having the dura-
tion extended accidentally as cues are added or edited.
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Reference Frame

By default, the reference frame is set to enclose all displays on the current stage tier when the composi-
tion is created. You can set the reference frame to any size you want, but it is generally a good idea to
make it about the same size as its content. This frame is displayed as a gray rectangle in the Stage
window while the composition’s timeline window is active. Furthermore, it is used to select and manip-
ulate the composition as a whole when used as a media item on other timelines.

NOTE: The reference frame doesn’t constrain or clip the content of the composition. Images may
extend outside the reference frame if desired.

Restrict Rendering to Stage Tiers

If selected, the timeline will be restricted to rendering onto selected stage tiers (see “Using Stage Tiers
for Complex Display Arrangements”). This is similar to the corresponding setting for a timeline layer
(see “Stage Tiers"), but affects the entire timeline.

IMPORTANT: Tier restrictions are cumulative in that a composition or timeline layer can only restrict
rendering further. It can not remove any restrictions applied at a higher level.

TWEEN MENU

The Tween menu is available when a media cue is selected. It allows you to add tween tracks to the
cue. Likewise, tween tracks can be removed by unchecking the corresponding item on the Tween
menu.

NOTE: The items available on the Tween menu vary depending on the selected media cue. For
instance, Volume tweening is only available for sounds and videos — not for still images.

Read more about the various kinds of tween tracks under “Tween Tracks”.

WINDOW MENU

This menu provides access to all standard windows, such as Stage, Media, Main Timeline, etc. Other
windows, such as Composition and Auxiliary Timeline windows are appended to this menu while

open, providing a quick way to switch among them. For more details on the various windows, please
see “3. Windows".

NOTE: To open an Auxiliary Timeline or Composition window, double-click the corresponding entry
in the Task and Media windows. A Composition window can also be opened by Alt-double-clicking a
cue for that composition.

HELP MENU

This menu provides quick access to the WATCHOUT User’s Guide and the release notes with the latest
news on the current version.
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5. DISPLAYS AND PROJECTORS

The term “display” is used throughout this manual to refer to any kind of image display device, such
as projectors, monitors, LED walls, video wall cubes, etc. In WATCHOUT, displays are represented by
objects added to the Stage window. In order to add or manipulate such objects, first select the Stage
window by clicking its title bar.

DISPLAY TYPES
There are three different types of displays in WATCHOUT:

2D Display/Projector. Use this type to represent all flat display devices, as well as projectors when
projecting onto a flat screen or a curved screen that can be managed by the Geometry Correction
feature of WATCHOUT. When used with overlapping projectors, WATCHOUT automatically applies
edge blending in overlapping areas.

3D Mapping Projector. Use this type when projecting onto a complex, 3-dimensional object,
represented by a 3D model in WATCHOUT. No automatic edge blending is applied, but manual
masking can be used to manage overlapping areas.

Virtual Display. A two-dimensional area of the stage from which you can “grab” the resulting pix-
els for use as a new media item. This is useful when dealing with displays that have odd resolutions,
such as LED wall modules (subsequently manager through an LED wall processor), or to create
dynamic textures for mapping onto 3D models

ADDING DISPLAYS

To add a display to the Stage window, choose “Add” at the top the Stage menu, selecting the desired
type of display. The “2D Display/Projector” sub-menu includes most standard display sizes. The size
can be altered afterwards using the display’s dialog box, accessed by double-clicking the display
object in the Stage window.

NOTE: Displays can be grouped into stage tiers. When using multiple tiers, new displays are added

to the current tier. Likewise, you must select the proper tier before you can manipulate its displays (see
“Tier”).

SELECTING DISPLAYS

Click a display to select it. Shiftclick to select multiple displays. Alternatively, drag from a point out-
side all displays to use the selection rectangle. To de-select all displays, click outside all displays in the
Stage window.

NOTE: You must activate the Stage window before you can select displays. To activate the Stage
window, click its title bar. Displays can not be manipulated if “Online” on the Stage menu is active.

POSITIONING DISPLAYS

Drag a display to the desired position using the mouse. Press the Shift key while dragging to constrain
the movement to horizontal or vertical only. For best precision, enter the exact position using the dis-
play’s dialog box.

REMOVING AND DUPLICATING DISPLAYS

To remove a display, first select it, then choose “Cut” or “Clear” on the Edit menu. To duplicate it, first
choose “Copy” then paste the duplicate back into the Stage window. When pasting a display, keep in
mind that the duplicate initially occupies the exact same location in the Stage window as the original
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did. You must move the duplicate to another location and change its name and computer assignment
before using it.

2D DISPLAY/PROJECTOR

To be able to edit displays, you must activate the Stage window by clicking its title bar. Double-click a
display to open its dialog box in a non-modal manner. This means you can work in other windows
while having this dialog open, and you can have multiple display dialogs open at the same time.

Display: Display 1 b 4

......................

[ General | Geometry Mask  Advanced

Display Mame: | Display 1

Computer:
Enabled: [~ Use this display

Dutput Configuration:
Device: GRAPHICS CARD ~

Connection: Test Connection

Change...

Fesolution: |HD-1080 1920x1080

Channel: |1

Display Resolution:
2045 1080

Stage Position and Size of Display:
Left: | 36 Top: | 100

Width: | 2043 Height: | 1080

Width and Height same as Display Resolution

Rotation: | O degrees dodowise

Stage Position of Display Center:
¥ | 1080 ¥: | 40 pixels

Name
Specifies the name of the display.

IMPORTANT: This name is also used to identify pre-split movie files (see “Pre-splitting a Large Video”).
Thus, if you use such pre-split movies, you should not change the name of the display after creating
those movies, or you'll have to rename the movies accordingly.

Computer

Specifies the name or IP number of the display computer to which this display device is connected. In
most cases, using named computers is preferable (see “Addressing by IP Number or by Name”).
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Doing so makes your presentation more portable and independent of the network addressing method
(see “Computer Addressing”).

When using the IP addressing method, the first part of their IP address is often identical, and only the
last group of digits differ (as shown in the illustration under “Network”). In this case, you can enter the
common part of the address in Preferences (see “Display IP Number Prefix”), and then enter only the

last group of digits in the Display Specifications dialog box. For instance, if the complete address is
“192.168.0.51", you would put “192.168.0.” into the “Display IP Number Prefix” field in Prefer-
ences (note the trailing period), and then put 51 into the Address field in “Display Specifications”.

OUTPUT CONFIGURATION
Specifies the output configuration for the two types of displays that correspond to physical outputs (2D
Display/Projector and 3D Mapping Projector).

Device
Determines which output card should be used; Graphics Card or SDI.

NOTE: SDI output is available only on WATCHPAX 60 model C.

Resolution

If the output device is set to SDI a limited number of resolutions are available. If the output device is set
to Graphics Card, there is also an option of using a custom, user-defined, resolution.

Channel

Specifies which output channel to use on the Graphics Card or SDI board. For details on SDI channel
assignment rules, please see “SDI Channel Assignment”. For details regarding channel numbering on
your specific hardware, please refer to its manual.

IMPORTANT: Assigning an SDI channel as an output will take precedence over input for multi-direc-
tional SDI channels.

SDI Link Type

This is only available when the selected output device is set to SDI and determines the link type for the
current output channel. Four different types are available: Single-Link, Dual-Link, Quad-Link Quadrant
and Quad-link Interleaved. For details on the different link types, please see “SDI Link Type”.

Enabled

Deselect “Use this display” to temporarily disengage the display device from your presentation.

NOTE: When deselected, WATCHOUT will not complain if it can’t connect to the corresponding dis-

play computer.

Connection

Indicates the on-line status of the associated display computer. You can use the “Test Connection”
button to verify the ability to connect to that particular display computer. This may be useful when
trouble-shooting a system.

Color and Change

Allows you to change the color of the display’s outline in the Status window.

DISPLAYS AND PROJECTORS 85



Display Resolution

Physical resolution used by the display computer for the signal fed to its projector or other display
device. WATCHOUT allows you to specify any resolution. However, the allowable settings are ulti-
mately determined by the display device and graphics card.

Stage Position and Size

Determines the position and dimension of the display in the Stage Window. Normally, the dimension
here matches the physical resolution of the display. You can override this by deselecting “Width and
Height same as Display Resolution”, allowing you to enter different values. Doing so will make
WATCHOUT scale the image to match the resolution.

HINT: This is particularly useful if you have to play a show made for a specific resolution on projectors
that can’t handle that resolution.

Rotation

Rotates the display to an arbitrary angle. This allows you to use a vertical display format, as well as
other creative display arrangements as shown in the illustration under “Alternative Display Layouts”.

NOTE: Edge blending will only work properly between displays that are on the same stage tier with
the same rotation angle and stage size.

Stage Position of Display Center

This field is similar to the Left and Top fields in the “Stage Position of Display” field above, but indi-
cates the center of the display rather than the top left corner. The center is often more relevant when
the display is rotated to an arbitrary angle.

See common sections, later in this chapter, for the remaining tabs and fields in this dialog box.
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3D MAPPING PROJECTOR

Use this display type to wrap images around a three-dimensional object,

projecting onto the surface of the physical object.

such as a car or a sofa, by

Projector: Projector 2

General  position  View

Calibrate Mask

Geometry|

Projector Mame: | Projector 2

Computer: |

Enabled: +|Use this projectar

Connection: _ Test Connection

Cutput Configuration:

Dewvice:

Resolution:

Channel:

Resolution:
1920

Stage Size:

Width: | 1920

Lens Shift:

Horizontal: IZI B
Vertical: IZI %o

GRAPHICS CARD

Height:

g

Change...

HD-1080 19201080 ~

1080

1080

Width and Height same as Resolution

Lock: []Lock Lens Shift During Calibration

Pt

.3

See under “2D Display/Projector” for details on most fields in this dialog box.

Lens Shift

Many projectors can project their image off-axis. For example, most office grade projectors have a
fixed shift that allows the projector to be placed horizontally on a desk, and yet project an image on a
wall where the bottom of the image is at or above the desk’s level. Some professional grade projectors
have adjustable lens shift — sometimes in both the vertical and horizontal directions.

Projector

Projector

Lens Center

On-axis projection and vertical lens shift of about 55 percent of the image height.

DISPLAYS AND PROJECTORS

87



When mapping images onto a three-dimensional object, it is important to account for the lens shift in
order to obtain a correct mapping. The lens shift is described as a percentage of the total image
height and width. Hence, for a vertical lens shift upwards from the projector’s center (as shown in the
illustration to the right above), you specify a positive shift value. If the image is shifted so that its bot-
tom coincides with the projector’s center line, it is said to be 50%. That is, the image is shifted
upwards by 50% of its total height.

The same applies in the horizontal direction, where a positive percentage value shifts the image to the
right and negative to the left.

NOTE: Some projector manufacturers refer to a shift of half the image height as “100%". Further-
more, the lens shift stated by the projector manufacturer is often an approximation. You're advised to
make your own assessment of this value rather than relying on the manufacturer’s stated lens shift.
Entering an incorrect value may impede your ability to use WATCHOUT's calibration feature to align
the projector.

The lens shift can either be determined and entered manually, or it may be derived as part of the pro-
jector calibration (see “Calibrate”). In general, it is best to measure the lens shift ahead of time, and
enter it manually. That works well for projectors with a fixed lens shift, but may sometimes be harder
when using variable lens shift in an installation.

Lock Lens Shift During Calibration. Select this option if you've determined the lens shift accu-
rately ahead of time. This stops WATCHOUT from attempting to calculate these parameters, which
may simplify the calibration procedure.

POSITION

This tab in the dialog box specifies the location, target point, rotation and focal length of the projec-
tor. While the values may be edited numerically, you typically use the “Calibrate” tab instead to deter-
mine all these values automatically.

Position/Point At

Specifies the position and target position of the projector, in 3D space. The target position of a
selected projector is indicated by a yellow point at the end of the projection beam in the Stage win-
dow. To change the position interactively, drag the projector in the Stage window. Likewise, to change
the target position, drag the yellow point in the Stage window.

To orient the projector in 3D space, use the “View” commands on the Stage menu to rotate the Stage
window in order to look from the top or from the side. Alternatively, use the “View” tab in this dialog
box to move the projector while viewing the scene from the projector.

Rotation Around Optical Axis
Rotates the projector, allowing you to use the optimal angle to cover the projection object.

CAUTION: Some projectors have restrictions on how they may be mounted or rotated, due to air-flow
and heat reasons. Always check the documentation before using a projector in any other orientation
than horizontally.

Width / Distance Ratio

The focal length of the projector’s lens, expressed as the ratio between the image width and projection
distance. A small value here indicates a wide angle lens, while a larger value indicates a long throw
lens.
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Lock Zoom During Calibration

Checking this option will improve end-results if you are projecting onto objects that will vary in their
distance from the projector. In order to get optimal results, the width / distance ratio (zoom) must be
known from the projector specification.

VIEW
The View tab in the 3D Mapping Projector’s dialog box shows the scene from the projector’s view-
point, as if looking through a camera’s viewfinder. This has two important advantages:

* |t allows you to position the projector interactively, using the controls along the top of the dialog
box, which is often more intuitive than dragging the projector and its target point in the Stage
window.

* |t shows you the scene from the projector’s viewpoint, allowing you to visualize the scene from any

vantage point — not just the front, top and left views available in the Stage window.

As you adjust the view position using the controls along the top of the dialog box, the Stage window

shows the effect this has on the projector. Moving the projector in this way also updates the numeric
values in the Position tab accordingly.

Projector: Projector 1 bt

General  Position  ViEw  Calibrate Mask  Geometry Advanced

RS "I" a0 MNarmal w
OFF LINE

Double-click a Projector in the Stage window and select the View tab to move the projec-
tor interactively using the controls along the top of the tab.

The controls along the top of the tab are:

¥ Track. Move the projector forward or backwards.

«» Dolly. Move sideways and up/down.

ww Orbit. Orbit around the target.

P Pan. Rotate projector around its center, moving the target.

) Rotate. Rotate projector around its optical axis.
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HINT: You can select a control and then drag in the view area, or simply drag the control. Press the
initial letter on the keyboard to switch among the controls.

The menu in the top right corner controls the behavior of the physical projector connected to the dis-
play computer, with the following options:

Normal. Project the image displayed in the View tab.

Muted. Project nothing (black). Useful when calibrating a projector, in which case you may want to
mute other projectors.

White. Project all white. Useful to see the coverage of the projector, to make sure it covers the map-
ping object.

White Masked. Project white, but include any masks defined on the Mask tab.

Pattern. Project a distinct pattern, which is useful when focusing the projector.

CALIBRATE

The Calibrate tab shows the same image as the View tab, but allows you to attach and adjust calibra-
tion points to the projector and the real-world projection object. This semi-automatic calibration
method allows WATCHOUT to calculate all the settings on the Position tab (as well as, optionally, the
lens shift values). This is useful when mapping images onto a physical, three-dimensional object.

Projector: Projector 1 by

Gereral Positon View  Calbrate Mask Geometry Advanced

{®) Edit Points () Line Up Points Mormal

Select the Calibrate tab and add calibration points to your physical 3D object.

To use this method, you must:
® Have a physical object to map images onto.
* Have a 3D model that accurately matches the physical object.

* Display the 3D model using a Cue on a timeline.
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* Place the physical projector so it illuminates the object as desired.
e Use the View tab to position the projector inside WATCHOUT in roughly the same way.

Once that's done, select “Edit Points” on the Calibrate tab and start adding points. To add a point,
you click somewhere inside the 3D model, as shown above. To add a point close to an edge, press the
mouse down inside the model, then drag it towards the edge. Points can not be placed outside the
model. You can add any number of points, but need to have at least six points. Calibration points
should be placed at easily recognized positions on the model allowing you to accurately correlate the
point in the Calibrate tab with the corresponding point on the physical object. Remove a point by
selecting it and choosing Clear on the Edit menu.

HINT: Enlarge the dialog box to position points more accurately.
To calibrate the projector’s position, do as follows:

e Select “Line Up Points”.

* Grab and move one of the calibration points while looking at where it will be projected on the
physical model.

* Move the point until it hits the same spot on the physical model.

* Do this for all calibration points until the image maps properly onto the model.

HINT: Use the tab key to switch between the “Edit Points” and “Line Up Points” modes, and arrow keys
for precise positioning.

As you work your way through aligning the points onto the physical object, the color of the calibration
lines may vary.

Yellow. The positioning of points on the model makes sense to WATCHOUT, allowing it to calibrate
the projector’s position accordingly (you'll also see the projector move in the Stage window, and the
projected image move on the physical object).

Red. The position of some points doesn’t make sense, and can not be used to calculate the projector’s
position.

Sometimes it may be hard to position the calibration points to avoid the red indicator lines. It's suffi-
cient to have a single point off for this to happen. This can also be caused by incorrect Lens Shift val-
ues. If you're unsure about the actual lens shift, it's sometimes better to uncheck “Lock Lens Shift During
Calibration,” allowing WATCHOUT to calculate this as well.

NOTE: The 3D object must be stationary in the Stage window for this calibration to work. If you move
the image in the Stage window, you need to start over with the calibration.

This video shows how the calibration feature is used:
https://www.dataton.com/3d-projection-mapping-basics

See common sections, later in this chapter, for the remaining tabs and fields in this dialog box.
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VIRTUAL DISPLAY

A virtual display is similar to a “2D Display/Projector” in many ways, except it is not associated with
a physical display connected through a display computer. Instead, whatever is displayed on it is
made available for reuse inside WATCHOUT itself.

Virtual Display x

Mame: | ==

coor: [N | change..

Display Resolution:

Width: | 2043 Height: | 2048

Stage Position and Size of Display:

Left: | <112 Top: | -3940

Width: | 2048 Height: | 2042

Width and Height same as Display Resolution

Rotation: | 0 degrees dodaowise

Stage Position of Display Center;
X: | 612 ¥z | 484 pinels

Media Preview: (®) Optimized For Performance
() High Quality

(0] Cancel

A virtual display named “Texture” has been added to the Stage window.
When you add a virtual display you also get a new entry in the Media window with the same name.
Media

Name Thumbnail | Type Information| Duration

[> Man Folder 3 items

Namos Composition 5408 x 1084 10.0
Texture [ |  virtualDisplay 2048 x 2048

The same virtual display also appears in the Media window.

You can use this virtual display media anywhere you use other types of video or images in

WATCHOUT, and you can apply all the same transformations and effects to it. This has two main
applications:

* Manage LED wall modules, or other kinds of display devices with odd pixel dimensions, often con-

necting through some kind of processor, which manages several modules by mapping them into a
common pixel space.
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e Create textures for 3D objects using the full power of WATCHOUT, including multiple image and
video layers, tween tracks, dynamic content (such as live video), etc.

MANAGING LED WALL MODULES

LED walls are typically made up of a large number of square “LED tiles”. Each tile has a resolution
based on its physical size and LED density, for instance 144 by 144 pixels. Due to this unusual resolu-
tion, and the common need for using a large numbers of tiles, the tiles aren’t connected directly to a
display computer, as is the case with most other displays. Instead they’re connected through an “LED
wall processor”. This processor accepts standard video formats, such as 1920x1080. The LED tiles it
manages are then mapped into this pixel space by configuring the system and the processor accord-
ingly. This mapping can be straightforward by placing all tiles in rows and columns to recreate most

of the 1920x1080 display.

A large number of 144x144 pixel LED wall tiles mapped into a 1920x1080 pixel
space.

More often, the pixel budget is used in more creative ways, for example as a narrow and very long
strip.

26 modules making up a narrow strip of 3744 by 144 pixels.

When producing the presentation in WATCHOUT, you generally want to have the displays in the
Stage window arranged in a way that resembles their physical arrangement, and not the arrange-
ment fed to the processor. In the example with the long, narrow strip above, you want to be able to
have text and images slide across that entire 3744 pixel wide display area.

While you can’'t make a 3744 by 144 pixels regular “2D Display/Projector” in WATCHOUT
(because no computer can output such an odd resolution), you can make a virtual display of that size.
Images appearing on this virtual display can then be mapped onto a real display, as two copies of
that single, long virtual display, like this:
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A long LED strip mapped twice onto a 1920x 1080 pixel space.

The reason you need to map the long strip onto a real display is that the processor driving the LED will
generally only accept standard video or computer resolutions, such as 1920x1080 in the example
above. The processor will then do the reverse mapping, putting all the pixels back where they belong
along the long, narrow strip of LED tiles.

IMPORTANT: When using virtual displays, always create as few virtual displays as possible. Do not
create one virtual display per LED tile. In the example above, you could make either a single, long
virtual display covering the entire 3744 pixels, or you could make two virtual displays side by side,
each 1872 pixels wide (as shown by the colors above). Using a large number of virtual displays may
degrade the performance of your system.

Here's another example of an arch-shaped structure built with the same kind of LED modules:

An arch-like structure built from 32 144-pixel LED modules.

Again when representing this in WATCHOUT, use as few virtual displays as possible, for example one
for the blue strip along the top and one for each side. Then assemble the resulting three media objects
onto a real “2D Display/Projector” using cues on a timeline in any appropriate manner to feed the
pixels to the LED wall processor. This will then map them back onto the arch structure.

HINT: Use a set of cues on a paused auxiliary timeline to map the virtual display media elements onto
the real display, leaving your main timeline clean and uncluttered for your production work.

See this video for a more visual description of how this is done:

http://www.dataton.com/producing-for-led-walls
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CREATING DYNAMIC TEXTURES

While you can use a simple image or video to texture a 3D model, it gives you very little flexibility in
how the content is played and positioned. For instance, you can’t do any of the following using that
simple method:

® Position an image anywhere on the 3D model (the entire image will be mapped into the UV space
of the 3D model, with no control over its placement).

e Compose multiple images, video and other content using several layers to build the texture (only a
single image element can be used).

e Change the content mapped onto the 3D model over time (only a single image element is used for
the entire duration of the 3D model’s cue).

* Loop a piece of video used to texture the model (since the video doesn’t have a cue of its own,
there’s no place to turn on looping).

All of these restrictions, and more, can be alleviated by first mapping whatever content you want onto
a virtual display, using the full capabilities of WATCHOUT, and then using the virtual display’s media
item as the texture for your 3D model.

To use this method, follow the steps below:
e Create a virtual display of the desired resolution.

® Render content onto that virtual display using multiple layers and cues, as you normally use

WATCHOUT.
® Locate the media item corresponding to the virtual display in the Media window.
* Add the 3D model to your timeline, positioning it as desired.
* Make sure the 3D model’s cue is selected.

* Drag the virtual display’s media item from the Media window onto the selected 3D model in the
stage window.

Usually, the virtual display will be square, with a resolution that's a power of 2, such as 2048 by
2048 pixels. That's not required by WATCHOUT, but is customary for 3D texturing. Discuss this with
your 3D artist. If desired, create the virtual display on a separate tier to keep it out of sight for other
displays and projectors (see “Stage Tiers"”). The resolution to use for the virtual display should be
based on the following factors:

* The resolution of the content you're going to place onto it. There's no point in using a higher resolu-
tion than that of the content that will be rendered onto it.

® The physical size of the object on which you are projecting. If it is a small object, or only going to
be viewed from afar, you won't be able to see any very high resolution content anyway.

* The resolution of the projector used for the projection. Since you often only use a part of the projec-
tor’s raster image to cover the 3D model, the resulting resolution is often well below that of the
projector.

Check out this video for an overview of how this technique can be done. The video also discusses how
to use multiple virtual displays to texture different areas of a 3D model (see “Using Multiple Textures”).

http://www.dataton.com/3d-texturing-using-virtual-displays
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PREVIEW QUALITY

The quality of the virtual display media in the production software is lowered to increase performance.
There is an option to view it in full quality by selecting the “High Quality” media preview setting in the
virtual display dialog. This is useful, for example, when using the virtual display as a texture on a 3D
model.

GEOMETRY CORRECTION

These settings allow you to compensate for any errors caused by projection off-axis (perspective), on a
slightly curved surface or to account for any optical distortion.

NOTE: Projecting straight from the front onto a flat surface always gives the best image quality. Use
geometry correction only when necessary.

Display: Display 1 b 4

General Geometry Mask  Advanced

=

Correction: | Full v mm O

1
*
&0
L]
4k 4k 41k
O &
)]

DCnrner Shapes =4 | 500

Full geometry correction mode selected. Diamond-shaped handles move the correction
points. Round handles adjust the curvature. Rectangular handles adjust the distribution
between correction points.

Select the type of correction to be performed using the “Correction” menu, which has the following
options:

None. No geometry correction.
Perspective. Provides perspective control, for use when projecting off-axis onto a flat screen.

Horizontal. Compensate for the screen curvature when projecting onto a horizontally curved
screen.
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Vertical. Compensate for the screen curvature when projecting onto a vertically curved screen.

Full. Maximum flexibility, for use when projecting onto spherically curved screen or other uneven
topologies.

A screen requiring full geometry correction, as it is curved both horizontally and
vertically.

The numeric fields at the bottom of the dialog box show values corresponding to the currently selected

correction mode, point and handle. The buttons next to each numeric field adjust the value with single
pixel accuracy.

Corner Shapes. Adds bezier handles to the corners, allowing you to compensate for minor optical
distortion, often associated with wide-angle lenses.

Smooth. Avoids abrupt kinks in points by keeping all tangents straight. Uncheck to allow opposing
handles to move independently of each other.

HINT: Your display computers need to be online to see the changes live on screen as you make them.
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PERSPECTIVE CORRECTION

To compensate for the keystone-shaped image caused by off-axis projection, choose Perspective on
the Correction pop-up menu and drag the corners of the grid until the image appears rectangular on
screen.

Display: Display 1 b 4

General Geometry Mask  Advanced

Correction: |Pergpective '-_ i (}

K| 277 | — E
v | 238 = — = +

DCnrner Shapes =< 0

Drag a corner point to adjust the perspective. Enable “Corner Shapes” to compensate
for optical distortion.

HINT: You can use the Copy and Paste commands on the Edit menu to transfer the geometry settings to
other displays.
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HORIZONTAL OR VERTICAL CORRECTION
Adds bezier handles to the top/bottom or left/right sides, allowing you to compensate for projection

onda CUI’VGd SUFFCICG.

Display: Display 1

General Geometry Mask  Advanced

_ " i
Correction: |Horizontal ot m By

4| ¥ L
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Smooth
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ADDING CORRECTION POINTS
In Full correction mode, you can add control points to the grid by Control-clicking the desired location.
This can be used to handle geometry adjustments when projecting on asymmetric or uneven surfaces.

Display: Display 1 bt
General Geometry  Mask  Advanced

Correction: | Full v i O

—

— 17

¥i| 25

4|k 4k
|.-

[:)-}—C]
O]
Smooth

— |92

¥:| 102

4|k L L 4|k

[ ]Corner Shapes == | 500

Control-click in grid to add points. To remove such a point, select it and press the Delete
key.

HINT: Use the Copy and Paste commands on the Edit menu to transfer the geometry settings to other
displays.

HINT: Correction points can be adjusted using the keyboard arrow keys.

In some cases, when projecting onto complex geometry, you may be better off with a proper 3D
model of the geometry, and then using the 3D mapping capabilities of WATCHOUT instead of trying
to fit the image using geomoetry correction.

It may occasionally be advantageous to combine the two techniques. In general, you shouldn't need
to use geometry correction for a “3D Mapping projector”, assuming that the 3D model you have is an
accurate representation of the object upon which you are projecting. But sometimes reality sets in, and
things just don't fit perfectly. In this case, after using the calibration feature of WATCHOUT to calibrate
the projector position as far as possible, apply some geometry correction as a last resort in order to
better fit the image onto the model.

NOTE: Any geometry correction applied to a “3D Mapping projector” will be temporarily disabled
while using the calibration feature, since the distortion caused by the geometry correction interferes
with the calibration.
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MASKING

WATCHOUT applies automatic edge blending to overlapping 2D display areas. This is sufficient for
most basic multi-display applications. However, this automatic method doesn’t work when mapping
onto three-dimensional objects with multiple 3D Mapping Projectors. In this case, any masking
required to blend the projectors’ edges must be applied manually.

Projector: Projector 1 e d

General Positon View  Calibrate Mask Geometry Advanced

Add... | [-]Enabled Full Screen | Gradient... | & :O Maormal o

A feathered mask added to a projector.

To add a soft mask to a projector, select its Mask tab and add the desired type of mask using the
“Add...”" menu:

Left, Right, Top, Bottom. Adds a mask along the specified edge. Use this to add custom edge-
blend masks when the default one is insufficient, or as a starting point for another mask.

Rectangle. Adds a rectangular mask, with a feathered edge along all four sides.

Oval. Adds an oval mask, with feathered edge all around.

NOTE: The masks added using this menu are intended as starting points only. You can create any
shape of mask from any starting point by manually moving, transforming or editing the mask. In the
example above, a mask was created using “Add: Right”, and then moved and scaled as desired
using the tools along the top.

Once a mask has been added, you can select, movie, scale and rotate it using the tools along the top:
k Select and Move.
“." Scale.

(¥ Rotate.
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You can add any number of masks. Select which mask to manipulate using the arrow tool. The
selected mask has a solid outline. When using the Scale or Rotate tools, an anchor point is shown. To
scale or rotate around another point, move this anchor before scaling/rotating the mask.

HINT: You can use Copy and paste to copy the selected mask from one display to another, or between
shows.

Uncheck “Enabled” to temporarily suppress a mask without removing it. This is useful when working
with multiple masks across several projectors.

EDITING THE SHAPE OF A MASK

To edit individual points in a mask, rather than the mask as a whole, double-click the mask with the
arrow tool. Selection points appear for all vertices in the mask. Select individual points, or drag to
select multiple points. Selected points can be moved, scaled or rotated using the tools along the top.
To add new points, click a line between two points using the Select tool (which shows a pen cursor to
indicate this). Delete a point by selecting it and choosing Clear on the Edit menu.

The outer points along a mask’s edge define the width of the feathered area. Move the outer points
closer to the inner ones to reduce the width. Delete outer points to remove the feathered area. Alterna-
tively, double-click a point to open its dialog box and select this behavior.

HINT: Make sure there’s an image on stage that appears on the display, allowing you to see the feath-
ered edge.

HINT: Masks and their points can be nudged using the keyboard arrow keys.

To stop editing a mask, click outside the mask with the arrow tool.

EDITING THE GRADIENT OF A MASK

By default, a linear gradient is applied to the edge of a mask. To change the curve of the gradient,
select the mask and click the “Gradient...” button. This displays a dialog box similar to the one used
to edit the standard edge blend gradient in the Preferences dialog box (see “Edge Blend”). Use the
same technique as described there to edit the gradient curve.

IMAGE MASKS

Still images can also be used as display masks. To create an image mask, drag an image media item
from the media list to the mask tab of a display dialog. This creates a grayscale mask version of the
image, where darker colors are opaque, and brighter colors are more transparent. This is useful, for
example, if you want to be able to draw your masks in another software application, for example
Photoshop.

Once an image mask has been created, it can be scaled and rotated in the same manner as other
masks. You can also set it to full screen mode (unlike other display masks) by checking the “Full
screen” check box, which becomes available when an image mask is selected. In this mode, the
image will be automatically stretched and placed to cover the whole display surface

OTHER USES FOR MASKS

While this masking feature is primarily designed to handle projector blends for 3D mapping pur-
poses, it can also be used as a general masking tool for both 3D and 2D projectors. For instance, if
you're projecting onto the outside wall of a building, you may want to mask out windows and other
areas where projection is not desired. This can be accomplished by adding the required number of
masks to the projector.
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You can also use manual masking in place of the automatically generated edge blends, for example
to blend between different types of projectors or where the automatic edge blending doesnt offer
sufficient control. If you design your own custom masks, turn off the automatically generated blending
masks by unchecking “Use Default Soft Edges” on the Advanced tab (see below — applies to 2D Pro-
jectors only).

ADVANCED
This tab contains some miscellaneous and rarely used functions.

Display: Display 1 a

............................. N

Color correspanding to white for this display.

Red: ' %
Green: ' T
Blue: ' %%

Stereoscopic Assignment: | None 55
Edage Smoathing: Off w

[Juse as Synchronization Chain Master

Reguires displ A% TN Sy N zateon hardwars
Lse Default Soft Edges

Apply Masks and Soft Edges
{®) With Geometry Correction
ID Without Geometry Correction

COLOR

Ideally, all displays in a system should be properly color matched. How- °
ever, sometimes you may have to deal with projectors with different lamp 20
life or other minor discrepancies. In such cases, WATCHOUT lets you

adjust the white balance of a display device, making the overall image
look more uniform. Use a colorimeter or an appropriate test image, such
as the one shown on the right, when adjusting the white balance.

NOTE: Display computers need to be online for you to see the changes as you move the sliders.

Alternatively, use the color calibration features built into most projectors. These can often give better
results when used by a skilled operator.

STEREOSCOPIC ASSIGNMENT

This setting applies to the “2D Display/Projector” only. Controls the stereoscopic channel reproduced
by this display device. You must use separate projectors for the images reproduced for each eye in a

stereoscopic presentation. Select the appropriate eye affinity on this menu. Leave this set to None for

normal (non-stereoscopic) presentations.
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For proper reproduction, each projector in a stereoscopic pair must be equipped with filters matching
those used in the glasses worn by the viewers. Please contact your projector vendor for details on
supported 3D projection technologies.

IMPORTANT: You must place the related left and right eye projectors at the same stage position. To
avoid WATCHOUT attempting to create edge blends for those overlapping projection areas, place
the set of left eye and right eye projectors on separate stage tiers (see “Using Stage Tiers for Complex
Display Arrangements”).

EDGE SMOOTHING
Use this option to smooth out the jagged edges that can appear when for example rotating media, or
when using geometry correction. The setting has four levels: Low, Medium, High, and Off.

This setting should be used with care if you don’t have a powerful graphics card, as it may have a
negative effect on performance.

USE AS SYNCHRONIZATION CHAIN MASTER

WATCHOUT synchronizes all computers in a display cluster via the network. This is sufficient in most
cases. However, in some cases, frame-accurate synchronization of display refresh cycles are
required. For instance:

® When driving a large LED wall using more than one display computer, or using multiple outputs
from a display computer using AMD graphics cards.

* In broadcast applications, where all displays used on set must be locked to the house sync to avoid
camera interference.

In such cases, WATCHOUT can be used with hardware synchronization solutions from AMD (S400)
and NVIDIA (Quadro Sync), in conjunction with compatible, professional-grade graphics cards.
Here's some more information on these solutions:

http://www.amd.com/en-us/products/graphics/workstation/firepro-display-wall /s400
http://www.nvidia.com/object/quadro-sync.himl
Both theses solutions work in about the same way:

e All display computers must be equipped with synchronization cards and compatible graphics
cards.

® One computer in the display cluster is designated as the synchronization master.
* A separate synchronization cable connects from the output(s) on the master to the slave cards.
e Optionally, a “house sync” (genlock) signal is connected to the synchronization master.

® The graphics cards’ and synchronization cards’ settings are configured according to the manufac-
turer’s recommendation.

Once this is done, enable “Use as Synchronization Chain Master” for a display connected to the
display computer acting as the synchronization master.

IMPORTANT: For this hardware synchronization solution to work reliably, you may need to ensure that
all displays are turned on before the display computers are powered up.

In addition, the SDI boards of Dataton media servers feature synchronization capabilities. For details
on which type of synchronization your Dataton media server supports and how to set it up, please
refer to its manual.

DISPLAYS AND PROJECTORS 104


http://www.amd.com/en-us/products/graphics/workstation/firepro-display-wall/s400
http://www.nvidia.com/object/quadro-sync.html

USE DEFAULT SOFT EDGES

This setting applies to the “2D Display/Projector” only. Uncheck this if you decide to make custom
edge blend masks manually, rather than relying on the automatically generated edge blends (see
“Once an image mask has been created, it can be scaled and rotated in the same manner as other
masks. You can also set it to full screen mode (unlike other display masks) by checking the “Full
screen” check box, which becomes available when an image mask is selected. In this mode, the
image will be automatically stretched and placed to cover the whole display surface”).

NOTE: The automatically generated edge blend mask is sufficient in the vast majority of cases. Before
you start creating individual edge blends manually, first make sure you projectors are well matched
and set up properly. In particular, avoid any “high brightness” or “office” gamma setting modes,
selecting more linear modes such as “film” or “photo” instead.

APPLY MASKS WITH/WITHOUT GEOMETRY
This setting allows you to specify if display masks and soft edges should be affected by geometry
correction, or not.

USING MULTIPLE DISPLAY OUTPUTS

Depending on the graphics card, a self-build display computer running WATCHOUT can support up
to six displays. Dataton media servers offer up to 12 simultaneous outputs from a single server. These
displays operate independently of each other, and can be freely positioned and rotated.

To drive multiple displays from one computer, enter the output number of each display in its dialog box
(see illustrations under “2D Display/Projector” and “3D Mapping Projector”). Use the same computer
name or [P-number for these displays.

IMPORTANT: Connecting multiple displays to one computer increases the load on that computer. You
will need a more powerful computer, with a multi-core CPU and a fast disk drive or SSD, to drive multi-
ple displays. For best performance, you may need to limit the number of displays.

EDITING MULTIPLE DISPLAYS

You can edit properties of multiple displays, of the same type and targeting the same output device
(Graphics Card or SDI), at once, by selecting them and then double-clicking one of them, or by
right-clicking one of them and selecting “Specifications...”. This will open a display dialog in a modal
manner, which means you can not work in any other window on the desktop while this dialog is open.

In this dialog you should only edit those properties that you want to be the same for all the displays
you selected, for example color or address. If the address or name text fields are empty in this dialog,
it means that those values are currently different for the displays you selected. Please note that the
mask and geometry tabs are not visible in this dialog as these properties can not be edited in this way.
The same goes for the view and calibration tabs of the 3D mapping projector.

CREATING MULTIPLE DISPLAYS
You can create multiple displays at once, formed in a grid, using the “Add Display Grid...” command,
which can be found on the Stage menu, or on the right click menu of the stage.
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Grid Size

Display Grid
Gereral  Advanced

Display Type: | 2D Display e
Mumbering And Addressing:

RowWise ~
Grouping Ru:uws: = Cu:ulumns: =
Marming:

Display ¥aMUM%%

rizbles to wss: WOOLW, TLROWT, TENUM®
IP Address
Start Address: |
Cutput Device: | Graphics Card -
Outputs Per Computer: :
Ok Cancel

Specifies the number of colums and rows in your display grid.

Display Resolution

All the displays will have the same resolution.

Start Position

Specifies the top left corner of top left most display in the grid. If you used the right click menu to open

this dialog, this value will be prefilled with the position where you clicked.

Spacing

Here you can specify how the displays should be separated/overlapped. Input a positive value to

have the displays separated by that amount of pixels, or input a negative value to get an overlap with

that amount of pixels.

Display Grid

General | anc

.............................

Display Type: | 2D Display e
Mumbering And Addressing:

FRow\Wise e

Grouping Ru:uws: = Cu:ulumns: =

Maming:

Display %eMUIM%%

Wariazbles to use: TWOOL%, WROWM, JLHNUM
IF Address
Start Address: |
QOutputs Per Computer: :
QK Cancel
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Display Type
Here you can select if you want to create normal 2D displays, or virtual displays.

Numbering and Addressing

Specifies if the displays should be numbered/addressed in a row wise or column wise manner. You
can also specify if the displays should be grouped in any way when numbering/addressing.

Naming

All displays should have unique names. This is why naming with variables is very useful. In the exam-
ple dialog above, the variable %“NUM% is used, which will be replaced with the number of each
display. The numbering order can be specified as described in “Numbering and Addressing”. Other
variables you can use are %COL% and %ROW%, which represent the column and row number
respectively.

Addressing
Addressing of the multiple displays can be done in two ways: By IP or name address.

IP Address

By selecting “IP Address” in the selection box, as shown in the example dialog above, you can
address the displays with ip addresses. In this case, just write the address of the first display computer
in the text field, and the address will automatically be counted up for each new display computer. This
numbering follows the rules specified in “Numbering and Addressing”

Name Address

Mame Address R

|C|:|m|:|‘}’nNLII'~"I‘}’n |
By selecting “Name Address”, as shown in the above image, you can specify named addresses for all
the displays. This is done similarly as naming the displays (described in “Naming”), except you have
only one variable available, %NUM%. This vaiable will be replaced with the computer number, to

form the final address of each display. The numbering follows the rules specified in “Numbering and
Addressing”

Output Device

The output device configuration for Graphics Card or SDI. For more information about output configu-
ration, please see “Output configuration”.

Outputs Per Computer

The number of outputs per display computer also affects the addresses of the displays and can be
specified in the display grid dialog. The output number (if there is more than one) will be increased for
each display created, making sure each display gets a unique address/output combination. The
numbering follows the rules specified in “Numbering and Addressing”.

DISPLAY SETUP

A display setup in WATCHOUT is a 2D display/3D mapping projector or a set of 2D displays/3D
mapping projectors containing properties obtained outside WATCHOUT, for example by using a
camera-based calibration system. These properties can be positioning, warping and/or blending.

WATCHOUT supports the domeprojection.com® generic format and MPCDI version 1.0 (Profiles 2D
Media/3D Simulation, level 1 or 3) which can be imported by going to “Import Display Setup “in the
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File menu and choosing the format of your choice. This will open a dialog that is specific to the
selected format.

Both formats require specification of a file or folder, a target tier, and an offset.
File/Folder. Specifies a file or folder that contains the Display Setup data.

Import to tier named. Controls where the imported display setup will be placed.
Display offset. Applies an offset to the positions of imported displays.

In addition to the three common fields of the two import dialogs, each of them has a unique setting.

Import domeprojection.com® Setup X
File/Foider: | | | Browse.
Import to tier named:
Display scale factor: | 1000
Display offset, X: | 0 Y:| 0
oK Cancel

Import dialog for domeprojection.com

As domeprojection.com® setups are often exported with normalized values, there is a “Display Scale
factor” option available in the import. The normalized dimensions of the displays will be multiplied
with this value before appearing in the Stage window.

Import MPCDI Setup b

Fie: | | Browse...

Import to tier named:

Display offset. X: | 0 Y:| 0

Preserve previous offset:

oK Cancel

Import dialog for MPCDI

The MPCDI setup import has a “Preserve previous offset” setting which lets you decide whether to
keep the offset of a previously imported display setup when it is re-imported. When this is selected,
whatever is entered in the Display Offset fields will be ignored in favour of the value specified during
the last import of the MPCDI setup.

IMPORTANT: When importing an MPCDI file that has multiple buffers, the selected tier will not contain
any imported display data. Instead, this tier is used as a basis for sequential creation of new tiers onto
which the imported display data will be placed.

NOTE: Be careful when moving imported displays around as their relative positions have been calcu-
lated precisely. If you alter them by accident, the setup can easily be recovered by using Ctrl-Z or by
simply re-importing the setup. Importing a setup again, using the same files, will update the existing
setup so that no duplicate setups exist.

SDI LINK TYPE

There are four different SDI link types available in WATCHOUT: Single-Link, Dual-Link, Quad-Link
Interleaved and Quad-Link Quadrant.

Single, Dual and Quad refer to the number of cables used to carry the signal, and subsequently how
many output channels that will be occupied by a given output resolution and link type combination.
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For Quad-Link there are two sub-categories; Quadrant and Interleaved. Quadrant splits a frame into
four sections and each section is then sent through a separate cable (output channel). In Interleaved
mode each channel sends interleaved pairs of pixels. The link type to use is determined by your
needs, resolution required and framerate.

More information on the Quad-Link subcategories can be found on the Deltacast website:
https://www.deltacast.tv/technologies/4k-video.

SDI CHANNEL ASSIGNMENT

Typically an SDI board has connectors for input and output with varying bandwidth capabilitie which
are usually expressed as 3G or 12G. An SDI board also has a maximum bandwidth capability. A 3G
connector may be used for Single-Link resolutions up to DCI 2K at 60 Hz, for Dual-Link up to DCI 4K at
30Hz or for Quad-link up to DCI 4k at 60Hz.

A 12G-capable connector may be used for Single-Link resolutions up to DCI 4K at 60 Hz. Its usage
will typically disable subsequent connectors.

As an example, Dataton’s WATCHPAX 60 model C media server has an SDI board with 8 connectors
and a maximum bandwidth of 24G. Two of the connectors (one and five) have 12G capabilities
whereas the other six are 3G only. Since the board has a maximum bandwidth of 24G it is not possi-
ble to use the 12G capabilities of connectors one and five and at the same time use any of the six 3G
connectors. In fact, using 12G or 6G (Single-Link) capabilities of connector one or five will cause the
subsequent three connectors to become occupied.
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6. MEDIA

WATCHOUT is a compositing application; it does not include any media creation or editing functions.
Most media to be used in your presentation must be supplied and edited using other means.

This chapter provides an overview of the media and file formats supported by WATCHOUT, as well as
examples of popular applications used to create or edit such media files. A brief overview is also
available online:

https://www.dataton.com/watchout-overview-supported-media-images-sound-and-video

IMPORTANT: Whenever possible, keep a show’s media files in a folder that is located in the same
folder as the WATCHOUT show file, or in a sub-folder. This allows the software to use relative file
access paths, making it easier to move the show to another disk or computer. You can use the Consoli-
date To command to organize all files in this way.

Thumbna| Type Information Duration

Ball.png Q Image J00 x 300

Human.3ds @  3DModel 410 x1000 x 1¢

Hydraulics.wav Ei] I}]I Sound 2 channels 1.298
y

melon.jpg Y ' Image T2 x 3648

% Video Folder J items

ArmCycle_HAP_A ™ Video 512 x 384 1.4

Snow.m2v o Video 2 x512 J.999

Various kinds of media in the WATCHOUT Media window.

STILL IMAGES

Still images can be used as backgrounds or superimposed on other images. You can control the
degree of transparency, scaling, rotation and other effects for all images (stills as well as moving
images).

SUPPORTED FORMATS
WATCHOUT reads most popular image formats, including JPEG, Photoshop, PNG, Targa and TIFF.

MEDIA 110


https://www.dataton.com/watchout-overview-supported-media-images-sound-and-video 

Preferably, use an image format native to the application used to create/edit the images. For exam-
ple, if you use Photoshop to edit images, save the images as Photoshop files. Although most image
editing applications support saving or exporting to other file formats, doing so may cause a loss of
information. This can make it difficult to edit the image later.

IMPORTANT: To use Photoshop images with WATCHOUT, files must be saved with “Maximize PSD
File Compatibility” enabled. In Photoshop, this is under Preferences, File Handling, File Compatibility.

For photographic images (for example, scanned or shot using a digital camera), JPEG at a high qual-
ity setting often provides the best compromise between image quality and file size. Keep in mind that
JPEG is a lossy compression format. This means that minor, normally unnoticeable, details in the origi-
nal image may be lost in the compression process.

For computer-generated images with large, smooth areas (for example, screenshots), PNG is a
suitable cross-platform format.

TRANSPARENCY

Some image formats include transparency information in addition to the image itself. This transpar-
ency information is sometimes referred to as an “alpha channel”, although some image editing appli-
cations use this term for other functions. Transparency can be used to create non-square images, holes
inside images or semi-transparent areas, such as drop shadows. Photoshop, PNG, TIFF and Targa file
are examples of file formats that support transparency.

Background image. Image with a transparent  Result when composited in
background and a WATCHOUT.

semi-transparent shadow.

WATCHOUT supports all common methods used for encoding transparency into images. Which
method to use is usually determined automatically. If not, you can specify this manually by opening the
Specifications dialog box for the image and choosing the desired type.

IMAGE SPECIFICATIONS
Double-click the name of an image in the Media window to change its specifications. Click the Browse
button to link the media item to another file. This updates all cues to show the newly selected image.
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Image >

Image File: | Pictures/Ball.png Browse...

Transparency: | ato Detect "

Optimize For: @ Better Performance
() More Effects and Capabilities

Applies to images

to BK by BK pieels.

(84 Cancel

Transparency
In most cases, WATCHOUT can determine the kind of alpha channel (transparency) being used in the
image, if any. If the automatic detection fails, choose the correct type of alpha channel here.

Optimize For

WATCHOUT normally optimizes all images for best possible playback performance. However, this
may occasionally limit your options when attempting to apply advanced features to an image, such as
external control of its position or size (see “External Control of Tween Tracks”). To allow the use of such
advanced features, choose “More Effects and Capabilities” instead.

IMPORTANT: Do not choose “More Effects and Capabilities” unless you need to, as doing so
increases the load on your computer. This option is not available for images larger than 8192 by
8192 pixels.

VIDEO
WATCHOUT can play back videos saved in a Windows Media (DirectShow) or QuickTime-compati-
ble format, such as MOV, WMV, AVI, DV and MPEG-1/2/4 (including H.264/AVC). A progressive

—that is, non-interlaced — format is preferable (for example, “30p” or “60p”).

NOTE: WATCHOUT can utilize QuickTime, including all its codecs, if available. However, QuickTime
is not required by WATCHOUT. Some popular video formats often stored in MOV files will use native
codecs built into WATCHOUT regardless of whether QuickTime is available or not. This includes the
H.264 (MPEG-4), Animation, Prores and HAP codecs.

HIGH RESOLUTION VIDEO

WATCHOUT supports high resolution video using MPEG-2, H.264 ,Windows Media 9, Prores and
HAP, as well as other codecs capable of high-resolution encoding and playback. Many MPEG-2
encoders have difficulty encoding higher resolution than 1920x1080, while other formats tend to be
more flexible, and can support 4k and beyond, depending on hardware resources.

NOTE: High-resolution content using H.264, Windows Media and Prores codecs requires a compara-
tively fast CPU. Likewise, HAP and Prores requires a very fast disk/SSD subsystem. In general MPEG-2
content will play on less powerful computers.

COMPUTER-GENERATED ANIMATIONS

When using computer-generated moving images, you must specify the frame-rate and resolution of the
resulting video during rendering. Generally, when combining computer generated and pre-recorded
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video material, the frame-rate is dictated by the live material. Alternatively, if your playback computer
is fast enough, match the rendered frame-rate to the WATCHOUT display frame-rate (see “Display
Framerate”); for example, 60 fps progressive.

As computer generated videos are by nature resolution independent, it is also possible to make videos
that are much larger than a single display area. Very large videos may need to be pre-split in order to
be used in WATCHOUT (see “Pre-splitting a Large Video”), depending on the performance of the
display computers.

USING TRANSPARENCY

Some applications support inclusion of transparency information in the generated video file. Such
transparency can either come from the source material (for example, a computer generated anima-
tion), or be added afterwards (for example a mask or color key applied to a video clip).

Being able to create arbitrarily shaped videos, or videos with holes in them, means you can combine
videos and still images in many creative ways.

In order to include transparency information in the video file, you must choose a codec that supports
this, such as the Animation or HAP codecs. If exporting the video, set to use “Millions+” of colors. The
“+" at the end stands for the transparency information. This is sometimes called “Millions+Alpha”. You
must also use an application that's capable of reproducing and/or generating transparency informa-
tion, such as Adobe After Effects.

HINT: In many cases, a clean green or blue background can be used instead of true transparency.

Simply apply WATCHOUT's Key tween track to the video.

VIDEO COMPRESSION

Due to the large amount of raw data in a video stream, storing and playing back uncompressed video
is usually not feasible. Video compression is based on the concept of codecs. A codec (which stands
for compressor/decompressor) is the part of the editing and display technology responsible for stor-
ing and playing back compressed digitized video.

There's a wide variety of codecs available, each optimized for a particular kind of source material
and playback requirements. WATCHOUT supports both Apple QuickTime and Microsoft DirectShow
codec technologies for playback. Here’s a rundown of some of the more commonly used codecs:

MPEG-2. High quality. Used on DVD video discs. Optimized for camera video at normal frame
sizes. Also supports high definition formats with some encoders (see “High Resolution Video” on page
112). The WATCHOUT MPEG-2 decoder performs de-interlacing automatically when required.

Quicktime Animation. Very low compression. Optimized for computer-generated material. Sup-
ports transparency when set to “Millions+" of colors.

Windows Media 9. High quality. Flexible in terms of frame size (useful for making tall or narrow
videos), frame-rate and interlacing/progressive options. Demanding on processor speed when using
high resolutions.

H.264/AVC. High quality. Flexible in terms of frame size (varies with encoder). Demanding on
processor speed when using high resolutions.

Prores. Very high quality and low compression. Due to the high data rate, a fast disk/SSD is
required. This codec is mainly designed for use in editing workflows, but given sufficiently powerful
hardware it can also be used for playback.

HAP. Medium-to-high quality. Good playback performance. Due to the high data rate, a fast disk/
SSD is required. The HAP-Alpha veriant supports transparency when set to “Millions+" of colors
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during encoding. While HAP is built into WATCHOUT, it's not available natively in most video encod-
ers. Get the HAP codec here:

https://github.com/vidvox/hap-gt-codec/releases/

Choosing the right codec and codec settings for your source material and playback hardware may
require some experimentation.

RECOMMENDED COMPRESSION FORMATS

Although WATCHOUT supports most video file formats, some formats tend to give better results. As a
general guideline, use MPEG-2, H.264 or Windows Media 9. HAP is often a good choice too — par-
ticularly if you need to play numerous videos simultaneously. If you need transparency encoded into
the video, choose either the HAP-Alpha or Animation QuickTime codec. WM9 as well as H.264
requires more processor power, but provides greater flexibility then MPEG-2 in terms of supported
frame sizes.

PRE-SPLITTING A LARGE VIDEO

High-end computers are often capable of playing numerous high-definition video files at the same
time. As long as what you need to play fits within the realm of your computer’s capabilities, you
should generally choose among the recommended formats listed above.

However, for extremely large videos, spanning numerous displays, even modern computers may not
be fast enough to handle the required resolution as one large video. This applies in particular to com-
puter generated videos, which can be made at any resolution and frame-rate your animation software
is capable of producing. Such very large videos can be played by splitting them into individual
pieces, where each piece includes only the portion of the frame that will play on each display.

While this splitter function is built into WATCHOUT for still images, it is not handled automatically for
moving images. The primary reason for this difference is that the original, large videos would most
likely have to be compressed in order to be stored and distributed to the display computers. To split the
video, the display computers would have to decompress each frame, split it and then re-compress the
result again for final playback. This would mean that each video frame will be compressed twice. The
end result would be a loss of image quality.

In addition to this quality aspect, there are also storage and bandwidth considerations related to
distributing and storing the original (large) video in order to split it, as well as the processing time
involved in compressing it twice. The latter would be significant for such a large video, particularly to
achieve the best quality.

A 1200 x 480 movie to be pre-split across two
overlapping 800 by 600 display areas.

This can all be avoided by splitting the image using the originating application, prior to compression.
Most applications allow you to crop the output to any desired rectangle. In some cases, you can even
set up batches to generate all the individual videos files in one go.
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As an example, assume that you have two 800 by 600 pixel displays with a 30% overlap, and want
to display a video of 1200 by 480 pixels, the split would appear as in the illustration to the right.

NOTE: These figures are only chosen as an example. All modern computers would be able to play
such a video as is, without pre-splitting it.

Include the overlap in the split, since the portion of the image in the overlap will have to play on both
displays. Likewise, if the displays aren’t overlapping you will have to factor in any gap between the
edges of the display areas by specifying a corresponding gap when making the split.

Most applications specify cropping relative to the initial image size. This
means that the bottom and right edges need to be calculated based on the | Crop right
height and width of the original (large) image. by 480

)

L pixels.
IMPORTANT: When splitting a large video into smaller pieces like this, <>
avoid using a compressed video as the source. Doing so would introduce Crop left
an additional de-compression/re-compression step, resulting in lower qual- by 480
ity. Thus, whenever possible, start out with the original material, such as pixels.

individual, computer-generated, image files.

Save the resulting files into a separate folder. Give each file the name of the WATCHOUT display on
which it will appear. Select “Pre-split for Multiple Displays” and link the Video Proxy to the folder (see
“Pre-split”).

VIDEO SETTINGS

Double-click the name of a video in the Media window to change its specifications. Click the Browse
button to link the media item to another file. This updates all cues to show the newly selected image
instead.

Video pd
Video File: | Video/MP2{Snow.m2v Browse. ..
Transparency: | Auto Detect W

Enable WATCHPAX Hardware Acceleration
Apply Frame Elending

(04 Cancel

Transparency

Most video formats do not support transparency. For the few that do (for example, QuickTime Anima-
tion and HAP-Alpha), the “Auto Detect” setting is usually sufficient. If you see a light or dark halo
around the video content, you may try one of the “Premultiplied” settings instead.

Enable WATCHPAX Hardware Acceleration
Applies only when playing certain video formats, such as H.264, on WATCHPAX. May improve video

playback performance when playing high resolution video. This checkbox has no effect when using
other display computers.
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Apply Frame Blending

This setting often results in smoother video playback, at the possible expense of some loss in image
sharpness. This is especially true when the frame-rate of the video is not an even multiple of the display
computer’s frame-rate (for instance, when playing 25 fps video on a display computer set to 60 fps).
This is accomplished by blending adjacent frames together, weighted by their temporal position.

IMAGE SEQUENCES

As an alternative to video file playback, WATCHOUT is also capable of playing image sequences.
This is conceptually similar to video file playback, but instead of storing the entire video in single file,
each frame of the video is stored as a separate, numbered file. All the frames making up the video are
then stored together in a folder.

For image sequences, WATCHOUT supports:

Uncompressed 8-bit RGB/RGBA Tiff

Uncompressed 8-bit BGR/BGRA TGA

The TGA (without run-length encoding compression) files yields best playback performance.

Since a sequence of TIFF images is essentially a large number of uncompressed video frames, a very
fast storage subsystem is required. This can be accomplished either using a number of SSDs in a RAID
configuration, or using the increasingly popular PCle-based SSD storage solutions.

For more details on using image sequences, see “Add Proxy”.

AUDIO

In WATCHOUT, audio is used in a way that's very similar to moving images. Simply bring the sound
file into WATCHOUT and place its icon on the display in the Stage window where you want the sound

file to play.

Audio waveform displayed inside cue on timeline.

Audio will normally always play through the production computer, unless explicitly disabled (see “Play
Audio Media”). Audio can also play through a display computer (see “Sound”). To decide which
display computer to use for audio playback use either of the following methods:

® Place the audio icon (corresponding to the cue) inside the frame of a display connected to the rele-
vant computer.

* Select the display or projector associated with the desired computer explicitly inside the audio cue.

Which method to use is specified in the cue used to play the audio file (see “Sound Cue
Specifications”).

AUDIO FILE FORMATS

WATCHOUT can generally play any sound file compatible with Windows Media Player. However,
the recommended sound file format is WAV. There’s usually no reason to use a compressed sound file
format, such as MP3, and the additional decompression step adds unnecessary load. The size of
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uncompressed sound files is usually not an issue with the kind of computers used to play back
WATCHOUT presentations.

MULTI-CHANNEL AUDIO
WATCHOUT can play back multi-channel audio using a suitable sound interface (see “Using Multiple
Sound Channels”). Multi-channel sound files are saved as WAV files using the “Wave Format Extensi-

ble” file format. Some applications capable of saving multi-channel WAV files include Steinberg
Nuendo, Digidesign ProTools and Adobe Audition.

Settings inside the cue allow you to route individual sound channels to their desired outputs (see
“Sound Cue Specifications”).

EMBEDDED AUDIO
Some video files also contain an audio track which means the sound would play from the same dis-
play computer(s) as the video.

NOTE: Using embedded audio is not recommended in WATCHOUT.

If you have a video file with embedded audio, cut the sound track out of the video and place it in a file
of its own. This gives you two media files: one for video and one for audio. The video and the sound
can then be added as separate cues in WATCHOUT. You can position them independently in the
Stage window, allowing the sound track to play through any display computer.

LIVE VIDEO

Live video can be integrated into your presentation. This is particularly useful in speaker support appli-
cations, since it allows you to bring an image of the speaker onto the screen. It can also be used to
play video from DVD or other external video playback devices, or to use video originating from satel-
lite links or video conference feed:s.

Video is brought into WATCHOUT by connecting the video source directly to each display computer
that will show the live video. This minimizes the delay in the video signal — important for speaker sup-
port applications — while maximizing the quality by avoiding compression of the video signal.

From a production viewpoint, you can use the live video image like any other still image or video
played from disk. Simply add the live video object to the Media window and drag it onto the Stage or
timeline from there (see “Add Live Video").

COMPUTER SCREEN

In the same way as you can display a live video feed in your presentation, you can also incorporate a
live image of what appears on a computer’s screen. This can be used to show Excel graphics, Power-
point slides, a Web browser, or similar software applications, as part of your presentation.

The image displayed on the screen of the source computer is sent continuously via the network to the
WATCHOUT display computers, where WATCHOUT composites it with other media. For example,
you can put a plain Powerpoint presentation on top of a large, high-resolution background, thereby
enhancing it with all the high-quality presentation capabilities of WATCHOUT.

The computer to supply the image must have VNC server software installed and configured (see “VNC
Server Software”).

From a production point of view, you use the live computer image just like any other image. Simply
add a Computer Screen object to the Media window and drag it onto the Stage or Timeline from there
(see “Add Computer Screen”).
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USING A COMPUTER VIDEO CAPTURE CARD

Although the VNC-based solution discussed above provides excellent image quality at virtually no
additional cost, it does require a fast computer for running the VNC server software. Even so, it may
not provide full frame-rate, and may hamper the performance of the computer somewhat, since it has
to handle both the VNC server and the application being displayed (for example, Powerpoint).

As an alternative, you could use a hardware capture card to bring the computer’s screen into
WATCHOUT. This solution is essentially identical to the “Live Video” input, described above. How-
ever, it may require a different capture card that can be connected to the source computer instead of a
video camera.

Datapath has an excellent series of capture cards covering most computer signals, as well as tradi-
tional video formats.

http://www.datapath.co.uk/products/video-capture-cards

NETWORK VIDEO

This media type is similar to Live Video, except that video is received via the network rather than using
a capture card. It can be used with network-enabled video cameras and other devices, applications
and services capable of sending video over the network. WATCHOUT supports standard streaming
protocols such as RTP and RTSP and video encoding formats such as H.264 or MPEG-2.

The advantage of this media type is that it requires no additional hardware installed in the computer
and that it adds new kinds of video sources. A possible disadvantage is the noticeable delay incurred
by the network stream processing, making it unsuitable for on-camera speaker display (IMAG), or
other applications calling for low latency.

Assuming that you have such a network streaming source available, it can be incorporated into your
presentation by choosing “Add Network Video” on the Media menu. Specify a name for the source,
such as the name of a network-attached camera.

The media type has basic support for audio in the network streams, note however that the audio may
start playing before the video appears.

Metwork Video x

Mame: |AxisCamera|

Stream: (_) UDP Multicast (@) UDP Unicast () TCP
RT: [rtep:ff192,168.0, 178 /axis-media/media. 3gp

Preview: (@ Live () Thumbnail
Enable WATCHPAX Hardware Acceleration
&pply Frame Blending
Dimensions
Width: | 1230 Height: | 720

a4 Cancel

Stream

Choose whether the data is sent as a multicast or unicast stream. In general, unicast is preferred. Use
multicast only if the video stream will be shown by multiple display computers simultaneously. Most
cameras unicast over UDP. Alternatively, choose TCP if required by the camera.
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URI

Enter the Uniform Resource Identifier of the stream’s source. The details here vary with the camera or
application sending the stream, so you need to consult the device’s documentation. As an example,
an AXIS network camera used the following URI (where the group of digits is the IP address assigned
to the camera):

rtsp://192.168.0.178/axis-media/media.amp

Preview

Select “Live” to see the network video in the Stage window. Generally, use this setting only for initial
testing purposes, or when using a multicast stream (see above). For final playback, you're advised to
use the “Thumbnail” preview mode.

Enable WATCHPAX Hardware Acceleration

Applies only when displaying certain formats, such as H.264, on WATCHPAX. May improve video
playback performance when playing high resolution video. This checkbox has no effect when using
other display computers.

Apply Frame Blending

This setting often results in smoother video playback, at the possible expense of some loss in image
sharpness. This is especially true when the frame-rate of the video is not an even multiple of the display
computer’s frame-rate (for instance, when playing 25 fps video on a display computer set to 60 fps).
This is accomplished by blending adjacent frames together, weighted by their temporal position in the
sequence.

Dimensions
Enter the width and height of the video stream’s image, as dictated by the originating device. In the
example above, this is the native resolution of the video camera.

NDI VIDEO

Although NDI® (NewTek’s Network Device Interface technology) is similar to Network Video in that
the video stream is received over the network, there are enough differences to make it its own media

type in WATCHOUT.

NDI video streams are identified by a name, which usually consists of a stream name and the name of
the sending device, for example “Studio10 (BackupComputer)”. To preserve network bandwidth, the
video streams are compressed using compression techniques which are part of NDI, and not gener-
ally compatible with any other types of video compression.

The compression used is lossy, like h264 and HAP, which means that there is some quality loss when
using NDI. However, in almost all cases the loss is so small that it is not noticeable. One very import-
ant feature of the compression used in NDl is that it has no generation loss, meaning that you may
compress and uncompress a video stream an infinite number of times, without any further loss of

quality.

Assuming that there is an NDI source on the local network that you wish to incorporate into a
WATCHOUT show, choose “Add NDI Video” from the Media menu. The dialog that appears lets you

configure WATCHOUT for receipt, as shown below.
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x|
MName: |Test Pattern
NDI™ Stream Name: | DEMO192 (Test Pattern) -l
Alternate NDI™ Stream Name: | DEMOO0OS (Test Pattern Backup) :_|
Pixel Format: IYUW (no alpha) ﬂ
Optimise for: |Low Latency L]

Preview:  Live Video ¢ Thumbnail
¥ Apply Frame Blending

~ Dimensions:
Width: | Height: | 1080

MNDI™ is a trademark of NewTek, Inc.
http: //NDI.NewTek.com

OK I Cancel

Name
The name of the source as it will appear in WATCHOUT's user interface.

NDI® stream name
The name of the NDI stream you want to incorporate into the show. Select one from the list of all NDI
sources that are visible on the local network. Alternatively, type in the name of the source.

Alternate NDI stream name

This is meant for specifying a backup NDI source. If the primary source fails, WATCHOUT will auto-
matically switch to the alternate source. As soon as the primary source is back online, WATCHOUT
will switch back. Using an alternate stream is optional.

Pixel format

This option gives the sender a hint of which pixel format is preferred by the receiver. The NDI sender is
free to ignore this request. The default is YUVY, which gives the best compression and uses less band-
width than BGRA. There is no support for an alpha channel in YUVY. If you need alpha, please use
BGRA instead, but remember that the sender is free to ignore this request. BGRA uses more band-
width, so YUVY is preferred at all times when there is no need for an alpha-channel.

Optimise for

There are three options here: Low Latency, Balanced and Smooth Playback. For Low latency,
WATCHOUT keeps no queue of received frames. The frame displayed is always the latest frame
received. This mode is sensitive to network hiccups, since if the continuous stream of frames is dis-
rupted, WATCHOUT will have no new frame to display, resulting in the video freezing for a short
amount of time. The Balanced mode keeps a short queue of frames for display. This increases the
latency somewhat, but also makes the system less sensitive to network issues. Lastly, the Smooth Play-
back option keeps a larger queue of frames, which makes WATCHOUT even less sensitive to network
issues, while increasing the latency further.

Preview
If Live Video is chosen, the video stream will be visible in the Stage window, for preview purposes. For
the preview, a low-bandwidth (lower quality and lower resolution) stream is used, to preserve

bandwidth.

MEDIA 120



Apply Frame Blending

If the display rate does not match the NDI stream rate, this option can be checked for smoother play-
back. As with any video media, frame blending will make the playback smoother, at the possible
expense of a slightly blurrier appearance.

Dimensions

This is the size of the stream as it will be displayed by WATCHOUT. This resolution is also sent as a
hint to the sender, which is free to ignore the request. If the resolution received is different, the frames
will automatically be scaled to fit.

AUDIO

There is currently no support for NDI audio streams.

NDI-HX

Some NDI senders use a modified compression algorithm for enabling NDI to be used over Wifi and
low-bandwidth connections. To use NDI-HX, the NDI-HX driver needs to be installed on all computers
that will display the stream. This is available as an option in the WATCHOUT installer, or it may be
downloaded from http://ndi.newtek.com. In most cases there is no need to install this driver, as most
streams are not HX-streams. NDI-HX uses less bandwidth, at the expense of more complex compres-
sion. Please bear in mind that many of the hardware boxes sending out NDI-HX are quite limited in
processing power, and may not be able to deliver the stream to more than a few display servers simul-
taneously. This is not a limitation in WATCHOUT, but rather a limitation of the sender.

For Dataton media servers, the NDI HX driver will be installed when upgrading the WATCHOUT
version by going online in the production software if — and only if — the NDI HX driver is installed on
the production computer.

MULTICAST

To reduce the bandwidth requirements, many senders can be configured to use multicast, which
means that only a single copy of the stream will exist on the network, and this stream will be received
by all media servers that display the stream. For multicast to function properly, it is absolutely essential
to use high quality network infrastructure. Use smart switches, and configure them to enable IGMP
snooping for best results. Always try to keep the number of servers and devices connected to the net-
work as low as possible and, preferably, use one switch with many ports instead of several smaller
switches.

If not using multicast, one unique copy of the stream will be sent to each display server showing the
stream. This can increase the network load dramatically.

DYNAMIC IMAGES

The WATCHOUT Dynamic Image Server allows you to incorporate dynamic data into your presenta-
tion, such as:

e Still images that can be updated live by simply dropping a new image into a folder.
® Graphs obtained from databases or other sources.

e Up-to-the-minute news, available from online providers such as CNN.

* Live stock quotes.

* Desktop capture.

To use dynamic content in your presentation:
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* Make sure the WATCHOUT Dynamic Image Server is running on a computer accessible from your
display computers via the network.

* Provide content for the image server in the form of still images, HTML web pages or Flash (SWF)
files, or by allowing the Dynamic Image Server to obtain such content from the Internet (may require
additional network setup and configuration)

® Choose “Add Dynamic Image” on the Media menu to add the corresponding media item to your
presentation (see “Add Dynamic Image”).

* Drag the media item onto the Stage or Timeline to make it appear on screen.

Please refer to the chapter titled “Dynamic Images” for more details on how to use this feature.

3D MODELS

3D models can be incorporated into your presentation in much the same way as images and video.
However, as many 3D file formats only contain the geometric shape of the object, and not its other
attributes, a two-step process is involved:

* Drag the 3D model into WATCHOUT. It appears as a white, or multi-colored, object without any
clearly distinguishable features.

e Apply images or video to the texturable areas of the 3D object to make it come alive.

The first step is accomplished by dragging a 3D model file into WATCHOUT. WATCHOUT accepts the
following common 3D file formats:

e 3DS (3D Studio Max)

e OBJ (Wavefront).

e DAE/Collada.

e BLEND (Blender).

e FBX (Autodesk Filmbox).

NOTE: Due to the wide variety of dialects used in 3D files, some files may not import properly or at

all. I so, try exporting your 3D model in a compatible format from your 3D application. Formats that
are likely to work consistently are 3DS and OBJ.
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Main Timeline

0:45.376

[> LAYERT

[> LAYER 6

M~ 1 AWECn C

A 3D model of a human figure just brought into WATCHOUT, but not yet textured.

IMPORTANT: Models brought into WATCHOUT must have texture coordinates (also known as UV

OFF LINE

Human.jds

coordinates) assigned in the 3D application beforehand. This is necessary in order to subsequently

apply the texture images correctly.

Many 3D file formats don't use real world dimensions. Instead they use their own, internal “units” to
define size and distance. Hence, when bringing 3D models into WATCHOUT, the model’s units must

be interpreted into Stage pixels. You can control how this interpretation is handled in the Specifica-

tions dialog box associated with the 3D Model in the Media window. This also allows you to control

where the anchor position used for scaling and rotation is located within the model.

30 Model

Model File

Anchor Position:

Size:

Flip Texture:

. | 3D/ Car fCarProjBodyWWheelind. 3ds

(® Model Crige () Model Center

(®) Scale To Size:

px

() Scale By Factor:

-

| Ry (Pt

[ ]Horizontally (U) [ ] vertically (W)

Ok

Browse...

Cancel

s

Specifications dialog box of a 3D model.
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Anchor Position

Controls where WATCHOUT's anchor point appears within the model. By default, it will be positioned
atthe X/Y/Z zero point (origo) of the imported model. However, in some cases, the model may not
have been positioned properly before it was exported, and the anchor position may be way off. Then
you can choose “Model Center” to position the anchor point in the center of the model instead. Alter-
natively, re-open the model in a 3D program and move it o its desired location.

Scale to Size

Scales the 3D model ensuring it will have the specified number of pixels along its longest axis. This is
good default behavior since it avoids models being interpreted either as extremely small (often smaller
than a single pixel) or extremely large. Simply type in the desired size, in pixels.

Scale by Factor

When bringing in multiple models, all originating from the same 3D application, you may instead
want them to maintain their relative size from the 3D application. This is hard to do when scaling them
all individually, each to its own pixel size. In this case, it is better to apply a fixed and known scale
factor to all objects. You can do this by importing the main object first, and scaling it as desired using
the “Scale to Size” option. Then read out the scale factor, and subsequently apply the same factor to
all objects, selecting “Scale by Factor” instead.

HINT: By setting all 3D objects in a scene to “Scale by Factor” and “Model Origo”, you can combine
multiple models while maintaining their position and size from the source 3D application. Simply
place all objects at the same stage position, as specified inside the cue. Since they all will have the
same origo and scale factor, everything will end up in its proper place.

Flip Texture

When you apply textures to a 3D object (see “Texturing” below), the placement of the image on the
3D object is controlled by texture coordinates embedded in the 3D model file. Different 3D applica-
tions use different standards for the direction of these texture coordinates. If the texture, when applied
to the object, appears reversed or scrambled, try the “Flip Texture Horizontally” or “Vertically” check-
boxes to see whether doing so corrects the problem. If not, you may need to go back into the 3D
application and try out the image to be used as a texture there, to make sure it really matches the
model and its texture coordinates.

TEXTURING

To give the model its texture and make it visible on displays, you must apply an image to it. This can
be done in a variety of ways, with each method offering an increasing amount of flexibility.

e Using a still image. This applies the same texture throughout the entire cue. Useful for static 3D
content.

e Using a video. The video starts playing at the beginning of the cue, but gives you no control over
how it plays (for instance, looping or free-running).

® Using a Virtual Display. This provides the full compositing capabilities of WATCHOUT, allowing you
to build the texture from multiple layers of still images, video, etc.

To apply a texture to a 3D object, first select its cue on the timeline, then drag the image, video or
virtual display onto the 3D object’s preview image in the Stage window.
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A still image applied as a texture to the human figure.

IMPORTANT: The cue associated with the 3D object must be selected in order to drop a texture onto
the object in the Stage window. This is also indicated by a purple selection box around the 3D object,
as shown in the Stage window above. When dragging from the Media window, reveal the image to
be used as a texture in the Media window first, before selecting the cue. Then drag the image from the
Media window onto the 3D preview in the Stage window with a single drag-and-drop operation.

See this video for more details on how to bringing in 3D models and applying basic textures:

https://www.dataton.com/academy-video-watchout-6-3d-basics
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Using Multiple Textures

Some 3D obijects have multiple texturable areas. If so, those are indicated by different colors in the
Stage window.

OFF LINE

Main Timeline b 4
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Parts of a 3D model that can be textured separately are indicated by different colors in
the Stage window.

To texture such an object, drop a separate texture onto each texturable area, replacing the solid color
shown initially. See this video for more details on texturing multiple areas.

https://www.dataton.com/academy-video-watchout-6-3d-texturing

To see the list of textures applied to a model, open the cue’s dialog box and select the “Textures” tab.
Here you can also select and delete individual textures. You don't have to delete a texture in order to
replace it. Just select the cue and drop a new texture onto the desired area to replace the previous
one. However, explicitly deleting textures often makes it easier to see where any separately texturable
areas are, due to the distinctive coloring of such areas.

Texturing with Virtual Displays

For maximum flexibility, use a Virtual Display to texture a 3D object. This indirect method gives you
access to all the rendering, tweening and compositing capabilities of WATCHOUT in order to create
textures. You can even incorporate dynamic content, such as live video or interactivity into the texture
before applying it to the 3D object. See “Virtual Display” for more details on how to use this method.
This video shows you this advanced technique in action:

https://www.dataton.com/academy-video-watchout-6-3d-texturing-using-virtual-displays
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SOLID

When all you need is a flat, colored background, create a Solid using the “Add Solid” command,
rather than creating a rectangle in Photoshop.

Solid X

Mame: [Sguarel100

Width: | 100 Height: | 100

(8] 4 Cancel

A 100 by 100 pixel solid white rectangle.

HINT: While the basic color of a Solid is always white, you can use a Color tween track to colorize it.

TEXT

This media type makes it easy to add headings and other texts to your WATCHOUT show without
having to use an external program, such as Adobe Photoshop. To add a text to your presentation,
choose “Add Text” on the Media menu, enter your text in the checkerboard area and click OK.

Text =
i v|[ ]2 vixr v]BOzO|se@=0=0=0|"gc |F = |52 FHa 5 e 5| =0ED
Text Styles

Width: px. | Style: | <Mone > ~ ! [ Auto Refresh Optimize For: (@) Better Performance

Margin:| 0 e | % | Reset Text | Set Style ! Refresh (O More Effects and Capabiities

I oK || Cancel i

To display the resulting text, drag it onto a timeline and position it on stage. The text is shown on a
transparent background and is used like a still image. As the text is rendered on the production com-
puter, you don’t need to have the fonts installed on your display computers. To change the text, dou-
ble-click it in the Media window or Alt-double-click the cue.

Width

Specifies the width of the resulting text image, in pixels. The height will be determined automatically
by the amount and format of the text.
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Font menu

Choose any font installed on your production computer and apply it to the selected text. Note that you
must select some text before you can apply a new font. The same goes for most other settings, as they
apply on a percharacter basis.

Text Color
The color swatch next to the Font menu specifies the color of the text. Again, first select some text then
click the button to choose a color.

Font Size and Scale Factor

This menu, in conjunction with the scale factor, determines the size of the text as dis- 7 <HL -
played in your presentation. For small to medium-sized text, keep the scale factor set to

1 and adjust the font size. For very large text, use the scale factor to scale the rendered

text while keeping the edited text at a manageable size. The scale factor also governs

other dimensions, such as the size of any drop shadow, but does not apply to the Width

sefting.

Bold and ltalics
These checkboxes apply the corresponding styles to the selected text.

Text Alignment

The alignment radio buttons align paragraphs to the left, center, right or justified
on both sides. Although adjusted text isn’t shown as such in the dialog box, the
rendered text will be adjusted.

Text Indentation
The Indent and Hanging Indent settings indent the selected text by the specified =g
amount. Note that these settings apply to entire paragraphs.

al[w
il
]
o
»

Leading and Paragraph Spacing
These fields control the spacing of lines and paragraphs in the selected text. Use =
negative numbers to tighten the spacing.

4[|k

[HI

Bullets and Numbering

These checkboxes display a bullet or a paragraph count in front of each selected paro-
graph. Use the Hanging Indent setting to control the distance between this embellishment
and the text itself.

B

Margin
Adds additional spacing on both sides of the text, as a percentage of the font size. This may be
required to account for certain italicized fonts.

Style

Chooses a common text style, as defined under the Style tab (see “Style”).

Reset Text
Resets the text, removing any local overrides, so it matches the style selected on the Style menu.

Set Style
Updates the style selected on the Style menu to match the currently selected text. Doing so affects alll
texts using this style.
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Update and Auto Update

Click “Update” to see the result of your changes in the Stage window (assuming the text being edited
is currently displayed). If you select the “Auto Update” checkbox, the stage will automatically update
whenever you make changes. This may be time-consuming when rendering large texts — especially
when also applying effects.

Optimize For...
This setting serves the same purpose as for still images, and has the same restrictions (see “Optimize

For”).

STYLE

You may define text settings that can subsequently be applied across several Text media items, thus
maintaining a consistent style throughout your presentation. To define a style, click the Styles tab in
any Text media item.

Text »
Sk “ W[ VK VB0 z0/se=0=0=0|"20 JF=b |FEo HI[r E|E=
Text  Styles
Styles: Preview:
Heading 1
Add Delete Copy Paste
gk ighe: [Jorop shadow Distance: 10 2 px. | []Emboss  width: S S oo
[#] Use global angle | OPadty: Blur: 5 * px. | Strength:
Cancel

A non-editable preview text is displayed in the checkerboard area of the window. If you have typed
anything into the Text media item, that text will be used for the preview. Otherwise, a default text sam-

ple is shown.

Change any of the settings (Font, Size, Color, etc) using the controls along the top of the window. The
preview area shows the result. Style settings apply to the entire text, so you don’t need to select any-
thing before changing settings.

Add/Delete Style
Click Add to create a new, named style based on the current settings, then enter a style name. To
delete a style, first select it in the list, then click Delete.
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Text Effects

Use the controls along the bottom of the window to add a drop shadow and emboss effect to the ren-
dered text. Your settings here are reflected in the preview area of the Styles tab, but do not appear in
the main editing area of the Text tab.

Styles: Preview:
Heading 1
Add Delete Copy Paste
Light Angle: . [“] Drop Shadow Dismnce:: px. | []Emboss 'n.-'u'iclﬂw:: px.
[] Use global angle | OPadty: ' B|LIF:E| + px. | Strength: '

A text style with Emboss and Drop Shadow effects applied.

NOTE: Applying a drop shadow effect renders the image slightly wider than the specified Width
setting. This is in order to accommodate the shadow without causing the text to re-flow.

Light Angle

Controls the perceived angle of light expressed by the emboss and drop shadow effects. Setting the
light angle to be from the top left causes the drop shadow to appear below and to the right of the text.
Select “Use global angle” to use a common angle across all styles with this option selected, or
uncheck this checkbox to set the angle independently for the current style.

Applying a Style
Once a style has been defined in this way, you can apply it using the Style menu on the Text tab. Note
that local overrides applied to the text take precedence over style settings. Click the “Reset Text” button

to remove all local overrides, setting all the text according to its style.

Transferring Styles Between Shows
Use the Copy button to copy selected styles to the clipboard. You can then paste those styles into
another show.

DMX-512 RECORDING

WATCHOUT can control individual lighting channels directly (see “DMX Output”). However, when
using numerous lighting channels, or moving lights, a dedicated lighting console is generally
required. To simplify your playback system, you can record the data from the console into
WATCHOUT, then remove the console and use WATCHOUT to play back the lighting control. Assum-
ing that you have a lighting console connected to your network using the Arinet protocol, you can
record its programming by choosing “Add DMX512 Recording” on the Media menu.
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@ Save DMX512 File As X

Savei_n:| DM V| €] Y = M~

H Mame Date modified Type

Mo itermns match your search.
Cluick access

Desktop
@ < >
Ne‘u:;.ru:urk File name: |C|:unscule Seql e | | Save
Save as type: .dme files (*.dmoe) ~ Cancel

-

Record DMX512 Data from Universe: | B =

Enter a file name for storing the recorded DMX512 data. Save this file in/under the
folder containing the current show file. Specify the Artnet Universe number used by the
lighting console. Only data sent on this universe will be recorded.

NOTE: If your lighting console doesn’t support Artnet directly, this requires a DMX512-to-Artnet
adapter. See “DMX-512 Input” for more details.

Once you've added the “DMX512 Recording” to the Media window, proceed as follows:

* Drag this new item from the Media window onto a timeline. Note that the cue says “To be
recorded”, indicating that data will be recorded when the cue is run. Place this cue where you want
the recording to start, and extend it to cover the duration of the recording.

* Run the timeline along with the lighting console. You may simply start WATCHOUT and cue the
console manually. Alternatively, use timecode to synchronize them.

* As the timeline reaches the cue, recording commences, as indicated by the RECORDING text in the
cue. Allow the timeline to run for the entire duration of the cue.

® Once recording is complete, the RECORDING text in the cue disappears.
* Disconnect the lighting console from the network, or switch it off.

Play the WATCHOUT timeline again. The recorded DMX512 data will now be played back by the
cue. An Artnetto-DMX512 adapter is required unless your fixtures/dimmers accept Artnet directly.

You can use the Fade tween track of the cue to modulate the intensity of the recorded channels, if
desired.

NOTE: Do not use the Fade tween track if any recorded channels use 16-bit precision — often used by
moving lights and similar devices.

Ifyou make a mistake during the recording, or DMX512 Recording %
simply want to do another take, you can reset

"rhe ref:ordmg to its |n.|’r|o| state by doub|e—c||ck- OMX File: | DMX/ConsoleSeqL.dmx cromse..
ing it in the Media window and selecting the —

“Re-record DMX512 File” checkbox. This [IRe-record DMX5 12 File

dialog box also lets you play the recording [JOverride ArtMet universe: 2 =

back using a different Artnet universe than the

one recorded. ok Cancel
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/. CUES

Cues are the primary active objects in WATCHOUT. They control when media appear on stage, as
well as more dynamic behavior such as positioning and opacity. Cues exist on layers in timeline win-
dows. The layers determine the stacking order of media on stage.

A cue also contains any associated animations. Those are managed by “tween tracks”, appearing in
the lower part of the timeline window when the cue is selected (see “Tween Tracks” later in this
chapter).

Main Timeline b4
0:36.882
% LAYER 10

o O

gl WATCHOIIT
: E""'? ;ﬁ_t":ﬁ It -

> Position

% Bcale

Q<P Q
Cues in the timeline window (top), with tween tracks of the selected cue below.

ADDING CUES

To add a cue to a layer in a timeline window, drag a Media window item, or a media file, to the layer
or the Stage window. Media files can be dragged directly from your hard disk.

IMPORTANT: Whenever possible, keep all media used in a presentation in a sub-folder of the folder
containing the show file. Doing so allows WATCHOUT to refer to the file using a relative path specifi-
cation, making it easier to move the presentation with all its media references intact.

When you drag media into the Stage window, the cue will appear on the currently selected layer (as
indicated by a purple line under the layer’s name) and at the current time position. When dragging
into the timeline, the cue appears at the layer and time you drag it to.

SELECTING AND POSITIONING CUES

Click a cue to select it. Shift-click to select multiple cues. Alternatively, drag from a point outside all
cues to use the selection rectangle. Use “Select All” on the Edit menu to select all cues on all layers. To
de-select all cues, click in the white space of any layer in the Timeline window.

You can also select a cue by clicking its preview image in the Stage window. This allows you to deter-
mine which cue corresponds to a particular image on stage.

To position selected cues, drag them using the mouse. To drag cues to another layer without altering
their time positions, press the Shift key while dragging.
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If you want to position a cue numerically, cut it, go to the desired time position using the Timeline Set-
tings dialog box (see “Timeline Settings”), then paste it. Alternatively, use the cue’s dialog box (see
“Cue Specifications”).

SELECTING CUES USING THE ARROW KEYS

Press the right or left arrow keys on the keyboard to select the next or previous cue on the layer that is
currently selected. Pressing the Shift key as well selects the next or previous cue on any layer. Pressing
the up and down arrow keys changes the currently selected layer.

CUTTING, PASTING AND DELETING CUES

Use Cut, Copy and Paste on the Edit menu to move or copy cues within a presentation or to other
presentations via the clipboard. When transferring cues to other presentations in this way, any media
associated with those cues will automatically be added to the target presentation.

To delete cues without altering the content of the clipboard, select the cues then choose “Clear” on the
Edit menu.

CHANGING A CUE’S MEDIA POSITION ON STAGE
Cues contain information on where the media will appear on stage. To change the stage position, do
one of the following:

* Drag the preview image in the Stage window. You can change the stage position of multiple cues at
the same time by first selecting those cues.

® For precise adjustments press Control-arrow. Add the Shift key for greater increments.

® Double-click a cue and change its “Initial Stage Position”. If the cue has a Position tween track, this
will relocate the entire motion path.

* Double-click one of the cue’s Position tween points.

IMPORTANT: If a cue has a Position tween track, click the desired tween point to go to its time before
moving the image using the mouse or the arrow keys. If the timeline isn't positioned exactly at the
tween point, a new point will be added. This assumes “Click Jumps to Time” is selected on the Timeline
menu.

HINT: You can move the stage position of multiple cues using the Move command (see “Move”). This
is particularly useful when merging cues from shows having different display positions.

The stage position of the anchor point is shown numerically in its Position tween track, if any (see
“Position”).

CHANGING A CUE’S DURATION
To change the duration of selected cues, drag the bar at either end of a

cue. If the cue has tween points, they will remain stationary in relation to ‘ Ballt.psd
the timeline. To stretch the tween points with the cue, press the Alt key

while dragging the end of the cue.

HINT: Either end of the cue will snap to the current time position if “Snap” is selected. For this to work,
you must first deselect “Click Jumps to Time” on the Timeline menu.
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To set the duration precisely, type the desired duration into the cue’s dialog box (see “Cue Specifica-
tions”). To change the duration of multiple cues by a specific amount of time, use the “Insert/Delete

Time” command.

NOTE: If you extend the duration of a movie beyond its actual length, it will stop by default at the last
frame. Alternatively, you can make the movie run repeatedly in a loop by choosing the “Loop” behav-

ior in the cue (see “Looping”).

REPLACING A CUE’S MEDIA

To change the media associated with a cue, drag new media onto the cue. You can either drag an

item from the Media window, or a new media file from your hard disk.

HINT: If you want to replace all instances of a certain media file, you can change the file association
of the item in the Media window instead (see “Image Specifications”). Doing so will affect all cues
associated with that media item.

CUE SPECIFICATIONS

Specifies the settings of the current cue. The options available vary with the kind of media that is con-
trolled by the cue. To open a cue's specifications dialog box, select the cue and choose “Specifica-

tions” on the Edit menu, or simply double-click the cue.

The time when the media will —
appear on stage.

Starting offset into sound or
video.

Stage position of anchor
point at the start of the cue.

Position of anchor point
within image, relative to
image’s top left corner.

Video Cue

Basic  Advanced

Time:

Duration: | 1:09.467

Pre-Roll: 0.0

In-Time:
cue Color: | i Reset

Media: Locate Media

Automatic

Initial Stage Position:

WaterVideoSmall. mp4

— X: | 2280 | ¥ | 125 |2:[ 0
Anchor Position within Image:

— x:[1920 | ¥: | 1080 |z:|0
Set To: Top Left Center

QK

Cancel

IN-TIME

Shows how long the media
remains visible on stage.

Media will be pre-rolled auto-
matically (uncheck to specify
pre-roll time manually).

Locates associated item in the
Media window.

Sets the top-left or center
position for anchor point.

Specifies a starting offset for a sound or movie. For example, a certain movie may have ten seconds of

black at the beginning. To skip those ten seconds, set the in-time to 10.
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ANCHOR POSITION

Determines the position of the image anchor, relative to the upper left corner of the image. The anchor
of a selected cue is displayed as a crossed circle in the Stage window. When scaling or rotating an
image, the anchor specifies the point that remains stationary.

HINT: A checkbox in the Preferences dialog box determines the initial position of the anchor point for
new cues (see “Center Anchor Position”).

INITIAL STAGE POSITION

If the cue does not have a Position tween track, this Initial Stage Position controls its media position on
stage. Otherwise, this is the position of the first tween point. Changing this position moves the entire
motion path, if any.

HINT: To move the position and motion paths of a set of cues, first select the cues, then choose Move
on the Edit menu.

LOCATE MEDIA
Locates the associated item in the Media window, automatically opening any enclosing folder.

HINT: Double-clicking a cue on a timeline while pressing the Alt key opens its associated media item.
This shortcut is particularly handy when you want to open a Composition associated with a cue, as it
allows you to go straight from the cue into the Composition.

PRE-ROLL

Some cues need to be pre-loaded and prepared a few seconds ahead of their appearance. When set
to “Automatic”, this time is calculated automatically. This is the preferred setting in most cases. How-
ever, certain media files may require extensive computer resources when prepared. This may have an
adverse effect on already visible, moving media. Although this is unavoidable, you may be able to
reduce the impact by moving the moment when the preparation occurs backwards to a more appro-
priate time.

When specifying the pre-roll time manually, a pre-roll indicator appears in the timeline window. Adjust
the pre-roll time by dragging the start of this indicator.

Main Timeline -4
0:46.800
[> LAYER 10

% LAYER 9
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Pre-roll indicator. Drag to
change pre-roll time.

CUE COLOR

Displays the current color of the cue. Clicking the color indicator brings up a color selection dialog in
which a new color for the cue can be chosen. To reset a cue to the default color of the cue type, click

the Reset button. For more information about default colors of cue types, see the “Cue Colors” tab in

the preferences window.
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ADVANCED CUE SPECIFICATIONS

To adjust additional settings of the cue, open its dialog box then select the “Advanced” tab. Some
options apply only to specific media types.

Video Cue >

Basic Advanced Output Channel Assignments

Sehavior: || Free Running
[JLooping

Maybadk Speed: | 100 | %

Staddng: Default o

Blend Mode: Normal v
Freview: Best Quabty v
Masked by Layer Above: | Off o

[ suppress Rendering (for use a5 Mask anly)

[ Awto-orient along Mation Fath

Forvward Mation Direction: X+

[Jusa anchor Position as Local Vanishing Paint

[l External Contral of Position, Scale & Rotation

Tradang Mame:

Interachon Namea:

FREE RUNNING

Causes sound, movie or composition media to continue playing even if the timeline is paused. This is
particularly useful in speaker support or conference situations, where you may be cueing the timeline
manually. While waiting at a pause cue, you may still want to have something moving on stage.

HINT: Free Running and Looping behavior can be combined to create continuous playback of unde-
termined duration.

LOOPING
Causes sound or movie media to loop (re-start repeatedly) when played past its duration. This is par-
ticularly useful for short, cyclical animations, where the movie then contains only a single cycle.

NOTE: To see the effect of this behavior, the duration of the cue must be extended past the media’s
natural duration, or made free-running.

PLAYBACK SPEED

When set to 100%, video plays at its normal frame-rate. Set to a smaller value to slow down the
video. Enable “Frame Blending” inside the video media object to make video that has been slowed
down play smoother (see “Apply Frame Blending”).

NOTE: Audio embedded in the video will not play properly unless set to 100%.
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STACKING

When using WATCHOUT iin its traditional 2D mode, images originating from higher timeline layers
cover images from lower layers. This is the behavior obtained when choosing “By Layer”. However,
when positioning and moving images along the Z axis (towards or away from the viewer), you may
want images closer to the viewer to always appear in front of more distant objects. In many cases, this
can be accomplished by placing the cues onto layers in a matching order, which is the preferable
solution. When this is not possible, choose “By Z-Depth” instead, to make images with lower Z posi-
tion appear in front of images with higher Z position.

NOTE: Images with transparent or semi-transparent areas may not blend with other objects as
expected when using “By Z-Depth”. If so, re-arrange the cues onto layers in the desired frontto-back
order.

The “Default” option is identical to “By Layers” for cues on the Main Timeline or Auxiliary timelines.
For cues in compositions, this setting makes images inherit the corresponding setting of the cue that
plays the composition.

PREVIEW

Controls the maximum Stage window preview quality. Set to “Reduced” to preview the image using its
thumbnail. Set to “None” to suppress preview altogether. When set to anything besides “Best Qual-
ity”, the name of the cue is shown in italics to indicate this. Reduce this setting if previewing this cue
adversely affects the performance of your production computer.

NOTE: The preview quality is ultimately constrained by the setting on the Preview menu (see “Preview
Quality”). The cue setting specifies the maximum quality by which the cue will be previewed.

BLEND MODE

These options control how the image interacts with other images that it overlaps on stage. They
perform similar to those with the same name in applications such as Adobe Photoshop.

* Normal makes the top image completely cover the bottom image (unless it has transparent areas
or opacity applied).

e Add results in a very bright image, suitable for adding highlights to other images. Black areas in
the overlapping image have no effect. See video.

e Multiply results in a darkened image. White areas in the overlapping image have no effect. See
video.

e Screen is similar to Add, but softer and often produces a more pleasant effect. See video.
e Lighten keeps the lightest parts of the images.
» Darken keeps the darkest parts of the images

e Linear Burn is similar to the Multiple mode, but produces a more intense result.

MASKED BY LAYER ABOVE

Allows you to use one image or video as a mask for another one. The image to be used as a mask
must be placed on the layer immediately above the one to be masked. If the mask image has an alpha
channel, choose the “Alpha Mask” mode. Otherwise chose “Luma Mask” to use the brightness of the
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image to create the mask. Choose the “Inverted” version of each mask mode to reverse the mask.
Masking is indicated by red dots running along the top of the masked cue.

Mask image, with
“Suppress Rendering”
selected.
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See these videos for more examples on how to use masks:

Masking: https://vimeo.com/134593900

Masking & custom wipes: https://vimeo.com/134594128

Masking with a video clip: https://vimeo.com/ 134594127
Combining masking with other effects: https://vimeo.com/134593%01

SUPPRESS RENDERING
When using an image as a mask, you often don’t want the image itself to be rendered — only its mask-
ing effect. To accomplish that, select this checkbox in the cue that controls the image used as a mask.

NOTE: Select “Masked by Layer Above” in the cue of the image being masked, and select “Suppress
Rendering” in the cue of the image being used as a mask.

When this option is selected, the cue’s name is shown in italics.

AUTO-ORIENT ALONG MOTION PATH

Causes an image or 3D model to rotate according to its motion direction Y-
at any given time. This is useful when animating an object that should Z+
always point along the path of motion, such as an airplane. 7>

The “Forward Motion Direction” options control the orientation of the X- <::| Image |jl> X+
image as it moves along the motion path. Choose the direction you want

to be considered forward, with the default value being the right edge of

the image (X+). Z- @

Y+

NOTE: In some cases you may also need to apply Rotation to the image
to make it point in the desired direction.

See these videos for more on animations:
Using animations, part 1: https://vimeo.com/134593525
Using animations, part 2: https://vimeo.com/134593526

USE ANCHOR POSITION AS VANISHING POINT
When positioning 3D models or rotating images in 3D space, a perspective must be applied to
achieve the proper result on a flat screen. This perspective must assume a particular vantage point.
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The far side of this point is called the vanishing point. The default vanishing point used in your
WATCHOUT scene is set in the Preferences dialog box (see “3D Perspective and Stereoscopy”).

However, in some cases you may want to handle multiple, more or less independent, displays as a
single WATCHOUT show. Those displays may not make up a single image canvas, but several image
areas, where each should appear on its own. In this case, applying a single vanishing point to all
these displays doesn’t make sense, and will make X/Y axis rotations and 3D objects on those displays
appear incorrect and distorted.

To manage such cases, you can do either of the following:

* Select “Use Anchor Position as Vanishing point” in each cue related to that display. This method is
suitable if there’s a small number of cues.

® Put all cues for that display in a Composition, and select “Use Anchor Position as Vanishing point”
in the cue that displays this composition.

® Use a 3D Mapping Projector instead of a 2D Display to produce the image for the display. In this
case, no special setting is required, since each 3D Projector manages its own perspective, indepen-
dent of the global vanishing point setting.

In the first two cases, you must also locate the anchor point in the cue as desired, since it will control
the vanishing point.

NOTE: This checkbox applies only for 2D and Virtual displays. It doesn’t apply for 3D Projectors,
which manage their own perspective based on their position and target point.

EXTERNAL CONTROL OF POSITION, ROTATION AND SCALE

Usually, you control media cue position, rotation and scaling using the corresponding tween tracks
alone. However, you may occasionally want to control these parameters from an external source,
such as a MIDI, tracking, DMX input, or via the network (see “setlnput”). Select this checkbox to allow
for such external control. Add the desired tween track and use its formula button to assign the control
source fo the desired parameters (see “External Control of Tween Tracks”). Alternatively, a “Tracking
Name” may be specified to allow a Tracking Input to control the position and rotation of a media cue,
see “Tracking Input” in the chapter titled “10. Inputs and Outputs”.

NOTE: The positional data received via a Tracking Input will be relative to a media cue’s anchor
position.

NOTE: For still images, this option is only available when the image is set to be optimized for “More
Effects and Capabilities” (see “Optimize For”).

IMPORTANT: Selecting this option increases the load on all your display computers. Do not choose
this option unless necessary.

INTERACTION NAME
This value is only used by the hitTest command (see “hitTest”).

TEXTURE
These settings apply only to 3D model cues.

Render

Surfaces on a 3D model have two sides: an outside and an Texture:
inside. For a closed 3D model, such as a sphere, you normally ~ Render: (O outside (Oinside @) Both

Extension: |Repeat Image Side by Side o
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see just the outside. For other more complex models, you may see both the outside and inside. What's
considered “outside” is controlled by the 3D model itself, and can be edited in a 3D application by
altering the “normals” of the model.

When applying a texture to a 3D model in WATCHOUT, it may appear on the outside, the inside or
both sides (default). If you prefer not to see the texture on the inside of the model, select “Outside”, or
vice versa.

Extension

Usually, a 3D model is designed to have a texture spanning its surface exactly. This is defined inside
the 3D model by keeping its texture space (UV coordinates) within a O4to-1 range. Some 3D models,
however, may have one or many areas where the texture space extends outside this range. If so, the
settings on the “Extension” menu determine what's to happen outside this range.

Repeat Image Side by Side. The texture you apply will be shown repeatedly, side by side, for as
large a range as required. For instance, if the texture range in the 3D model is five wide by five tall,
25 copies of the texture will be shown in a 5-by-5 arrangement.

Repeat by Mirroring Even Copies. This option is similar to the previous one, but will cause cop-
ies at even positions in the grid to be mirrored or flipped. This works better with some textures to cre-
ate a more seamless look.

Extend image edge pixels. In this mode, texture coordinates that fall outside the O...1 range will
be filled with whatever color is at the closest edge in the texture you provide.

Texture Tab

This tab lists the names of all textures currently applied to the model.
Select a texture in the list and press the “Delete Texture” button to
remove it from the model. Doing so replaces the texture with a solid %ﬂlﬁﬁi_
color, allowing you to see the extent of a separately texturable area | Gakzg1 psd

inside a model. Select multiple textures in the list by Shift- or
Control-clicking.

Basic = Advanced Textures

Delete Texture

NOTE: You don’t need to delete a texture in order to replace it.

Simply drop a new image in its place while the cue is selected.
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SOUND CUE SPECIFICATIONS

Cues specific to sound media share many of the basic settings with images and video, as under “Cue
Specifications”. They also have some settings that are unique to sound playback.

Sound Cue X

Basic  Qutput Channel Assignments
Time:

Duration: |4:EI'3. | |

Pre-Roll: (0.0 Automatic

In-Time: (0.0

Behaviar; |:| Free Running |:| Loop
Production Computer: (®) Play this Sound () Mute
Display Computer: (_) By Display Mame: = - None Selected -

(®) By Icon Placement:

¥: | 360 Yo | 178

Cue Color: . Resst

Media: Locate Media

&_Channel_ID.wav

K, Cancel

PRODUCTION COMPUTER

Specifies whether the production computer should play this sound. This setting gives you control over
this property on a per-cue basis, while the corresponding setting on the Preview menu provides a
global setting for your production computer (see “Play Audio Media”).

DISPLAY COMPUTER
Specifies which display computer to use for playback:

By Icon Placement. In this mode, place the speaker icon corresponding to this cue inside the
desired display rectangle in the Stage window (also indicated by the X and Y position values in the
cue). This legacy method applies only to 2D displays.

By Display Name. In this mode, choose the name of a display or projector associated with the
desired computer on the menu next to this option.
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OUTPUT CHANNEL ASSIGNMENT
In the “Output Channel Assignments” tab in the Sound Cue dialog box, you can modify the audio

channel matrix by clicking corresponding cells. Any input channel can be routed into any output.

Note: WATCHOUT supports a maximum of 24 channels.

HINT: Use a “Channel Volumes” tween track to control playback volumes individually for each

channel.

This video explains how to use multi-channel sound files and sound interfaces:

[ ]

| Basic ] Output Channel Assignments |

InputyQutput 1 2 3 4 5 6 7 8 i
1 v
2 W
3 v
4 W
5 v E
b W
7 v
8 W
9
10
11
12
13
14
15
16 -

| Chedk Diagonal ” Uncheck Al ]
I Copy ” Paste J
[ QK I I Cancel

)

http://www.dataton.com/multi-channel-audio-playback
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TWEEN TRACKS
Tween tracks control the appearance of media on stage over time. Depending on the type of media

associated with the cue, you can add one or more tween tracks.

Main Timeline bt

To add or remove a tween .
track, first select the cue then 1:35.700 |30 L

choose the desired type on N AT C H O U -|- .

the Tween menu.

Tween tracks of the selected
cue appear in the tween
pane.

Formula button linking the
tween track to an external
control input.

HINT: Click the disclosure triangle in the layer header to expand the layer. This reveals where tween
points are located using colored dots along the bottom of cues, as shown above. These dots show you
where tween points are used without having to select each individual cue.

Most tween track types apply to images, compositions and video. Volume and Balance apply to mov-
ies and audio media. 3D models support only Position, Scale and Rotation. However, you can apply
any tween track for images used to create textures for 3D models by using a Virtual Display to man-
age the texture.

These videos provide an introduction to some of the tween tracks:
Using animations, part 1: https://vimeo.com/134593525
Using animations, part 2: https://vimeo.com/134593526
Using animations, part 3: https://vimeo.com/134593530

The following pages describe each kind of tween track, as well as the dialog boxes accessed by dou-
ble-clicking a point along a tween track.

COPYING AND PASTING TWEENS
Entire tween tracks, or individual tween points, can be copied in one cue and pasted into one or more
other cues. Select entire tracks by clicking their name to the left in the tween pane.

EXTERNAL CONTROL OF TWEEN TRACKS

Most parameters can be controlled by external inputs, or by a combination of tween track and exter-
nal input. Those are indicated by a formula button, as shown in the illustration above. See also “Exter-
nal Control of Position, Rotation and Scale” as well as “Controlling Tween Tracks”.
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POSITION

Positions an image on stage. To change the position,
drag the image or one of the motion path handles
shown in the Stage window when the cue is selected. To
set the position numerically, double-click the Position
tween point and type the desired position of the anchor Incoming: []Smooth  Speed: | 1
point into the “Location” field.

Pasition x

Time: |pEsERE

Outgoing: [+]Smooth  Speed: | 1

HINT: To move the entire motion path, first select all the Location Sl

Position tween points, then drag the image. Or use the . [502.62 — 3
Move command on the Edit menu. K : v : £

The “Speed” fields control the speed of motion into or OK Cancel

out from the point. A value of 1 results in the normal
speed required to move linearly to the next point.
Smaller values make the image go slower and greater values go faster. The speed is indicated by
white dots along the motion path (see below), and can also be controlled using the speed handles
(visible only for smooth points).

Using the Z position field, you can move the image along the Z axis, away from or towards the
viewer. The Z position can also be controlled by dragging the Position tween point vertically, with the
position indicated numerically next to the tween track. Moving the image along the Z axis changes its
perceived size according to the amount of perspective selected in the Preferences dialog box. When
images move away from the viewer, they move toward the vanishing point, which is also set in the
Preferences dialog box (see “3D Perspective and Stereoscopy”).

Normally, images overlap and obscure each other according to their layer order. When using Z posi-
tion, you may want images closer to the viewer to obscure images farther away. If so, select “By
Z-Depth” in the cue’s specifications (see “Stacking”).

When positioning images along the Z axis, it may be hard to see where the image is when viewed
from the front. If so, choose “View, Left” or “View, Top” on the Stage menu to rotate the stage preview.
These views also allow you to edit the Z position by dragging the image or its position tween points in
the Stage window.

HINT: In some cases, it may be easier to edit the position of an image in the Stage window by first
deselecting Perspective on the preview menu.

MOVING ALONG A PATH

The “Smooth” checkboxes allow you to create curved motion paths, as shown below. When selected,
a direction handle appears attached to the point, controlling the direction of motion into or out from
the point.

OFF LINE - Tier Main

Smooth Position tween
points create a curved path.

White dots along the motion

path indicate the speed of
ot e® | A T C |'| 0 UT.

Speed control handle
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Link Handles

Select “Link Handles” to make sure that the motion through a tween point is perfectly smooth. When
selected, the directional handles on either side of the point are linked so they always point in opposite
directions. This option is not available for the beginning and end points.

SCALE

Scales an image in relation to its anchor position (see “Anchor

Position”).You can specify either the scale factor (relative to the

image’s natural size), or the desired size of the image on stage.
Negative values flip the image.

Srale oo

Time: |

Point Type: Smooth
Constraint: Maintain Proportions

The “Smooth” checkbox allows you to change a corner point

into a smooth point, and vice versa. A smooth point changes the
rate of scaling over time, for example making it start or stop in a Scale, X: | 3333 | 13359 |%
more gradual and less abrupt way. Image Size, X: | 840 | v:|840  |px.

As an alternative to using the Scale tween track handle or its
dialog box, simply drag the scaling handle appearing in the
Stage window. Press Shift to maintain the image’s proportions
as you drag.

(04 Cancel

To scale the width and height by different values, first uncheck the “Maintain Proportions” checkbox.
This results in a split scale curve, allowing you to adjust horizontal and vertical scaling independently.

Independent X and Y scaling factors, combined with a smooth retardation.

CROP
Use a Crop tween track to move the edges of an image inwards. You can use this to remove unwanted
parts of an image, or as a creative effect to make text or other elements appear gradually.

HINT: To specify a precise amount, double-click a tween point and enter the value as a percentage or
in pixels.

As an alternative, use a Wipe tween track to reveal an image using a feathered edge.

CORNERS

Offsets the four corners of an image individually, allowing it to be mapped onto another image or
real-world object. As the corners are moved, the image changes accordingly to obtain a matching
perspective (see below). While this alters the perceived perspective of the image, the image remains
flat (2D). The corners can be moved either by dragging with the mouse, or by using the arrow keys
while holding down the Control key. Add the Shift key for greater increments.

For more advanced mapping applications, such as mapping onto arbitrarily shaped 3D surfaces, use
a 3D Model object instead (see “3D Models”) .
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Original image.

Corners pinned fo a target
object.

An image being mapped onto an object using a Corners tween track to position each of
its four corners.

HINT: This tween track can also be used to skew the image by moving either the top or right-hand side
control points.

OPACITY
Controls the opacity (transparency) of an image. To change the opacity, either drag the tween point
vertically in the tween track, or double<click it to change its value numerically.

The “Time Position” field specifies the position of the tween point along the timeline. This must be a
time within the time span occupied by the cue.

The “Smooth” checkbox allows you to change a corner point into a smooth point, and vice versa. Use
smooth points in combination with corner points to accelerate or slow down transitions, as shown in
the illustration under Scale.

HINT: The opacity curve is also displayed in the cue’s body, allowing you to see it even when the cue
isn't selected.

ROTATION Z

Rotates an image around its anchor point (see “Anchor Position”). You
can rotate the image by a specified number of revolutions or degrees, or
a combination of the two. (For example, to rotate 2.5 times, set Revolu- L e
tions to 2 and Degrees to 180.)

Rotation Z x

Point Type: [ Smooth
Alternatively, drag the rotation handle in the Stage window or the Rota- angle: | 45 :
tion tween point in the tween pane. o

Revolutions: | 0

HINT: You can also make an image rotate automatically to orient itself T
along a motion path (see “Auto-orient along Motion Path”).

Cancel
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Main Timeline b4

Stage OFF LINE - Tier Main
2:00.960 |5 200 205 2110 215 |K

L
V Rotationz | 2X0° 7y

Anchor Rotate by
point. dragging the handle... or a rotation tween point.

ROTATION X AND Y

Similar to the Rotation Z tween track described on the previous page, but rotates the image around its
X (horizontal) or Y (vertical) axes instead, making it appear in perspective. The amount of perspective
applied is specified in the Preferences dialog box (see “3D Perspective and Stereoscopy”).

HINT: To edit the amount of X or Y Rotation interactively in the Stage window, first change the view-
point using the View command on the Stage menu.

VOLUME

Controls the volume of audio media and video containing audio. The volume curve is also displayed
in the body of a sound cue, allowing you to see the curve even when the cue isn't selected. When
combined with the Channel Volumes tween track described below, the Volume tween track controls
the overall volume of the sound file, allowing you to fade all channels together.

NOTE: When a Volume tween track isn't used, the volume is controlled by a setting in the Preferences
dialog box (see “Default Audio Volume”). Setting this to a value of less than100% allows you to use a
Volume tween track to boost the volume of individual sounds above this default level.

BALANCE
Controls the left/right audio channel balance. Applies to audio media and video media containing
audio.

CHANNEL VOLUMES

Provides individual volume control for up to eight channels in the sound file. This is particularly useful
when playing multi-channel sound files (that is, files with more than a single stereo pair). This tween
track type applies to audio media only.

IMPORTANT: Use WAVE files to play multi-channel audio. Other file formats are not supported.

KEY (GREEN/BLUE)

Makes a green or blue background transparent. This is sometimes referred to as a “green screen” or
“chromakey” effect, and is typically used with live video, although it can be used with any kind of
image. Adjust the Threshold and Contrast parameters for best effect. See this video:

Blue green keyer: https://vimeo.com/134594129

HINT: For non-rectangular video playback, you can often use a pure green or blue background, com-
bined with this tween track, as an alternative to a true alpha channel. This allows you to use more

efficient video codecs than QuickTime Animation, such as MPEG-2 or H.264.
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KEY (SELECTIVE)

Makes any specific, pure color transparent. This can, for example, be used to make a black back-
ground transparent (sometimes referred to as a “luma keyer”). Select the color using the color swatch,
then adjust the Threshold and Softness parameters for the desired effect.

HINT: Use this feature to display Powerpoint slides, fed through a capture card Live Video or a Com-
puter Screen media item, on top of a background produced in WATCHOUT. Specify a suitable back-
ground color in the Powerpoint presentation, which is then made transparent using this effect. See this
video:

Luminance keyer: https://vimeo.com/134594130

KEEP COLOR

Makes the image mostly monochrome, while retaining a certain color range. First select the color to
keep by clicking the color swatch or by adjusting the Hue, Saturation and Brightness tween tracks.
Then adjust the Tolerance and Softness until you achieve the desired effect.

RGB MIXER
Re-mixes any amount of the original Red, Green and Blue color components to the Red, Green and
Blue color components of the resulting image.

HUE & SATURATION
Allows you to re-map the color spectrum of an image, as well as adjusting its color saturation contrast
and brightness. See this video for a few examples:

Hue & saturation effect: https://vimeo.com/ 134593724

Hue
Rotates the color spectrum of the image so that the chosen hue corresponds red in the original image.
This can be used for minor color balance adjustments all the way up to color inversion.

Saturation
Adjusts the color saturation.

Gain
Changes the contrast of the image by multiplying all its pixels by the specified amount.

NOTE: This may result in clipping in bright areas. If you only want to change the contrast, use the
“Contrast & Brightness” effect instead.

Offset
Changes the brightness of the image by adding the chosen amount to its pixels.

HINT: You can invert the image by setting the Gain to -100% and Offset to 100%.

CONTRAST & BRIGHTNESS

Adjusts the contrast and brightness of the image. This effect uses a spline curve to adjust these values,
similar to how you may use the “Curves” command in Photoshop, thereby avoiding clipping in bright
or dark areas.

COLOR
Use a Color tween track to specify the overall color of an image. The colors in the image will be multi-
plied by the color you choose. You can think of the Color tween track as the color of a light source
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illuminating the image. Normally, the color of this light source is white. By changing the brightness or
color of this light source, you can influence the overall brightness or color of the image.

Start by selecting an image cue on the timeline and choosing “Color” on the Tween m

menu to add the tween track. The default color is white, as indicated by the small
color swatch next to the tween track name. Click this swatch to change the color.

This brings up a dialog box allowing you to specify the color. Choose among the following color
models:

HSB. Specifies the color by first picking a hue (a specific color) and then the saturation (the amount of
that color) and brightness of the color. This intuitive color model is familiar to many artists and
painters.

RGB. Specifies the color using an additive method based on the amount of the three primary colors
Red, Green and Blue. This color model is often familiar to users with a web or computer background.

CMY. Specifies the color using a subtractive method, where you specify the filter density of an imagi-
native set of Cyan, Magenta and Yellow filters. This model may be familiar to you if you come from a
lighting background, where filters are often used to control the color of a light.

Color Chooser -l
HSB Sliders  RGB Sliders  CMY Sliders
Hue: £l 68.21 | %
|
Saturation: ' 26.59 e
[ ]
Brightness: ' 100 Yo
Resulting Color: |
oK, Cancel

Choose a color model by clicking one of the tabs, then specify the color with the sliders.

NOTE: It doesn’t matter which of the three methods you use to specify the color. Use the method that
feels most familiar to you.

When using the HSB model, note that merely changing the Hue has no effect unless you also specify a
saturation and brightness greater than zero. Watch the “Resulting Color” swatch as you drag the
sliders to see the resulting color. The preview in the Status window shows the color as applied to the
image.

An alternative way of specifying the color is to open the Color tween track to reveal its sub-tracks.
HINT: Double-click a tween point to set its value numerically. As the hue is specified by its color wheel

angle, you can use this method to create rainbow cycles by making the hue go through several
revolutions.
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TINT

Use a Tint tween track to add color to an image. You can think of the Tint tween track as specifying the
color of translucent spray paint added to the image. While the Color tween track primarily affects the
bright areas of the image, the Tint tween track mainly affects the dark areas. Normally, the Tint color is
black, meaning that no color is added.

HINT: You can combine both Color and Tint on the same image.

Specify the color to be added using the same methods as described above for the Color tween track.

BLACK & WHITE

Makes the image monochrome based on the color chosen in the Hue and Saturation parameters.
Adjust the Mix parameter to restore some amount of the original color, if desired. See this video for an
example:

Black & white effect: https://vimeo.com/134593725

HINT: The “Black &White” effect, with a carefully chosen source color, often gives a better result than
using the “Hue & Saturation” effect to desaturate the image.

WIPE

The various Wipe effects make an image appear gradually, starting from one edge or corner and
progressing towards the other. To see the effect, ramp up the Completion parameter from 0 to 100%
over time. Change the Angle parameter to control the direction of the wipe. Adjust other parameters
to your liking by changing the parameter while the Completion value is around 50%. See this video
for some examples:

Wipe effect: https://vimeo.com/134593531

ROUNDED CORNERS
Applies a corner radius and/or feathered edge to an image. Note that for still images, this tween
track is only available when “More Effects and Capabilities” is selected (see “Optimize For”).

HINT: Use this tween track on a Solid, in combination with a Color tween set to black and some Opac-
ity, to create a rectangular shadow.

CONTROL CUE

The Control cue governs the behavior of timelines. The cue is performed when the timeline runs past it.
The Control cue can be used to make a timeline pause, or jump to another position (by time or by
name). To create a Control cue, choose “Add Play / Pause Control Cue” on the Timeline menu.
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Cue name. Used to jump
to a named position.
Name cues F1 through
F12 to use function keys. — Mame: F2) Time: |1:31.364

Contral Cue -

Name of auxiliary timeline

Control the enclosing — Tell: |Enclosing Timeline —— to control.
timeline or another, Makes fimeline ivmp fo a
specified timeline. o . iy [9mp

@ Time Position: [0.0 time position or a named
Time posiﬁon’ or Control — . Control cue.
cue name fo jump fo. () Control Cue Named:
Makes the timeline stop, Search Reverse Only JU/TPS 'back.wards only .
pause or run (possibly ____ w3 : - : when jumping fo a name

. . applies to Auxiliary Timeline onl
after jumping). Lstop (app : V) cue.
IC::I Pause @ Run
Jump-to-Run Delay: (0.0 Introduces a delay
between the jump and the
= Cancel restart.

CREATING LOOPS

You can use the “Jump to” option to create loops — causing a section of the timeline to be repeated.
When jumping, you have the option of automatically restarting the timeline after the jump. In this case,
it is often a good idea to introduce a delay of a second or so to allow the display computers to catch
up before starting. This is done using the “Jump-to-Run Delay” field.

To exit such a loop, use the QuickFind feature described below, possibly in conjunction with the
Standby command .

Another option for creating loops is to use a free-running and looping composition. While slightly
more complex, it gives better control over the loop exit. To use that method, proceed as follows:

® Put the entire loop into a composition (see “Compositions”).

* Drag the composition onto a timeline to create a cue.

® Select Loop and Free Running in the cue to make the composition loop.
® Make the timeline pause during the loop.

* To continue after the pause, fade out the looping composition cue.

CONTROLLING OTHER TIMELINES

A Control cue can also be used to start, stop and position auxiliary timelines. To do so, select “Tell
Timeline Named"” in the cue, then enter the name of an auxiliary timeline into the field.

HINT: To name an auxiliary timeline, choose “Timeline Settings” while its timeline window is open. Do
not change the name of an auxiliary timeline after creating control cues targeting it, or you will break
the connection.

USING FIND AND QUICKFIND

Named Control cues can be used with the Find command to locate a position along the timeline by
name. A QuickFind feature allows you to instantly jump to positions using the computer’s function
keys. To use this feature, simply name the Control cues “F1”, “F2”, etc, as shown above.

IMPORTANT: The Control cue’s name field is case-sensitive. When using function key names, type an
upper case F.
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8. COMPOSITIONS

A composition allows you to group a set of cues together on their own sub-timeline. This can then be
used from other timelines similar to how you can play a video. A composition makes it easy to re-use
or re-arrange show sections or short snippets. It also makes it easier to apply the same effect to a
group of media elements — for instance, to move and scale a set of images together.

A composition behaves like other media elements, such as still images and video clips. It lives in the
Media window, from where you can drag it onto any timeline to use it. You can use a composition any
number of times — you can even play multiple instances of a composition at the same time.

Similar to a video clip, a composition has a duration and may contain motion. However, as a compo-
sition is created within WATCHOUT, there’s no rendering time or other delays involved in changing it.

A composition can be looped and/or free running, making it easy to create motion of indefinite duro-
tion within WATCHOUT.

A BASIC EXAMPLE

For example, assume you want to add a frame to a video clip, and then make the video clip move
across the screen while scaling it up at the same time. Although you could do this by applying the
motion and the scaling to the video and the frame image individually, it's often hard to make the two
move together in a cohesive way. Instead, you can add both elements to a composition without apply-
ing any motion and scaling to the individual elements. Then use the resulting composition from the
main timeline, applying the motion and scaling to the composition as a whole.

CREATING A COMPOSITION

Start by choosing “Add Composition” on the Media menu. Give the composition a name, and type @
suitable size into the “Reference Frame” field. In this case, it is a good idea to make the reference
frame just slightly larger than the still image frame around the video. This reference frame will be used
later when manipulating the composition as a whole from the main timeline.

Open the composition’s timeline window by double-clicking the newly added composition item in the
Media window. Notice that the content of the Stage window changes when the composition window
appears. Instead of showing the display rectangles, it now shows the reference frame of the composi-
tion. While editing a composition, its preview appears in the Stage window, temporarily replacing the
preview of the displays. To restore the Stage window to its usual state, select the main timeline
window.

To change the size of the reference frame, or any other composition setting, choose “Timeline Set-
tings” on the Timeline menu while the composition’s window is active.
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ADDING CUES

You add cues to a composition in the same way as you do to other timelines. In this example, we will
add a video with a still image frame on top. Drag those images onto the composition’s timeline. Their
preview will appear in the Stage window.

Indicates composition pre- Composition: FramedVideo
view mode.

Stage window content tempo-
rarily replaced to show a
preview of the composition.

T TETERTTE AR ERNE R LA NN R

This rectangle represents the

composition’s reference o
frame. o | 0:04.100 | e
.. e

Media added to the composi- = I F“j’“e i —J e
tion’s timeline. .

FramedVideo

g FireVideo.mp4

a<Q B

When you’ve added the media to the composition, close its timeline window. This restores the Stage
window to its normal preview mode.

USING THE COMPOSITION

To use your newly created composition as a whole, simply drag it from the Media window onto the
main timeline.

Drag a composition from : OFFLINE Tior Main

the Media window onto 1N

a ﬁmeline. By 8 ——— i R Thumbnail | Type
; Dérrpaneljpg _;[ Image

The selection rectangle _ . )
FireVideo.mp4 B Video

around the composition —— E—

corresponds to its refe- ':. { . ; GoldenFrame.psd E Image v

rence frame. UE ER e Te—————
* Main Timeline

2:43.852 E"I?E
A composition cue ¥ LAYER 10
appears on the - ko] FramedVideo
timeline.

[> LAYER 9 "I|r§ Dérrpanel.jpg Dérrpaneljpy

Add tween tracks to
move and scale the
entire composition.

HINT: To open a composition’s timeline window from the Main Timeline, press Alt then double-click the
composition cue.
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NESTING COMPOSITIONS
A composition may be used inside other compositions. This can be applied in a hierarchical fashion
to build complex animations one step at a time. This video shows how:

https://vimeo.com/134594388
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Q. DYNAMIC IMAGES

The WATCHOUT Dynamic Image Server is a separate program that allows you to incorporate up-to-
date text, images and graphics into your presentation. It renders the requested images, and sends the
result to your display computers via the network. This is somewhat similar to the way a VNC Server
provides images for a “Computer Screen” media item, but provides greater flexibility and
programmability.

Being a server application, the program doesn’t offer much in terms of user interface. It simply runs on
a computer connected to the network and responds to image requests from WATCHOUT. Using the
commands on the File menu, you can manually open local files and URLs to preview them on screen.
Images are also displayed while they're being served to WATCHOUT.

IMPORTANT: As the Image Server runs as a separate application, it requires its own WATCHOUT
license key.

IMAGE TYPES
The Image Server can serve three types of content:

¢ Astillimage

* A web page, based on standard HTML5 components
e A SWEF file (Adobe Flash)

e Desktop

For still images, the Image Server accepts JPEG and PNG and TIFF formats. It supports transparency
information in PNG and TIFF images, as well as in HTML and Flash content. See “Add Dynamic
Image” for more details on how to configure this media type.

ALTERNATE FILE LOCATION

By default, local image files are served from a folder relative to the location of the Image Server appli-
cation. If you want to keep your dynamic images elsewhere, pass the -f command line parameter to
the Image Server application to specify the location of the folder. Put this option into a shortcut used to
start the image server, possibly located in the Startup folder of the computer, so that the shortcut’s
Target field resembles the example below:

“C:\WATCHOUT\ImageServer\ImageServer.exe” —-f D:\DynImages

If the image folder path contains spaces, enclose it within double-quotes too.

SERVING STILL IMAGES

A still image provided through the Image Server can be changed at any time. To update an image on
the server, simply drop a new image file into the folder containing the old one, using the same name
as the old image. When an image is replaced on the server, the new image will appear on all dis-
plays currently showing it. The default refresh interval is 3 seconds but you can customize the interval
by using the parameter below.

“C:\WATCHOUT\ImageServer\ImageServer.exe” —-fileRefreshInterval 1000

Values are expressed in milliseconds; the example thus shows a 1 second interval. :
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You can provide the updated image in any way you like. For instance, you may run a web server on
the same computer, configured to allow files to be uploaded. This web server can provide a web
interface for manual uploading of images, or interact with camera phones via the Internet.

Alternatively, you may have a custom application that updates the image on a regular basis, based on
some external data or other events. This application can run on the same computer as the
WATCHOUT Dynamic Image Server, or another computer connected over the network. From the
Image Server’s point of view it doesn’t matter where the image comes from. As soon as it is changed,
it will be updated on screen accordingly.

SERVING HTML CONTENT

The Dynamic Image Server can render regular web pages, based on standard HTML, CSS and Java$-
cript. Such content can be served either from a local folder on the image server computer, by using a
relative path, or from the Internet, by using a fully qualified URL.

Put the local path or the URL into the “Path” field in the Dynamic Image media item.

NOTE: When using a URL, the Dynamic Image Server mush have Internet access in order to fetch the
content.

If you want to display only a section of a web page, such as a weather map from a weather site, you
can use a Crop tween track to extract the desired part. The dimensions you specify in the Dynamic
Image media item must be large enough to include the desired part from the outset.

SERVING SWEF FILES

You may also choose to serve Flash (SWF) files. Such a file can dynamically generate and update text,
graphics and other image elements, and can interact with various data sources. SWF files are pro-
duced using Adobe Flash Professional. By combining high quality text and graphics rendering with a
powerful, network-aware programming language, Flash allows you to create custom solutions with
very little effort.

In order to serve SWF files, you must install the Adobe Flash Player on the Image Server computer.
This is available as a free download:

http://get.adobe.com/flashplayer/

NOTE: When displaying SWF files that reside locally on the Image Server computer, you may need to
grant additional rights to those files in order to access network resources. To do so, go to Control
Panel, Flash Player. Click the Advanced tab, then Trusted Location Settings. Click the “Add...” button
and add the folder(s) containing SWF files to be served by the Image Server.

SOURCING FLASH CONTENT

There are many websites dedicated to providing Flash examples and tutorials. This is a great source
for simple flash content, such as live clocks, stock tickers, news readers, etc. In many cases, such con-
tent can simply be dropped into your Image Server folder and used as-is.

IMPORTANT: Since you're going to run the SWF files on your local computer, with a relaxed security
sandbox based on the “trusted location settings” set above, only use SWF files from sources you trust.

NOTE: Keep in mind that such content may be copyrighted. Always check its license before including
it in your presentations.
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FLASH EXAMPLE: A NEWS READER

To develop custom solutions, you need to be familiar with Flash Professional and its ActionScript pro-
gramming language, which is used to create live data. The example below shows a complete news
reader for displaying the latest news from CNN:

var rssXML:XML; // RSS feed data is loaded here

var rssLoader:URLLoader = new URLLoader () ;

var rssURL:URLRequest = new URLRequest (“http://rss.cnn.com/rss/edition
world.rss”);

var timer : Timer = new Timer (10000); // Updating image regularly

rssLoader.addEventListener (Event.COMPLETE, rssLoaded) ;
rssLoader.load (rssURL) ;

function rssLoaded(evt:Event) :void {
var firstCall : Boolean = !rssXML;
rssXML = XML (rssLoader.data) ;
if (firstCall) {
updateDisplay(null); // Draw first time rigt away
timer.addEventListener (TimerEvent.TIMER, updateDisplay);
timer.start(); // Display other news every 10 seconds

}

function updateDisplay(evt : TimerEvent) : void {
var itemCount : uint = rssXML.channel.item.length ()
if (itemCount) { // Has something to display
var pick : uint = Math.random () * (itemCount-1);
displayField.htmlText = rssXML.channel.item[pick].description;
}
}

DISPLAYING LOCAL SERVER FILES

Put the local files that are to be served into a folder on the computer running the WATCHOUT Image
Server application. By default, this folder is assumed to be found inside the WATCHOUT program
folder. Add a command line parameter when starting the Image Server application to put the image
folder elsewhere (see “Alternate File Location”).

You can test a file manually using the Open command in the Image Server application. This will dis-
play the image on screen if it is compatible with the Image Server application.

To display an image in your WATCHOUT presentation, add it as a media item to the Media window
of your WATCHOUT presentation (see “Add Dynamic Image”), then drag it onto stage. The image
should now be requested from the Dynamic Image Server, and displayed on screen.

NOTE: You can also preview dynamic images in the production software, if specified in the dynamic
media item.

DYNAMIC IMAGES 157



DYNAMIC IMAGE PARAMETERS

In addition to the basic settings, such as the dimensions and path to the image being served, you can
also provide additional parameters to the dynamic image. The parameters available vary with the
type of image served.

Dynamic Image b 4

Mame: |25

Server Address:

Leave Server Address empty to use
default address from Preferences

Type: |Flash o
Stage Preview: () Live (@) Thumbnail

Dimensions
Width: | 400 Height: | 50

Path: |flash/TickerTest, swf

Parameters: |code=AAPL

(04 Cancel

FLASH PARAMETERS

For SWF images, any parameters specified in the Dynamic Image Specifications dialog box are
passed to the SWF similar to how parameters are passed from a web page. This allows you to custom-
ize a single SWF file in various ways, without having to modify the SWF file itself.

For example, when creating a stock quote display SWF, you may not know what company to display.
Instead of hard-coding the company identifier into the SWF file, pass it as a parameter by putting it
into the “Parameters” field of the dynamic media item, as shown on the left.

You can then access this “code” parameter, as well as any other parameters you may want to pass,
from the loaderlnfo object in the SWF file like this:

loaderInfo.parameters.code

This parameter can be sent to a web service providing live stock quotes, such as the one available
from Yahoo.

HTML PARAMETERS

Parameters entered for the HTML type will simply be appended to the URL as query string parameters,
separated by a question mark. This can be used to pass such parameters to the web server serving the
content.

STILL IMAGE PARAMETER
Still images support only the single, optional parameter:

missingImageIlsOK

to indicate that a missing image should be displayed as entirely transparent, rather than giving an
error message.
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DESKTOP PARAMETER
The Path and Parameters fields are ignored when a desktop image is used. The Image Server simply
transfers the desktop image to displays.
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10. INPUTS AND OUTPUTS

Inputs and outputs act as gateways between WATCHOUT and external devices. Using industry-stan-
dard protocols, such as DMX-512, MIDI, TCP/IP, RTTrPM, and serial data communication, you can
interact with the presentation environment in many creative ways.

INPUTS

Inputs receive signals from the outside world. Those signals can then be used to control and influence
the behavior of WATCHOUT by starting and stopping timelines and by controlling various cue
parameters.

Input bt

Mame | Description | Value

Click the plus button in the top, right corner to add an input.

To create an input, first open the Input window using the Window menu, then choose “Add..." from
the pop-up menu located in the upper right corner of the Input window. Depending on the type of input
chosen, this displays a dialog box allowing you to enter its specifications. See the following sections
for details on the various kinds of inputs.

NOTE: When you are using the production computer, inputs are managed there. When not using a
production computer, inputs are managed by the primary display computer in the cluster.

GENERIC INPUT

Use a generic Input when you want to control its value using the WATCHOUT control protocol. The
default range of a generic input is O through 1, although you may set the upper limit to any positive
value using the Limit field in the Generic Input’s dialog box. To control a generic input, use the setlnput
command.

CONNECTING A MIDI DEVICE

Connect your MIDI device to a USB port (or other suitable MIDI
interface) on your WATCHOUT computer. Many newer devices
come with a direct USB connection. Older MIDI devices often use
a standard 5-pin DIN connector, in which case you need a MIDI+o-
USB adaptor, as shown on the right, or other Windows-compatible
MIDI interface. If you have multiple devices with MIDI capabilities connected to your system, you can
choose which one to use for MIDI input in the Control tab of the Preferences dialog.

NOTE: Most MIDI devices that connect using USB occupy an entire MIDI bus on their own. Since
WATCHOUT handles only a single MIDI bus, you won't be able to combine such a device with other
MIDI devices. When connecting multiple MIDI devices through the same bus, WATCHOUT can handle

up to 16 devices simultaneously.
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IMPORTANT: When using the production software, connect your MIDI interface to the production
computer. Otherwise, connect it to the primary display computer. Turn on and connect your MIDI
interface and devices to your computer before starting WATCHOUT.

MIDI CONTROLLER INPUT

A MIDI Controller Input brings in a knob or slider from a keyboard, or similar signal from a MIDI-com-
patible device or software. This type of MIDI data is sometimes referred to as a “Continuous Control-
ler”, “Control Change” or “CC" message.

MIDI Controller 4
The name used to refer to I}
this input in expressions Name: || |
Channel used for
= 1 . Vi ”

the message Channel Click “Learn” and move the
MIDI controller number ——————— Contraller: D [Jiean_| controller to pick up the

) . L channel and controller
Data resolution for the ———————— Resalution: '~ Normal (7 bit) b omaticall
controller (usually 7 bits) High (14 bits) numbers aufomaticarly-
Inferpo/afion method — Interpolation: | Linear

(04 Cancel

Enter the MIDI channel number and controller number to use, if you know them. If not, click “Learn”
and move the controller.

NOTE: The controller number used in the MIDI protocol is often not the same as any number next to
the knob on the device. Furthermore, many devices have programmable controllers, so the actual
controller number may vary depending on the device’s configuration.

Do not select “Resolution: High” unless you know for a fact that the controller transmits high resolution
data. Regardless of the resolution being used, WATCHOUT normalizes all controller inputs to a num-
ber in the range O through 1, as indicated in the Input window’s Value column.

Circular interpolation should be set if using external controls able to rotate more than 360 degrees
(e.g. an Endless Wheel Encoder, Jog-wheel or Jog-dial). This makes the input value interpolate the
shortest distance between two points on a circular basis. This to avoid a jump backwards, if for exam-
ple a rotational animation exceeding one revolution is applied on an object, which would be the case
if using linear interpolation.

When done, click OK in the MIDI Controller dialog box. Verify proper operation of the input by mov-
ing the controller and observing the bar graph in the Input window.

Input pd

Mame Description Value +

@ Moawneet MiDI1Conto [0523 Indicates the current
‘h controller input value.

Drag to change.
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MIDI NOTE INPUT
A MIDI Note Input brings in MIDI keyboard messages, often referred to as “Note On/Note Off”
messages.

MIDI Mote 4
The name used to refer to
this input in expressions. — MName: |MiddleC
Channel the message i .
: J ! Click “Learn” and press a key
Is sent on. o oick vo the ch I and

Nen Ao | to pick up the channel an

MIDI note number. Note: | 60 | Leam P P

note numbers automatically.

QK Cancel

When you've entered all the information, click OK in the MIDI Note dialog box. Verify proper opera-
tion of the input by pressing the key and observing the bar graph in the Input window. If the keyboard
has velocity sensitivity, the velocity is indicated by the magnitude of the value.

DMX-512 INPUT

A DMX-512 Input brings in the value of a DMX channel. DMX-512 is a
protocol used by most lighting consoles, dimmers, moving lights and
other similar devices.

WATCHOUT uses the computer network to receive DMX data with the
Artnet protocol. Many lighting consoles can send Arinet over an Ethernet
network. Otherwise, a DMX-to-Ethernet adapter must be used. In either
case, you need to know the DMX channel number(s) to be used for WATCHOUT, as well as the Artnet
Universe number used to send those channels. Set the default ArtNet Universe from which
WATCHOUT will receive data under the Control tab in the Preferences dialog box. As the Universe
can be set per output, the default setting can be ignored if multiple Universes are to be used.

DMX-to-Ethernet adapters
from Enttec and Kissbox.

Add a “DMX-512 Input” to the Input window using the plus button in its top, right corner. Specify the
desired DMX channel number.

DMX Channel X
The name used to refer to
this input in expressions —— Name: | |
DMX-512 channel number Channel: | 1 J 1-512
Resolution: (@) Normal (8 bit)
Select resolution of data () 16 bit
. . () 24 bit
Choose interpolation i
method Interpolation: Linear
DMX-512 Universe number — Universe: |0 0-255
0K Cancel

Choose the appropriate interpolation method (see explanation under the section on “MIDI Controller
Input”, click OK in the DMX Channel dialog box and verify proper operation of the input by moving
the fader for the specified channel and observing the bar graph in the Input window. WATCHOUT
normalizes DMX values to a number in the range O through 1, as indicated in the Input window's
Value column.
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Learn more about Artnet here:

https://en.wikipedia.org/wiki/Art-Net

Resolution. Some lighting consoles support higher resolution values (16 or 24 bit). Such values are
generally required to control, for example, the position of images in WATCHOUT, since the standard
8 bit DMX resolution (0...255) is too low for this purpose. If your console is capable of outputting
16-bit or 24-bit DMX values, choose the appropriate resolution in the DMX input settings and enter the
base (coarse) channel number. WATCHOUT will derive the coarse 8 bits from this channel and the
fine bits from the following one or two channels.

TRACKING INPUT
A Tracking Input is a multi-variable type of input that brings in positional and rotational data from a
live motion tracking system into WATCHOUT.

Any tracking system that supports the RTTrPM protocol may be used, and the information sent by the
system can either control the position and rotation of a media cue or act as a trigger for tasks.

Tracking Imput x
Traddng Mame: ||
Trackable 1D:
Position: Rotabon:
] b Rl
%L [ pirch
1z E raw
Lise Prediction:[] ms:
Ok Cancel

Enter a name and a trackable ID to start using a Tracking Input.

The name is used inside of WATCHOUT to refer to this input in expressions and in media cues that
should be controlled by the tracking input. The trackable ID is determined by the tracking system that
is being used. For details on how to determine the trackable ID value, please refer to the manual of the
tracking system being used.

The six checkboxes allow you to select which type of data will be applied to media cues controlled by
the tracking input. If a type is deselected, and thus no longer processed, it will not be applied to media
cues. For example, deselecting X under Position means media cues will no longer be affected by trans-
lation on the X-axis received from the tracking system.

To use the different components in a tracking input in expressions or triggers, specify them as:
<Tracking Name>.<component> where component may be X, Y, Z, Roll, Pitch, or Yaw. To use the
“Roll” component of a Tracking Input called “MyTrackable” in an expression you would write the
following: MyTrackable.Roll

During periods of high network traffic or system load, the tracking of an object may seem to “fall
behind”. In these scenarios, tracking results may be improved by selecting “Use Prediction”. This is
especially useful when the tracked object(s) moves in a predictable way, e.g. at a constant speed.

The “ms” (millisecond) setting controls the magnitude of prediction. It should be set according to the
lag in the complete system.
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NOTE: Using prediction when the tracked object may quickly change its direction or speed can cause
an “overshoot” in its position or rotation.

CONTROLLING TWEEN TRACKS

Inputs can be used to control parameters of cues, similar to the way tween tracks are used. This pro-
vides external control over most parameters. To use this capability, add the desired type of tween track
to the cue, then click the formula button located in the header area of the tween track. You may need
to click the triangle in the tween track header to reveal the formula button. Some tween tracks have
multiple controllable parameters.

Main Timeline b4
1:37.750 1:40
O L A dashed tween
= R Al track curve indi-

The formula button allows
you to control a parameter
using an input. It turns green
to indicate that such control
is in effect.

cates that the
parameter is over-

ridden by a

formula.

Y 0
W

Clicking the formula button brings up a dialog box allowing you to enter the control formula. By
default, the formula consists only of the TweenValue item.

NOTE: In order to access the formula of some tween tracks, such as Position, Scale and Rotation, you
must first enable this in the cue’s settings (see “External Control of Position, Rotation and Scale”). For
still images, you must also select “More Effects and Capabilities” in the image's specification (see
“Optimize For”).

Some tween tracks, such as Position, contain multiple values, one for each dimension controlled by the
tween track (such as X, Y and Z position).

The TweenValue identifier represents the tween track itself. To control the parameter using an input,
simply enter the name of the input instead, as shown in the illustration below, or enter a formula
combining inputs, numerical constants, operators and the original TweenValue (see “Expression”).

Pararmneter x

Formula governing the parameter being tweened:

The result of the formula is applied to the parameter being controlled.
It may include the name of inputs, operators (+, - *, etc) and the name
TweenWalue (which refers to the current value of the tweening curve).

(8]0 Cancel

Enter the name of an input, or a formula with inputs, constants and
the original TweenValue.
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TRIGGERING TASKS
You can use an input to start an auxiliary timeline by entering the name of the input in the Trigger
column of the Task window.

Task *

Mame Status Trigger

Click in the Trigger col- IMAG [>

umn of a task to enter its
starting condition.

A red border around
the field indicates an
error in the formula.

Press Enter to complete the formula. The task will be started whenever the value of the formula entered
in the Trigger column becomes non-zero. You can create more elaborate starting conditions by enter-
ing a more complex formula including multiple inputs, numeric constants and operators (see
“Expression”).

IMPORTANT: Most media cues need some time to prepare before they will appear properly on stage.
Therefore, it is generally not a good idea to put such cues at the very beginning of an auxiliary time-
line. Leave about a second or so empty at the beginning of the timeline.

HINT: You can only use a trigger to start a task — not to stop it. To stop a task, use another task with a
timeline containing a Control Cue that targets the timeline to be stopped. Trigger this second task
using the desired condition.

OUTPUTS
Use Outputs to send data to other devices and systems from WATCHOUT. To create an output, click
the plus button in the upper right corner of the Output window and choose “Add...” (see “Output

Window").

CREATING OUTPUT CUES
Outputs are controlled using cues. To create a cue for an output, drag the output from the Output win-
dow onto a timeline.

Output

Name Description
® Houselights DMX 62 w

® b Dix 63 : 2:08.520
[1| switch UDP192.168.0.64 1218

[> LAYER 10

Fade

F 41%

> adgq

Drag from the Output window onto a timeline to create a Cue.
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DMX OUTPUT

Use a DMX Output to control lighting and other devices which accept the [ ouxoutpu x
DMX-512 protocol. Specify the DMX channel and Universe number to use \one: [EETS
in the dialog box, as shown to the left, and give the output a descriptive =T
name. Resolution: (® Normal (8 bit)

O 16 bit
You can configure the default Universe from which WATCHOUT will trans- Qam "
mit data under the Control tab in the Preferences dialog box. However, as e
the Universe can be set per output, the default setting can be ignored if e 0255
multiple Universes will be used. o Cance

If the devices being controlled don’t have an Ethernet connector accepting
the Artnet protocol, you need an Ethernetto-DMX interface, as shown under “DMX Output”.

A DMX-512 Output is controlled using a Fade cue, created by dragging the output onto a timeline, as
seen above. This cue contains a single tween track, allowing you to control the DMX output.

IMPORTANT: The DMX output is only controlled while the cue is active. Jumping to positions on the
timeline between Fade cues will not change the output. To control an output over the entire duration of
a timeline, the Fade cue must have the same duration as the timeline.

NOTE: If you have multiple cues controlling the same output at the same time (for example on sepo-
rate timelines), the highest value will take precedence.

STRING OUTPUT

Use a String Output to control devices that accept text strings or other discrete data packets through a
serial or Ethernet port. For example, you can tell a projector to power down by sending it a command
through a serial port on its display computer.

String Output x

Qutput Port Name: |5witd-| |

Select the kind of data port ___

N
: Netwaork Port (TCP ar UDP ~ e
to use on this menu. =i The settings in this part of

— Network Address: [192.168.0.64 | the String Output dialog
| box are specific for the

For a network port, enter its
IP address and port number

IP Port Number: |3002

here. kind of port selected on the
Select the desired IP — [ rotock: OTCP @ue 1 menu above.
protocol. o

Using a Network Port

When using a network port, you must know the IP number (or DNS name) and port number of the
device to be controlled. You must also specify a protocol type. UDP is a rudimentary protocol used by
many simple devices, while TCP is more common on computer-based systems. When using the TCP
protocol, WATCHOUT will open the connection (if not already open), send the data packet, and close
the connection after about a minute of inactivity.

Using a Serial Port

To use a serial port, connect the device to the COM1 port on any display computer, and select a dis-
play connected to that computer on the pop-up menu in the String Output dialog box. Select the data
rate and parity mode according to the specifications of the device being controlled.
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String Output >

Output Port Mame: |Switch

Serial Part of a Display Computer o

Display Mame: | Display 1 @ Main  ~

Data Rate: | 9600 o
Parity: |Mone W
K Cancel

Send data on a serial port of the computer connected to “Display 1” at the Main tier.
For more details on serial data communication and wiring, see
http://en.wikipedia.org/wiki/Serial_port

Sending a Data String
A String Output is controlled using a String Cue, created by dragging the output onto a timeline (see
“Creating Output Cues”).

String Cue >
Name the cue to state its _ Name: |54 Time: [3.33
purpose.
Data to Send:

Enter the data to send to the
device here. This can be [OM] 40D
plain text, hexadecimal data
bytes, or a combination of S

. e o send arbitrary data, type a dollar sign followe
:ofh.dPre.le eI(Z)Ch tw? ﬁlg” by two hexadedmal digits. Far example, to send

exadecimal byte with a a Carriage Return, type $0D.
$-sign.
QK Cancel

IMPORTANT: The data is sent only when the timeline plays across the cue. It is not sent when jumping
to or past the cue.

To output text, simply type the text into the “Data to Send” field. To output non-textual data, such as
control characters or other arbitrary data bytes, enter the data in two-digit, hexadecimal form, pre-
fixed with a dollar sign. The example above uses “$0D” to output a Carriage Return control character.

NOTE: To output a single dollar character, enter two dollar characters into the field, like this: $$.

GENERIC VARIABLE

A Generic Variable can be controlled using cues on a timeline, just line a DMX-512 Output. However,
its value isn’t sent to any external device in your system. Instead, it can be used internally to govern the
behavior of Task triggering expressions (see “Using Outputs in Triggering Expressions”).
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11, TASKS AND EXPRESSIONS

The Task window allows you to create multiple auxiliary timelines, and to specify their triggering con-

ditions using expressions. Auxiliary timelines behave very much like the main timeline, but can be

started and stopped independently.

If an auxiliary timeline displays images on stage, those images will appear on top of any images

originating from the main timeline. You can control the order in which images from multiple, concur-

rent auxiliary timelines interact by dragging the tasks to the desired order in the Task window.

Task

Drag a task towards the Name

top of the Task list to make
its images appear in front
of other tasks’ images.

Marquee
B Andrews
% The Joneses

A Jones

. Z Jones
See “Task Window” for
. . P Crenshaw
more information.

AUXILIARY TIMELINE

Status

Trigger

ModWheel = 0.5

Click to lock the task list

or to add more tasks or
task folders

Double-clicking an item in the Task list opens its associated auxiliary timeline.

Task

Double-click the task name to Name
open its timeline. Marquee
B Andrews

> The Joneses
Click here to start, stop or P Crenshaw
pause the auxiliary
timeline...

B Andrews

[> LAYER3

[> LAYER 2

> LAYER1

...or click here after opening
its timeline window.

Status

Trigger

Iy <

HINT: Change the name shown in the Task list by first opening the auxiliary timeline and then choos-

ing “Timeline Settings”on the Timeline menu.
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STARTING AND STOPPING MANUALLY

An auxiliary timeline has three primary modes:
e Stopped (red button is lit). In this mode, the timeline doesn’t contribute to the stage.

® Paused (neither button is lit). In this mode, the time isn’t moving, but any cues at the current time
position does contribute to the stage.

* Playing (green button is lit).

You can control these modes manually by clicking the buttons either in the Task window or in the lower
left corner of an open auxiliary timeline window.

HINT: You don’t need to open an auxiliary timeline to run it. Just click its play button in the Task
window.

STARTING FROM AN INPUT

Alternatively, you can trigger an auxiliary timeline using an external signal, brought in as an input in
the Input window. For details on how to configure inputs see “Inputs and Outputs”. The section titled
“Triggering Tasks” describes how you use an input to trigger a task. The task will be started when the
value of the triggering expression becomes non-zero. This expression may combine multiple inputs
and constants using operators (see “Expression”). For example, to trigger a task when the input goes
above 50%, you would enter an expression like this:

ModWheel > 0.5

NOTE: The task will be triggered only when the value of the expression goes from being zero to being
non-zero. In order to trigger the task again, the value must first return to zero.

Task

I} <

Status Trigger

Marguee > 0:03 CKey
B Andrews > 0:06
W The Joneses
A.Jones [=
Z Jones [ ModWheel = 0.5

P Crenshaw [>

To see the current value of an expression, point at the expression using the mouse.

Using Outputs in Triggering Expressions

Task expressions can use inputs, as described above, as well as numeric outputs. This can be used to
build complex logic conditions, where the value of an output - such as a “Generic Variable” - gov-
erns the performance of a task.

STARTING FROM ANOTHER TIMELINE
You can use a “Control Cue” to position, start, stop or pause an auxiliary timeline from another
timeline.

STOPPING AN AUXILIARY TIMELINE
An auxiliary timeline will stop automatically after playing to its end.

HINT: Set the length of an auxiliary timeline using the “Timeline Settings” command on the Timeline
menu while the auxiliary timeline’s window is active.
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Alternatively, use a Control cue (either on the timeline itself, or on another timeline) to stop it. When
stopped, its images will disappear from the stage.

EXPRESSION

An expression is a simple mathematical formula, combining values such as inputs, outputs (Task trig-
gering expressions only) and numeric constants using operators in a way that yields a numeric result.
Expressions are used fo:

e Start tasks (see “Starting from an Input” and “Triggering Tasks”).
® Influence tween tracks (see “Controlling Tween Tracks”).

In its most basic form, an expression consists of a single value, such as an input (this example assumes
that an input with the name “ModWheel” exists in the Input window):

ModWheel

If this expression is used in the Trigger column of the Task window, that task will be started when the
ModWheel's value becomes non-zero (that is, when the modulation wheel on the attached MIDI
device is moved from its zero position).

Likewise, if this expression is used as a formula for an Opacity tween track, the opacity will be con-
trolled only by the modulation wheel (that is, the value of the tween track itself will have no effect).

USING NUMERIC OPERATORS

In some cases, you may want to combine multiple values. For instance, in the previous example, you
may change the expression so that the modulation wheel modulates the value of the cue’s Opacity
tween track by entering the following expression into its formula dialog box:

Parameter X

Formula governing the parameter being tweened:

TweenValue * ModWheel

The result ofthe formula is applied to the parameter being controlled.
It may include the name of inputs, operators (+, - *, etc) and the name
TweenValue (which refers to the currentvalue of the tweening curve).

Ok Cancel

Enter an expression for a tween track by clicking its formula button (see “Controlling
Tween Tracks”).

This expression combines the value of the ModWheel input with the value coming from the tween

track itself by using the TweenValue identifier, which provides the enclosing tween track’s current

value. Since both values are in the range O through 1, multiplying them in this way will work as

desired.

Alternatively, you may want to combine the two values so that the opacity can be controlled by either
the tween track or the modulation wheel. This can be accomplished by changing the formula to

TweenValue + ModWheel
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Now the resulting image will appear on stage if the tween track or the external input says so. Note
that if both the tween track and the input are at their maximum value, the result of the expression will
be 2. However, the opacity value is effectively clipped to the range O through 1 (as the image can’t be
more than fully opaque or fully transparent). Most parameters work in this way, with the notable
exception of the color hue, as it allows the color wheel to be rotated multiple revolutions.

USING RELATIONAL OPERATORS

When using expressions to trigger tasks, it is often useful to specify a threshold for the triggering
value. If the input is used on its own, the task will be triggered as soon as the input leaves zero. If you
prefer the input to exceed a certain value, you can use a “greater than” operator to test for this:

ModWheel > 0.5

This operator yields a value that is 1 if the value on the left hand side is greater than the value on the
right hand side, otherwise its value is O. Likewise, if you want to trigger the task when the value
becomes zero (rather than when it leaves zero), you can write:

ModWheel = 0

This uses the “equals” operator, yielding 1 if the value on the left is the same as the value on the right,
or else yielding O.

USING LOGICAL OPERATORS

Occasionally you may want to create more complex triggering conditions, combining multiple inputs,
so that the task will only be triggered when all conditions are met. That can be accomplished using the
“and” operator:

ModWheel > 0.5 && MiddleC

This will trigger the task when the modulation wheel is above 50% and the MiddleC key is pressed
(assuming here that MiddleC is a MIDI Note input).

HINT: Expressions in the Task window can use both numeric input and output values. This can be used
to create complex logic conditions, governed by WATCHOUT itself, using logical operations together
with the “Generic Variable”.

LIST OF OPERATORS
This is a list of the operators supported by WATCHOUT, shown in their order of precedence.
Operator Description

() Parenthesis. Used to group sub-expressions.

- Unary Minus.

*/ % Multiplication, Division and Modulo.

+ - Addition and Subtraction.

< <= > >= = |Lless Than, Less Than or Equal To, Greater Than, Greater Than or Equal To, Equal,
|= Not Equal.

&& Logical And.

| | Logical Or.

Most operators work as expected. The Modulo operator yields the remainder of an integer division.
All other numeric operators may yield results with fractional digits. All relational operators (<, >, efc)
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yield 1 if the relation is true, O if it is false. Likewise, the logical operators yield 1 for true and O for
false.
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A. SYSTEM REQUIREMENTS

This appendix lists what you need in order to install WATCHOUT on a PC.

COMPUTER
A WATCHOUT computer has the following minimum system requirements:

* Intel or AMD dual core processor with four logical processors (4 threads).
e USB port.
 Gigabit Ethernet port.

e SATA hard disk (SSD recommended to drive multiple displays or for playing some video formats).

e 4 GB RAM. Under 64 bit Windows, 8GB is recommended (more RAM will generally not improve
performance).

e DirectX 9.0 capable graphics card.

® Windows 10 (recommended, see tweak list), or Windows 7, 32 Bit “Home" (while WATCHOUT is
a 32-bit application, it's fully compatible with 64-bit Windows).

NOTE: It is generally not recommended to mix different kinds of display computers/media servers, or
graphics cards in one display or projection surface. Nvidia or AMD synchronization cards are
required to prevent tearing on LED displays when using multiple display servers.

IMPORTANT: These are minimum system requirements. Faster processor, faster memory, NVMe SSD,
faster network, faster professional graphics card with more video memory, etc, will enhance
performance.

LIVE VIDEO INPUT
To integrate live video into WATCHOUT, each display computer used to show live video must be
equipped with a suitable video input, and its driver software must be installed.

Suitable video input solutions include:
* Datapath Vision cards:

http://www.datapath.co.uk/products/video-capture-cards

AUDIO

For sound playback a high-quality audio device is recommended. ASIO drivers are preferred for
multi-channel. Audio input is required for slaving to SMPTE time code.

NETWORK

The production and display computers must be connected using an Ethernet network. A typical system
has 100 MBit Ethernet network ports on all computers and a high-quality Ethernet switch with the
required number of ports to connect the computers.

NOTE: A wireless network may work, but is generally not recommended for reliability reasons and
affects synchronization accuracy among display computers.
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B. MIDI SHOW CONTROL

MIDI Show Control (MSC) allows WATCHOUT to be controlled from a lighting console, or similar
device capable of outputting MSC commands.

NOTE: During production, connect your MIDI device to the production computer. When not using the
production software, connect it to the primary display computer in the cluster.

In addition to enabling MIDI Show Control, you also have to specify which input device to use for
MIDI show control and the MSC Device ID (see “Control”). This acts as a channel number for MSC
commands, and must be set to the device ID number output by the console. In addition, WATCHOUT
also recognizes the global “all call” device ID.

Some MSC commands allow a cue/list/path to be specified. WATCHOUT doesn’t use the “path”
number. The “list” number can be handled in either of three ways, as specified in the WATCHOUT
Preferences:

* Ignore Command. In this setting, the entire command will be discarded (not acted upon) if a list
number is specified.

* Map all to Main Timeline. This setting ignores the cue list number, sending all such commands
to the main timeline.

* Map to Auxiliary Timelines. If a cue list number is specified, the command will be applied to
an Auxiliary Timeline with the same name (where the name must be numeric, to match the list
number).

The cue number, if specified, makes WATCHOUT locate a Control cue with that name (that is, the
name of the cue must be a number). The GO and TIMED GO, LOAD and STOP commands interpret
cue number O as specifying “no cue”, allowing you to specify the cue list part only. This allows you to
use the STOP command to stop an Auxiliary Timeline without necessarily specifying a particular cue,
by setting the cue number to zero.

The following is a description of each command, as it relates to WATCHOUT.

GO

If given without a cue/list specification, runs the main timeline.

If given with a cue but no list, locates the specified cue on the main timeline and runs from there. This
does nothing if a cue with that name doesn't exist.

If given with cue and list, locates the specified cue on the specified Auxiliary timeline, and runs it from
there (assuming cue lists are mapped to Auxiliary timelines). This does nothing if specified cue or
timeline can’t be found.

TIMED GO
Performs like GO, ignoring the time value specified.

STOP

Pauses the timeline, optionally locating the specified cue.

LOAD
Similar to GO, except that the timeline is not run.
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RESET
Stops all Auxiliary timelines (returning them to their inactive state) and resets the main timeline to its
beginning.

ALL OFF
Enters Stand-By mode.

RESTORE
Exits Stand-By mode.

MIDI SHOW CONTROL 175



C. CONTROL PROTOCOL

You can control the production computer or a cluster of WATCHOUT display computers from other
programs or systems, including general purpose control systems such as AMX or Crestron. This is
usually done through the network, but other options (such as serial port or a script file) are also avail-
able. The control protocol uses simple and readable command strings, making it easy to learn and
implement from an external system.

To get started with controlling WATCHOUT, use a TELNET client to connect to WATCHOUT and give
the commands from there. Both Windows and MacOS X come with a TELNET client (although under
Windows it needs to be enabled before it can be used).

COMMAND FORMAT DETAILS
Each command is sent as a string, terminated by a carriage return, line feed or CR/LF pair. A com-
mand consists of a command name, sometimes followed by parameters. Commands are case-sensi-

tive. Commands are encoded using the UTF-8 UNICODE character format, which is downward
compatible with ASCII.

IMPORTANT: Commands containing non-ASCIl characters — such as 4, &, U, ¢ — must be encoded
using the UTF-8 format in order to work properly.

String parameters are sent within double quotes. Backslash is used as an escape character (that is, to
encode a double quote in a string, precede it with a backslash). To send a backslash character, use
“\\" inside the string.

Commands are case-sensitive. Successfully performed commands are normally not acknowledged
(although you can use the Command ID Tagging option to force explicit feedback for all commands).

While most commands are available in both the production and display programs, not all are. Fur-
thermore, in a few cases, parameters to commands are slightly different in the two programs. Such
differences are noted in the detailed descriptions of commands in this appendix.

WATCHOUT uses a simple text format for its commands. Some commands may return a reply, error
message or other kind of response to the controller. Such responses are also sent as text.

Parameters

In commands that take parameters, the parameters are separated by white-space only. Optional
parameters are shown in square brackets, like this: [<uint>]. Parameter types are described below.

<string>. String parameters are sent within straight double quotes:
"This is a string"

Backslash is used as an escape character (that is, to encode a double quote in a string, precede it with
a backslash). To send a backslash character, use “\\" inside the string.

<uint> and <int>. An unsigned or possibly signed decimal integral number:
123

<float>. A possibly signed decimal number with an optional fractional part:
0.25

<bool>. The keyword true or false, with no quotes:

true
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CONTROLLING THE PRODUCTION SOFTWARE

In cases where you must keep the production software in the system for some reason, you connect to
and control the production computer, which in its turn controls the display computers. One advantage
of this method is that you can clearly see you commands as they occur in the production computer’s
user interface, making it easier to try things out.

NOTE: Even when your goal is to control the display computers directly, it may help to start by con-
trolling the production computer as it makes it easier to see what's happening. Once things work as
desired, remove the production computer and target the display cluster directly.

Control Options

You can control the production software only through the network. It uses IP port number 3040. Com-
mands can be sent over either TCP or UDP. In order to accept commands on either of those ports, you
must enable those options in the Preferences dialog box’ Control tab.

When using UDP, no feedback is available due to the connectionless nature of the UDP method.
Hence, for most applications where reliability or feedback is important, always use the TCP method.

IMPORTANT: If you use the “load” command to load another show, make sure the desired control
options are enabled in that show as well, or the connection will be closed.

CONTROLLING THE DISPLAY SOFTWARE

Before attempting to control a display cluster, ensure that the show has been successfully run from
WATCHOUT production software (meaning that all media files have been transferred, etc). Then quit
the WATCHOUT production software.

Authentication

Before you can give any command to the display software (with the exception of the “ping” com-
mand), you must specify the authentication level. To control WATCHOUT display software, you need
authentication level 1:

authenticate 1

WATCHOUT responds with a Ready message. You can now send other commands.

CONTROL OPTIONS
You can control the display cluster either using a file stored on the primary display computer in the
cluster, or using commands sent via the network or through a serial port.

File-based Control

You can use a script file stored on the primary display computer’s hard disk to automatically perform
most commands in this protocol when starting the display software. This can, for example, be used to
set up a system that automatically loads and runs a show every time the computer is switched on. See
"Startup Script" for more on how to set up a script on your display computer.

The example below shows the content of a command file that displays a message on the WATCHOUT
screen, waits a few seconds, loads a show, waits for any other computers in the WATCHOUT display
cluster to become ready, and then runs the show.

authenticate 1
setLogoString "The show will begin shortly"
delay 5000
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load "MyShow"
wait
run

See each individual command later in this appendix for details.

IMPORTANT: If using non-ASCII characters in the show name (for example; &, 3, U, B), your text editor
must be able to save the text using the UTF-8 encoding. If you're unsure about this, it's usually easiest
to rename the show to avoid non-ASCII characters.

NOTE: Any errors occurring while executing commands from such a command file are displayed in a
console window. However, to see this window, you have to close the main WATCHOUT display win-
dow by pressing Ctrl-W. Keep this in mind if your command file doesn’t work as expected.

Network Control

To control a WATCHOUT display cluster via the network, connect to TCP/IP port number 3039 of one
of the WATCHOUT display computers. The computer with which you initiate communication becomes
the master of the cluster, and will automatically control the other cluster members, as specified by the
presentation loaded using the “load” command.

Use a TELNET program to check the communication. Open the port specified above, then type “ping”
and press Return. WATCHOUT will respond with a Ready message, stating its version number and
some other details.

Serial Control

To control a WATCHOUT display cluster through a serial port, connect the controlling device to a
serial port of one of the WATCHOUT display computers. This computer becomes the master of the
cluster, and will automatically control the other cluster members, as specified by the presentation
loaded using the “load” command.

No serial port is open by default. Use the serialPort command to open a serial port. Put this command
into a text file, and use the file-based control feature to perform the serialPort command (see “File-

based Control”).
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LIST OF COMMANDS
The table below shows the available commands. Some are explained in greater depth on the follow-

ing pages.

Command Description

ping Do-nothing command, causing a Ready feedback message to be sent.
authenticate Perform authentication. Required only for display software.

load Load a show and get ready to run. Parameter syntax differs.

online Go online or offline. Production software only.

run Start running, optionally specifying an auxiliary timeline name.

halt Stop running, optionally specifying an auxiliary timeline name.

kill Stop and deactivate the named auxiliary timeline.

gotoTime Jump to a time position.

gotoControlCue
enablelayerCond
standBy
getStatus

reset

setlnput
setlnputs
setlogoString
delay

wait

serialPort
timecodeMode
hitTest

Jump to the time position of a named Control cue.

Turn conditional layers on or off.

Enter/exit standby mode.

Retrieves name and status of the currently show and its timelines.
Reset and stop all timelines.

Set the value of a named Input, with optional fade-rate in mS.
Sets the values of multiple inputs together.

Displays a message on the startup screen.

Introduces a delay between commands (command file use only).
Waits for the entire display cluster to become established (cluster only).
Opens a serial port for control protocol use (cluster only).
Activates LTC (SMPTE/EBU) timecode control (cluster only).

Get information of interactive media cues

authenticate

This command is required for the display software prior to issuing any other commands except the
ping command. While this command is accepted by the production software, it is not required. See
" Authentication" above for details.

load (production software version)

Loads a show by name. The name is specified as a quoted string containing the full path to the file.
The use of backslash characters in Windows path names conflicts with the use of the backslash as an
escape character in this protocol. Either double the backslash characters, or use forward slashes
instead (as shown in this example):

load "C:/Samples/ExampleShow.watch"

Parameter Description
<string> Path to the show to be loaded.
[<uint>] Conditional layer enable flags, least significant bit is condition 1.
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Parameter Description
[<bool>] Go online automatically. Defaults to true.

NOTE: When using this load command, the production software will automatically go online after
loading the show.

If desired, you can add a numeric parameter to override the conditional layer settings of the show
being loaded. For example, to enable condition 1 and 2 only:

load "C:/Samples/ExampleShow.watch" 3

The number is a sum of the decimal numbers corresponding to each desired condition, as shown in
the table below.

Condition | Number
| 1

2 2

3 4

4 8

5 16

6 32

...and so on.

The last optional parameter is a boolean controlling whether the production software will go online or
not, after loading the show (default value is true):

load "C:/Samples/ExampleShow.watch" 3 false

loads the specified show and sets its layer conditions, but remains offline.

load (display software version)

Load a complete show specification from a local file associated with the show name specified by the
first parameter. Busy feedback may be sent to the host while loading, informing the host about the
progress. If errors occur, "Error" feedback is sent. Finally, a Ready feedback message is sent,
regardless of whether any error occurred.

load "Phantom"

Parameter Description

<string> Name of the show to be loaded.

[<bool>] Manage cluster loading and feedback. Defaults to true.

[<bool>] Designate as the master display computer. Defaults to true.
[<uint>] Conditional layer enable flags, least significant bit is condition 1.

NOTE: You can not specify a folder path to the show. The show must be present in the “Shows” folder,
located in the same folder as the WATCHOUT display software.

CONTROL PROTOCOL 180



online

This command applies to the production software only. It takes a single boolean parameter, specifying
whether to go online (true) or offline (false). Note that the load command also goes online unless
explicitly disabled by the optional parameter.

gotoTime
Jump to the specified time position along the timeline.

gotoTime 5000

Parameter Description
<uint> or <string> Time position to go to, in milliseconds, or as a string in this format:
“HH:MM:SS.FFF”, where FFF is millisecond:s.
[<string>] Name of auxiliary timeline to control (omit for main timeline).
gotoControlCue

Jump to the time of specified Control cue. If the optional “reverse only” boolean is set to true, it
searches for the Control cue only back in time from the current time position. Otherwise it searches first
forward then reverse.

The command does not change the run mode of the timeline. If the specified cue is not found, the time-
line's state will not change, and a runtime error message to this effect will be returned.

gotoControlCue "William" true

Parameter Description
<string> Name of Control cue to look for.
[<bool>] Search in reverse only if true. If false or not specified, then search both
ways.
[<string>] Name of auxiliary timeline to control (omit for main timeline).
enableLayerCond

Change the set of enabled layer conditions. While the layer conditions can be specified as part of the
load command, this separate command allows the layer conditions to be changed without loading
another show. The command takes a single, mandatory <uint> parameter with the same interpretation
as the conditional layers parameter of the load command.

setLogoString

This command applies to the display software only. Display its single string parameter next to the
WATCHOUT logo, when shown on screen.

standBy

Enter/exit standby mode. In standby, the display and sound is muted, or media on standby layers — if
any — is performed . This mode can be entered/exited smoothly, by specifying a fade rate.

standBy true 1000
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Fade out sound and image over one second and enter standby mode. If any standby layer is avail-
able, its media is performed instead.

Parameter Description

<bool> Enter standby if true, exit if false.

[<uint>] Fade rate, in milliseconds. Defaults to zero if not specified.
getStatus

Get the current status of the WATCHOUT cluster master.

getStatus
Reply "WOZLaunch" false 0 true true false 122 true

Responds with a Reply with the following parameters:

Reply Parameter Description

<string> Name of the show. Empty string if no show loaded.

<bool> Busy. True if the master display computer or any of its slaves is busy

<uint> General health status of the cluster; 0: OK, 1: Suboptimal, 2: Problems,

3: Dead.

<bool> Display is open (in its full screen mode).

<bool> Show is active (ready to run).

<bool> Programmer is on line.

[<uint>] Current time position, in milliseconds (only included if show is active).

[<bool>] Show is playing - false if paused (only included if show is active).

[<float>] Timeline rate (nominally 1, only included if show is active).

[<bool>] Standby mode (true if in standby, only included if show is active)
delay

Wait the number of milliseconds specified by the parameter before performing the next command in
the file.

NOTE: Performed only when used in a command file. Applies to display software only.

wait
This command applies to the display software only. Wait for the display cluster to become fully estab-

lished before proceeding with the next command in the file. Waits at most the number of milliseconds
specified by the parameter.

NOTE: Performed only when used in a command file.
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setlnput
Sets the value of a named input (see “Inputs”).

Parameter Description

<string> The name of the input fo set.

<float> The desired value, optionally prefixed by + or - for incremental change.
[<uint>] Optional transition rate, in milliseconds.

setInput "uno" 0.5

The value is generally in the range O through 1, but may be extended to cover a wider range using the
Limit setting of the Generic Input .

By prefixing the value with a plus or minus sign, you can adjust the value incrementally relative to its
current setting. This example increases the value of the input by 0.1:

setInput "uno" +0.1

A third, optional parameter allows you to specify a transition rate, causing any property controlled by
the input to change gradually to the specified target value. This parameter is specified in milliseconds.

NOTE: While you would typically use this command to set the value of a Generic Input, you may use it
to set the value for any input. If data is also provided by a MIDI or DMX-512 source, the latest data
will take precedence.

setinputs

This command is functionally equivalent to the setinput command above, but allows you to set multiple
inputs with a single command. This is useful in the following cases:

® When it is important that several inputs are set simultaneously, because their values are used in an
interdependent way. If you use two separate setlnput commands, it is possible that the commands
will not be executed on the same frame.

® When setting a large number of inputs, as it is more efficient to handle this with a single command
than a number of separate commands, allowing you to set a larger number of values within a single
frame.

The first parameter is the transition rate, in mS. Subsequent data must be provided in groups of two
parameters:

Parameter Description
<string> The name of the input to set.
<float> The desired value, optionally prefixed by + or - for incremental change.

setInputs 100 "Yo" 0.8 "Man" 0.5 "Stereo" 0 "Left" 0 "Top" 0.5
Ramps the named inputs to the specified values over 100 mS.
setInputs 0 "Yo" +0.1 "Man" -0.5

Instantly increase the Input named "Yo” by the value 0.1 and decrease “Man” by 0.5.
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serialPort

Applies to display software only. Opens or closes a serial port for protocol commands, setting its
parameters.

serialPort true "COM1"™

Parameter Description

<bool> Open (true) or close (false) the serial port.

<string> The name of the serial port.

[<uint>] Protocol selector. Must be 0. Default is O.

[<uint>] Data rate, in bits per second. Default is 9600.
[<uint>] Number of data bits, 7 or 8. Default is 8.

[<uint>] Number of stop bits, 1 or 2. Default is 1.

[<uint>] Parity: O = none, 1 = odd, 2 = even. Default is none.

HINT: For serial-only control, put the serialPort command into a text file, and use the file based control
feature to perform the commands in this file (see “File-based Control”).

timecodeMode

Applies to the display software only. (Use the Timecode options in the Preferences dialog box to use
timecode with the production software.)

Controls the LTC timecode receiver of the display computer. The timecode receiver is initially off.
When turned on, incoming timecode will control the presentation as if using the run, halt and goto-
Time commands. Furthermore, while playing, the presentation will be synchronized to the timecode.

timecodeMode 2 "-1:00:00"

Parameter Description

<vint> 0 = receiver off, 1 = auto-detect format, 2 = EBU 25 fps, 3 = SMPTE
29.97 NDF, 4 = SMPTE 29.97 DF, 5 = SMPTE 30 ("B&W"), 6 = 24.

[<int> or <string>] Time offset expressed in milliseconds, or as a string in this format:
“HH:MM:SS.FFF”, where FFF is milliseconds. Default is O.

Avoid using the auto-detect mode whenever possible. Instead, specify the expected timecode format
explicitly. Specifically, the SMPTE 30 ("B&W") format can not be detected automatically.

Use the separate Timecode Tester application to verify proper timecode reception, and to choose the
appropriate input connector to use for the timecode signal .

HINT: For stand-alone use of the timecode control feature, put this command into a text file, as
described under "File-based Control".

NOTE: Timecode control of the display computer can’t be used while the production software is
online. In this case, use the corresponding feature of the production software instead.

hitTest

Get information of the frontmost, visible and interactive media cue that intersects the 2D point given
by the two parameters (in stage pixels).
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hitTest 1200 250
Reply true "ImageOl"™ 1154 212 O

Parameter Description
<int> X-coordinate of the 2D stage point
<int> Y-coordinate of the 2D stage point

To make a media cue interactive it needs an interaction name specified, which can be done under the
advanced tab of the media cue dialog see (see “Advanced Cue Specifications”). The reply message
contains, among other things, this interaction name, if an interactive media cue was hit.

Reply Parameter Description

<bool> True if an interactive media cue was hit

[<string>] Interaction name (if hit)

[<float>] X-coordinate position of media cue (if hit)

[<float>] Y-coordinate position of media cue (if hit)

[<float>] Z-coordinate position of media cue (if hit)
FEEDBACK

The WATCHOUT cluster master sends feedback messages to the controller. Note that the controller
must be prepared to receive such messages at any time — not only as a direct response to particular
commands.

Most commands execute silently, unless an error occurs. Use the command ID tagging feature to force
commands to be positively acknowledged, if desired (see “Command ID Tagging”). When using
command ID tagging, any feedback message sent as a direct response to a command will be tagged
by that command ID, and will be sent to the sender of that command.

Any spontaneous feedback message (that is, not directly associated with a particular command) will
be sent to the most recently connected or authenticated controller.

Ready

Sent once when becomes ready after being busy (as indicated by one or more Busy messages). Also
sent as response to the “ping” command.

Ready "2.0" "WATCHPOINT" "Windows" true

Feedback Parameter |Description

<string> The version of the program.

<string> The name of the program.

<string> The name of the computer/OS.

<bool> License key is up to date.

[<string>] Address of originator (empty or omitted if originating from the master).
Busy

Sent once or repeatedly while busy doing lengthy tasks, such as downloading or caching files.

Busy "Transferring" "Media/Wilfred.jpg" 76
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Note that either or both string parameters may be empty, in which case the controller should retain the
previous values for these parameters and just update the progress value.

Parameter Description

<string> What is being done (for instance, “Transferring”). May be empty string.

<string> The subject of the above action (for instance, a file name). May be empty.

<vint> Percentage done so far, 0...100

[<string>] Address of originator (empty or omitted if originating from the master).
Error

Sent when any error occurs, either as a direct result of a command, or for any other reason.

Parameter Description
<vint> Error kind:
1 Operating system error (for instance, a Win32 HRESULT).
2 QuickTime error (Mac OSErr style).
3 Rendering APl error (that is, DirectX).
4 Network errors (that is, WinSock).
5  File server error (for example, file not found during download).
6 Syntax/parser error (for instance, when loading a specification file).
7 General runtime error — described by string.
8  Authentication error.
<int> or <string> | Error number or description string. May be zero.
<string> Excuse or explanation, may be empty string.
[<string>] Address of originator (empty or omitted if originating from the master).

Operating System Error. Indicates a generic operating system error from the host’s OS. Under
Windows, this is a HRESULT that indicates failure, with the error code included as the second parame-
ter (possibly decoded into an error message string). The third parameter may provide additional
information.

QuickTime Error. Similar to the Operating System Error, but originating from QuickTime. This is

treated separately from the OS errors since the QT errors use MacOS style error codes even under

Windows. This kind of error typically originates from still image files, or from video files as they are
opened or played. The third parameter generally contains the name of the offending media file.

Rendering API Error. Error occurred specifically related to rendering. This is similar to other oper-
ating system errors, except that you also know that it occurred while rendering. Sometimes, rendering
errors occur due to display card driver issues, video memory or other hardware resource limitations.

Network Error. Error occurred specifically related to network communication. This is similar to
other operating system errors, except that you also know that it occurred specifically while using the
network. Sometimes, network errors are caused by network interface hardware or driver issues, the
computer’s network configuration, or problems on the network itself (for instance, a bad cable/hub or
incorrectly configured router).

File Server Error. Error occurred when attempting to get a file from the media file server. The error
number is the same as those listed for the first Reply parameter in the File Transfer group. The Excuse
string is typically the name of the required file.
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Syntax/Parser Error. Indicates an error that occurred when reading structured data (such as a
show specification file). Error code and excuse vary with the nature of the error.

General Runtime Error. Other errors, not covered by any of the above cases. Always described
further by a string as the second parameter, as well as further information in the third parameter
(optional).

Authentication Error. The second parameter gives further details:

Value |Description

You have no authority.

Your authority is insufficient for this command.

In use by another Programmer.

Authentication challenge/response sequence failed.
Invalid authentication level.

Authentication level not allowed for port.

NO OO h WODN —

Command not allowed in read-only mode.

The third parameter may provide additional context information. For instance, in the case of being in
use by another controller, it may provide information to identify that controller — such as its address.

Warning

Sent when a non-critical error occurs.

Warning "Low Memory: Primary Video 1960 KB"

Feedback Parameter |Description

<string> The warning message, as a quoted string.
[<string>] Address of originator (empty or omitted if originating from the master).
Information

Sent to convey some general information.

Feedback Parameter |Description

<string> The information message, as a quoted string.

[<string>] Address of originator (empty or omitted if originating from the master).
Reply

A Reply feedback message is sent as a direct response to a query command (getStatus, for instance).
Use a command ID to positively associate the reply with the command.

The format of the reply parameter(s) depends on the command that caused the reply to be sent.
Quit

Sent when the application is about to quit (either due to a keyboard or other command). This message
has no parameters.

CONTROL PROTOCOL 187



COMMAND ID TAGGING

Commands may optionally be preceded by a command ID. This is any sequence of characters
enclosed in square brackets. When used, at least one explicit reply is always sent for each command.
The reply is then also tagged with the same ID:

[23]ping
[23]Ready "2.0" "WATCHPOINT" "Windows" true

Use this feature if you want positive confirmation of commands, or to explicitly associate a feedback
message with a command.
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D. COMMAND LINE OPTIONS

Some parts of WATCHOUT accept startup options that can be specified on the command line used to
launch the program. This is typically done using a shortcut located in a convenient location, such as:

® The computer’s desktop.

® The Startup folder, in case you want to launch the program automatically as your computer is
started (see “Auto-Starting WATCHOUT").

A shortcut to the desired WATCHOUT application (such as the display software or the dynamic image
server) is created by dragging the application using the right mouse button to the desired location

— such as the desktop or the Startup folder — and then choosing “Create Shortcut here”. There are
three WATCHOUT applications you may want to create shortcuts to:

® The display software, named “WATCHPOINT.EXE”, found inside the WATCHOUT installation
folder (by default located at “C:\WATCHOUT 6").

® The production software, named “WATCHMAKER.EXE", also inside the WATCHOUT installation
folder.

® The Dynamic Image Server, named “ImageServer.EXE”, located inside a folder named Image-
Server in the WATCHOUT installation folder.

Once a shortcut has been created, you can configure it by right-clicking the shortcut and choosing
Properties. Enter any options at the end of the Target field, separated by a space, as shown below.

TS WATCHPOINT - Shortcut Properties >
Security Details Previous \ersions
General Shortout Compatibility

IE WATCHPOINT - Shortcut

Target type: Application

Target location: WATCHOUT

Target: |C:"-.‘."'.n';':".TCHDUT‘-.‘."'.:';’-‘-.TCHF‘OINT.EKE -Delay & |

Start in: |C:"-.‘."'.|'ATCHDLIT |

Shortout ey | MNone |

Bun: Mormal window W
Comment: | |
Open File Location Change lcon... Advanced...

Cancl Apply

The -Delay option specified for the display software.

Note the following details:

® The first part of the Target field is the full path to the program being started by the shortcut. If this
contains any spaces, it will be enclosed in double quotes.
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® The items in the Target field are space separated. This also applies to command line option
arguments.

® |f a command line option argument or other parameter contains spaces, it must also be enclosed in
double quotes.

IMPORTANT: Command-line options of the newer generation of Dataton media servers, such as the
WATCHPAX 60, are set through the “Edit Command Line Options” entry under the File menu.

DISPLAY SOFTWARE
The WATCHOUT display software (WATCHPOINT.EXE) accepts the following options:

-Delay

Specifies any delay to introduce when starting the display software. This option must be followed by a
number, specifying the delay in seconds (see illustration above). This is useful in cases where other
programs or computer functions may need to be fully started before WATCHOUT can start reliably
(see “Auto-Starting WATCHOUT").

-Nologo

Suppress the WATCHOUT logo normally shown together with a progress bar when updating shows or
transferring media files. With this option, the display software will hold whatever is on screen during
such operations, hence providing no on-screen feedback on the progress. Progress bars will still be
shown in the Stage window of the production software, though.

-ShowsPath

Specifies the location of the “Shows"” folder, which in its turn contains all the shows that have been
transferred to the display computer. By default, this folder is named “Shows” and is located in the
WATCHOUT installation folder. In some cases, you may want to locate this folder elsewhere, such as
on a separate drive. If so, use this command line option to do so.

Specify the path to the desired location after the -ShowsFolder option, separated by a space. Remem-
ber to put the path inside double quotes if it contains any spaces.

STARTUP SCRIPT

You can pass the name of a file as the last item on the command line. Note that such a command file
name is not prefixed by any option name. Remember to enclose this path in double quotes if it con-
tains spaces.

NOTE: By default Windows hides the file extension of most files. Hence, the name of a script may
appear as “StartWQO” rather than “StartWO..ixt”. The same applies to most other files. Use the DIR
command in a command line window to see the full file name.

If you specify just a file name, without an absolute path, WATCHOUT will look for this file in the
WATCHOUT installation folder. The example below specifies a file named “StartWO.ixt”, located in
the folder named “Mike” at the root of the system drive.
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S WATCHPOINT - Shortcut Properties >

Securty Details Previous Versions
General Shortcut Compatibility

laE WATCHPOINT - Shortcut

Target type: Application

Target location: WATCHOUT

Target: |'C HOUTYWATCHPOINT .EXE “Mike \StartWO ta |

Start in: |C:"-.‘.".|'ATCHOLIT |

Shortout key: | MNone |

Run: Momal window b
Comment: | |
COpen File Location Change lcon... Advanced...

Cancel

The content of this script file follows the same syntax as described in the chapter titled “Control Proto-
col”. Here's an example of a valid command file.

| autostart - Notepad — O ot
File Edit Format View Help

setlogo5tring "Good Morning!™

A command file that displays a message after starting WATCHOUT.

You can put comments inside the script file, if you want. Start each comment line with a semicolon.
Comment lines are ignored by WATCHOUT.

Default Startup Script

By default, WATCHOUT always looks for a file named “autostart.ixt” inside the WATCHOUT installa-
tion folder. If found, and no explicit file name was specified on he command line, any commands
found in this “autostart.txt” file will be performed. The main purpose of this file is to perform some
configurations on Dataton media servers, but it can be used on any display computer, if desired.

You can edit this script either by locating it inside the WATCHOUT installation folder using Windows
Explorer, or by choosing “Edit Startup Script” on the File menu of the WATCHOUT display software,
accessed by pressing Ctrl-W while the display software is active.
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HINT: You can edit this file from the production computer, in case you don’t have a keyboard con-
nected to the display computer, by using the Remote Access command.

After editing the startup script, you need to re-launch the display software for it to take effect. You can
do his by choosing “Relaunch” on the File menu of the display software.

PRODUCTION SOFTWARE
The WATCHOUT production software accepts the following command line options.

-Lang

Specify a localized version of the user interface. Normally, the language selection is performed auto-
matically, according to the preferred language of the operating system. For instance, if you're running
a Chinese version of Windows, WATCHOUT will be displayed in Chinese. In some cases, this is not
desired. For instance, you may want to run the user interface in a localized language even if the com-
puter is running in English. To force WATCHOUT to run in Chinese, for example, add this command
line option when starting the production software

-Lang zh

Follow the option with a space and two letter language code, as shown above. The following lan-
guage codes are recognized:

e en English.

es Spanish.

it ltalian.

e jaJapanese.
® ru Russian.
e tr Turkish.

e zh Chinese.

NOTE: If a recent command or text is not available in the chosen language, it will be presented in
English instead.

-SiteServer

It is possible to use a central license key rather than individual license keys for each computer in a

WATCHOUT installation. In this case, the display computers will find the site license server on the

network automatically. However, if you also want to use the site license for a production computer,
you need to specify the IP number of the license server using this command line option, like this:

-SiteServer 192.168.0.101

In this example, “192.168.0.101" is the IP number of the site license server.

DYNAMIC IMAGE SERVER
The dynamic image server accepts the following command line options.
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-FilePath

By default, the image server looks for any local files to serve relative to the WATCHOUT installation
folder. Hence, to display a file named “TickerTest.swf” located in a folder named “flash” inside the
WATCHOUT folder, configure the Dynamic Image media item as shown under “Dynamic Image
Parameters”.

You may prefer to keep your dynamic image content somewhere else than inside the WATCHOUT
installation folder. If so, use the -FilePath option to the image server to specify the path to the folder
containing your local dynamic content. Separate the option and the path with a space. Enclose the
path in double-quotes if it contains spaces.

NOTE: This option is also recognized by its alias -f, as shown in the example under “Alternate File
Location”.

-Pollinterval

When displaying images hosted locally on the dynamic image server, any changes made to those
images will be recognized instantly. This can be used to update content by simply replacing a file with
another one, with the same name and dimensions.

When displaying remote images, accessed by specifying a fully qualified URL as the path in the
Dynamic Image media item, changes will not be recognized instantly, as a round trip to the server is
required in order to detect them. While displaying a remote image, the image server will poll the
server at regular intervals to see if the image has changed. If it has, it will be updated accordingly. By
default, the interval by which the image server queries the remote server is 30 seconds. Hence, it may
take up to 30 seconds for any change made to the image on the server to appear on the displays.

You can specify another poll interval using the -Pollinterval command line option, followed by a space
and then the desired interval, in seconds. The shortest interval you can specify is 1 second. Setting this
value to O disables any updates, making the image server load the image only once, as the first client
requests it, and then hold the same image indefinitely until the last client let go.

NOTE: Some servers may impose limits on how frequently you may request updates. In such cases,
making the refresh interval too short may cause the server to stop responding altogether, thereby
nullifying your intent to expedite updates.

PRODUCTION SOFTWARE

The WATCHOUT production software accepts only a single option; the full path to a show file to load.
Hence, if you have a situation where you use the production software to run the show, and you always
load the same show, you can make a shortcut to the production software (possibly putting it into the
Startup folder), specifying the full path of the show to load.

HINT: If the show was saved with “Go Online Automatically” selected in the Control tab of the Prefer-
ences dialog box, the production software will also connect to the display computers automatically.
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E. TRACKING INPUT

CONTROL MEDIA
A tracking input can be connected to any type of visible media inside WATCHOUT. This includes
images, videos and 3D objects.

To set media to receive tracking data, open the preference window of the media cue and go to the
Advanced tab. In the Advanced tab, enable “External control of position, scale & rotation” and enter
the name of your tracking input in the “Tracking name” field. The object is now receiving tracking data
and can move freely inside the Stage window.

Video Cue i

Basic Advanced Cutput Channel Assignments

Sehavior: || Free Running
[ ILooping

Maybads Speed: | 100 | 8%

Staddng: Default w

Blend Mode: Mormal L
frewnew:  Best Quality W
Masked by Layer Above: | Off W

] suppress Rendering (for use as Mask only)

[C] Auto-crient along Motion Path

Forvward Mation Direction: K+

[Juse Anchor Position as Local Vanishing Paint

E]Exlema Conviral of Position, Scale & Rotation

Tradang Mame:

Interacton Mamsa:

Ok Cance

External control specified in the Advance tab.

CONTROL 3D MODELS

To ensure correct movement of a 3D object in WATCHOUT, you have to correlate the object scale to
the system scale of WATCHOUT. The best way to achieve this is to open the 3D model’s media prefer-
ences and select “Scale by factor.” Set this to the appropriate factor, depending on how the model
was created (inches, mm, cm).

IMPORTANT: Make sure that the Anchor position within the model correctly reflects the origin as deter-
mined by your tracking system.
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REALTIME TRACKING PREFERENCES

Multicast Address

The tracking system sends its RTTrPM data on this address.

Port

The port used for sending the data.

System Scale

WATCHOUT employs pixels as its units while RTTrPM uses meters. This value determines the conver-

sion from meters to pixels.

Use Tracking for Floor Projections

This option rotates the tracking data 90 degrees which makes it possible to use the WATCHOUT 2D
display for tracked floor projections.

System Origin Offset

Set an offset to your tracking data to position your media in a more convenient place in the
WATCHOUT Stage window.

Note: A tracked object cannot be moved using click and drag. In order to change the position of a
tracked object, you can either change the position in the cue specifications, use the move command
(Ctrl-M) or set an offset to the tracking.

Preferences

General EdgeBlend Control  Conditions Video In - Audio Out 3D
Metwork

[ Go Cnline Automatically After Opening Show

Production Computer Contral: [ TCR/IP [ UDP

Timecode
[ control of Main Timeline (LTC EBU/SMPTE)

Input device: |Realtek ASIO [ASIO]

Format: | Auto Detect
Time Offset: 0.0 +or-

Status:
MIDI
Input Device: | Mone ~
[ImiDI Show Control, Device 1D: 0

MSC Cue Lists: Ignore Command {do nothing)

DMX 512 (Art-Met)

Default Universe, In: EI Out:

Dynamic Image Server

Default Address: l:l

Realtime Tracking
Multicast Address: 238,210,101

System Scale (im in pixels) Use Tracking For Floor Projections

| port: | 24002 |

x

Cug/* |

System Origin offset  X: |D | IH |D | Z: |D

Preferences dialog when using realtime tracking
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F. KEYBOARD SHORTCUTS

GENERAL

Shortcut Description

Ctrl-K Preferences dialog

Ctrl-O Open a show file

Ctrl-Q Quit program

CtrlR Refresh media (looks for changed files)
Ctrl-S Saves show to disk

EDIT

Shortcut Description

Cirl-A Select all

Ctrl-C Copy

Ctrl-E Select to end

Ctrl-F Find/Replace

Ctrl-G Find/Replace again

Ctrl-M Move stage position of selected cues/displays
Cirl-X Cut

Ctrl-Z Undo

Ctrl-Shift-Z Redo

Enter Open specifications dialog
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STAGE & PREVIEW

Shortcut Description
Ctrl-Shift-A Remote manage display
Ctrl-B Standby mode (toggle)
Ctrl-D Update

Ctrl-L Online (toggle)

Ctrl-N Snap (toggle)
Ctrl-Shift-D Frame displays
Ctrl-Shift-O Scroll to origin
Ctrl-Shift-E Perspective

Ctrl-Shift-F View front

Ctrl-Shift-T View top

Ctrl-Shift-L View Left

Cirl-1 Preview scale 1:16
Ctrl-2 Preview scale 1:8

Ctrl-3 Preview scale 1:4

Ctrl-4 Preview scale 1:2

Ctrl-5 Preview scale 1:1

Ctrl-6 Preview as wireframes
Cirl-7 Preview as thumbnails
Ctrl-8 Preview video as thumbnail
Ctrl-9 Preview at best quality
Ctrl-0 Preview masked by displays
Ctrl-Drag Zoom scale to rectangle
Ctrl-Click Zoom in

Ctrl-Shift-Click Zoom out

Citrl-Alt Drag To pan

Ctrl-Tab Cycles window
Ctrl-Shift-(1,2,3,etc) Select tier
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TIMELINE

Shortcut Description

CtrH Insert layer

Citrl-DEL Delete layer

CitrlJ Timeline settings

Ctrl-P Add play control cue

Ctrl-Shift-P Add pause control cue

Ctrl-T Click jumps to time (toggle)

Spacebar Start timeline (toggle)

Esc Pause timeline (no toggle

NUM O Start timeline (no toggle)

NUM * Jump to last start position

NUM + Magnify timeline scale

NUM - Reduce timeline scale

Alt While dragging tail of cue to stretch tween points
Up/Down Select layer

Left/Right Select next/previous cue in layer
Ctrl-Arrow Nudge image of selected cue 1 pixel
Ctrl-Shift-Arrow Nudge image of selected cue 10 pixels
AlT-Double-Click Composition Opens a composition from the timeline
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TWEEN

Shortcut Description
Alt-P Position

AlO Opacity

Alt-S Scale

AltR Rotation Z-axis
Al-C Crop

Alt-L Wipe (tiles)

Alt-T Tint

AltE Wipe (strips)
AlrW Wipe (gradient)
Al+N Corners

Alt-H Hue & saturation
Al Wipe (bands)
AltY Rotation Y-axis
AUDIO TWEEN TRACK

Shortcut Description
AlV Volume

Al+-B Balance
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